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Get Help

There are a number of ways to learn more about your product and interact with Oracle and other users.

Get Help in the Applications

Use help icons @ to access help in the application. If you don't see any help icons on your page, click your user image
or name in the global header and select Show Help Icons.

Get Support

You can get support at My Oracle Support. For accessible support, visit Oracle Accessibility Learning and Support.

Get Training

Increase your knowledge of Oracle Cloud by taking courses at Oracle University.

Join Our Community

Use Cloud Customer Connect to get information from industry experts at Oracle and in the partner community. You
can join forums to connect with other customers, post questions, suggest ideas for product enhancements, and watch
events.

Learn About Accessibility

For information about Oracle's commitment to accessibility, visit the Oracle Accessibility Program. Videos included in
this guide are provided as a media alternative for text-based topics also available in this guide.

Share Your Feedback

We welcome your feedback about Oracle Applications user assistance. If you need clarification, find an error, or just
want to tell us what you found helpful, we'd like to hear from you.

You can email your feedback to oracle_fusion_applications_help_ww_grp@oracle.com.

Thanks for helping us improve our user assistance!
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1 Overview of Channel Revenue Management
Cloud

Channel Flows: Buy Side vs Sell Side

Channel Revenue Management supports multiple channel flows and categorizes them as either buy side or sell side
flows. Each has its own separate user interface for their transactional users.

A sell side channel flow centers around a customer account and typically involves rebates offered to customers.
Deductions is part of the sell side flow. A buy side channel flow centers around a supplier site and involves
administering rebates from suppliers.

On the sell side we support:

Deductions and Settlement

For more information about Deductions and Settlement, see Oracle SCM Cloud: Using Deductions and
Settlement guide.

Analysts can access Deductions and Settlement from the Order Management work area.

Rebates to channel customers
Royalty payments
Rebates for customer annual co-op programs
Rebates for customer promotion programs
- Tiered rebates for annual volume programs and customer volume programs

Lump sum payments
For more information about Customer Programs, see Oracle SCM Cloud: Using Customer Channel Management
guide.

On the buy side we support:

Rebates from your suppliers.
- Annual rebates from your suppliers.
- Ship and debit rebates from your suppliers.
Direct collaboration with suppliers to administer programs.
Supplier Channel Management that encompasses buy side flows:

- Analysts and administrators can access Supplier Channel Management from either the Procurement or Order
Management work areas.

- Supplier contacts can access Supplier Channel Management from the Supplier Portal.

For more information, see Oracle SCM Cloud: Using Supplier Channel Management guide.

Related Topics
- Starting an Implementation
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Deductions and Settlement

Deductions and Settlement

Deductions originally started in consumer goods where powerful retailers would short pay invoices based on their
understanding of the trade terms or agreements.

This has spread across all industries, and deductions are a common practice not only for collecting promotions, but
also for any kind of dispute or misunderstanding, whether it's a pricing error, transportation related, damages, and so
on. This is also the hardest challenge for the receivables departments to resolve because of the need for approval from
outside receivables, like sales or shipping. The customer may short pay based on their own policies and procedures. It's
up to you to resolve these claims.

Deductions

5% - 15%

of Revenue

51% - 10%

Invalid

According to market surveys, deductions can represent 5 to 15 percentage of revenue, depending on the industry. Of
that number, 5.1to 10 percent are invalid or unauthorized. In some industries it can be a lot higher.

Deductions and Settlement in Channel Revenue Management enables you to take back control, and provides:

- Centralized deductions directly from Receivables.
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- Accurate and fast resolution of customer short pays.
Resolution with accountability and transparency, which enables root cause analyses.

- Settlement of deductions in Receivables.

How Deductions and Settlement Works

Overview
Receive Short Pays Initiate Claim
~
C
(§< aingas X — Py
* Receive customer short * Create deductions
pay claim
* Lockbox integration * Assign ownership
Settle Deduction Fast Accurate Resglution
e §
=@ -
* Create & apply credit memo * Review & research
* Apply open credit memos or deduction details
overpayments * Determine resolution

When a customer short pays you, the flow is:

1. Receive a short pay from a customer, including from the Receivables lockbox.
2. Create a claim from Receivables for the short pay difference within the receipt.
3. Assign ownership of the claim.

4. Research and resolve deductions quickly and accurately.

5. Settle the claim.

With Deductions and Settlement you can:

- Centralize deductions and overpayments, with accountability and aging by:
o Supporting lockbox
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o

o

o

Creating manual claims
Assigning claim owners

Setting up aging methods

Resolve deductions by:

o

o

o

o

o

Associate promotional accruals

Creating credit memos

Applying open credit memos and open overpayments
Applying write-offs

Applying chargebacks only for invoice deductions

Resolve overpayments by:

o

o

Creating invoices.

Applying open deductions.

- Approve your claims.

Chapter 1
Overview of Channel Revenue Management Cloud

« Schedule the Settle Customer Claims process periodically to settle the claims in Receivables in a ready-to-use
and tightly integrated manner. The settlement details are brought back to Channel Revenue Management to
complete the flow.

- Analyze the root causes behind deductions, with the help of claim types and claim reasons assigned while
resolving the claim.

Proactively analyze write-off thresholds through occasional review of claim write-offs.
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Business Process Flow

Chapter 1

Overview of Channel Revenue Management Cloud

=]

Deductions and Settlement Flow (including promotional settlement)

=]
AR Manager | Lockbox

Auto Settlement in AR

3rd Party System

=]
Channel Claims Manager

= Channel Claims
Approver

Channel Operations

Orchestrated by

Orchestrated by

Receive AR Channel Channel Settle
customer Lockbox Customer —
short pay ARI AP Claims
_ Create & Apply Pol,;;r;?rte B ]
Create Receipt Settlement Settlement T Resolve via
Artifacts Artifacts Settlement
Methods
Custom
- Settlement
Claim =
Create & Apply Investigation Mew short | FEST
daim H or Channel 1 ; Review & : j
Investigation or : Revenue Claim ' payin AR Mrererrre @k {—> Approve Claim
Channel Revenue L Settled :
Caim R — l __________ R
Create
I Accounting
Create Clﬁﬁlt:tr::r » Create Manual
Accounting dispute Claim
l EST Post to GL
Confirm
Post to GL [ » Settlement of €
Claim
Scheduled Financial
Legend Process Process Integration

How Deductions and Settlement Works with Receivables and

Payables

Here's how Deductions and Settlement works with Receivables and Payables to provide transparent, integrated

settlement.

Receivables Analyst Claim Creation

At the end of the day, a short pay or deduction represents any kind of dispute or misunderstanding between you and
your customer. These disputes manifest themselves as short pays in customer remittances, and can take multiple

forms:

Customer Action

Customer short pays a receipt while marking

invoices as paid in full

Customer overpays a receipt on account

ORACLE
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Create Claim Investigation

Create Claim Investigation

Management

Deduction

Overpayment

Claim Source in Channel Revenue
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Customer Action Action Taken by Customer Analyst or Claim Source in Channel Revenue
Lockbox Integration Management
Customer short pays a specific invoice Create Channel Revenue Claim Invoice Deduction
Customer overpays a specific invoice Create Channel Revenue Claim Invoice Overpayment
Customer communicates a dispute N/A Manual Claim

Based on the action of the customer, the Receivables analyst in the Edit Receipt Ul or through the lockbox integration,
will behind the scenes, initiate the creation of a customer claim accordingly in Deductions and Settlement. This typically
defaults to a deduction claim type and an unknown claim reason. It's part of the resolution process to determine the
true claim type and reason.

For a non-invoice based deduction or overpayment, a Receivables activity is applied to the receipt in the amount of the
short pay or overpayment. The receipt is updated with a reference to the created claim number.

For an invoice specific deduction or overpayment, claim details are applied to an invoice application line of the receipt in
the amount of the short pay or overpayment, and the invoice application line is updated with claim details. The created
invoice claim takes on the amount outstanding, the currency, and the business unit of the invoice.

I Note: Claim creation will fail if a default claim type and default claim reason isn't specified in the claim source setup.

Claim Creation Through Lockbox

Many enterprises leverage lockbox banking services for the receipt of payment from customers. Create claims
automatically for deductions and overpayments from the Process Receipts Through Lockbox process in Receivables.
This reduces deduction creation time and improves processing efficiency. The lockbox receives payments and
automatically creates an invoice-related claim in Channel Revenue Management for underpayments and overpayments
to the invoice's outstanding balance and non-invoice related overpayment claim for any remaining unapplied amount
on the receipt post applications.

Claim Settlement

After a channel manager resolves the deduction and it's approved, the Settle Customer Claims process can be run to
create the artifacts of settlement in Receivables. A deduction can encompass one or multiple settlement methods. The
process is typically scheduled by the Channel Operations user.

During the settlement of a claim, the schedule process:

1. Creates credit memos in Receivables with applicable taxes, if credit memo lines are present in the resolution of
the claim. Credit memos on account are then applied to the receipt. Credit memos on invoice are applied to the
invoice. Similarly, for an overpayment, an invoice is created and applied to the receipt.

2. The Fusion Tax application or supported partner tax applications are supported.

Reverses the original claim investigation activity in the receipt.

4. Applies any open transactions that are part of resolution to the receipt if settling on account or to the invoice if
settling on invoice.

5. Auto write-offs are only applicable to short pays. If the entire short pay wasn't resolved, and the remaining
amount is below the write-off threshold, then this write-off amount is applied to the receipt or invoice.

W
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6. If the entire short pay wasn't resolved, and the remaining amount is greater than the write-off threshold
amount, then a child claim is created in Deductions and Settlement. This child claim is also applied to the
receipt.

Note: While settling a claim, the Claim Amount Includes Tax field indicates whether the amount settled is inclusive of
taxes. If the override is allowed at the controls at status and tax rate levels, then the application will check this field.

In case of manual claims, settlement can be done in Receivables or Payables. The settlement method for Receivables
is Credit Memo - On Account and for Payables the settlement methods are Check or Default Payment Payable. If you
select a Payables settlement method, then the application creates an invoice in Payables with the information used
to settle the claim. To do this, the application uses the Import Payables Invoices scheduled process and the payment
details are updated in the claim when you run the Settle Customer Claims scheduled process.

Accounting

The accounting for nonpromotional settlement is handled by Receivables. Settlement artifacts are created as
Receivables transactions and activities according to the Channel setups. For credit memos and invoices, Receivables
performs the subledger accounting based on the Receivables transactions and activities created by Channel Revenue
Management settlement.

- Claim Type setup for a deduction includes a one to one mapping to a Receivables credit memo transaction
type. This is used when a credit memo is created in Receivables. A standard credit memo is always created for a
credit memo on invoice.

- Claim Type setup for an overpayment includes a one to one mapping to a Receivables invoice transaction type.
This is used when an invoice is created in Receivables.

- Claim Reason setup for a deduction includes a one to one mapping to a Receivables credit memo reason. This
is used when a credit memo is created in Receivables.

The accounting for a claim investigation is derived from the Receivables Activity associated with the claim investigation
application.

In the Manage Channel Settings page, there are two settings under the category Settlement by Credit Memo - On
Invoice that drive the settlement in Receivables. A receivables method to reverse accounting entries, and a receivables
method to credit installments.

The accounting for promotional settlement is handled by Channel Revenue Management's integration with Subledger
Accounting.

For more information about accounting events, see Accounting Event Details for Customer Accruals in the
Implementing Channel Revenue Management guide.

Related Topics
« Manage Customer Claim Sources and Settlement Methods

 Create Claim Investigations
« Process Receipts Through Lockbox Execution Report
« Channel Revenue Management Claim Creation and Settlement for Lockbox Receipts
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Customer Programs

Overview of Customer Programs

Program managers are sales representatives for channel customers with an arsenal of program types to incentivize
channel sell through.

You can use annual programs such as annual co-op and annual volume programs, which are built into the unit cost, to
drive customer loyalty. Additionally, you can use shorter, more targeted programs such as customer promotions and
volume programs. Use lump sum programs to promote marketing activities and behaviours, which aren't predicated on
purchases.

Deductions started in consumer goods where retailers would short pay invoices based on their understanding of
customer promotions.

e —
®
i f \.
o Offer & © Investigate
Track (2] & Settle
Rebates Deductions

Deducts

To combat invalid or unauthorized deductions, customer programs in Channel Revenue Management provide:

- Centralized promotions for channel customers.
- Automated eligibility of channel incentives against sales transactions.
This leads to fast and accurate accruals.
- Automated accrual tracking.
This provides real time visibility of liabilities.
- Centralized claims processing.
This helps reduce margin leakage and reduce your DDO (Days Deductions Outstanding).
- Automated channel accounting.
This configurable integration reduces time to implement and cost of ownership.

The following table provides a comparative of the available customer programs:
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Program Feature

Typical program
duration

Eligibility attributes

Eligibility date context
attributes

Additional Mandatory
Conditions (AND
condition)

Program qualification

Tiers
Accrual record for

each order line or
aggregation

Beneficiary support for
accrual

ORACLE

Customer Annual Co-
op Program

Jan — Dec Entire Year

Customers (All)

« Actual Ship Date
- Invoice Date
. Order Date

- Requested
Arrival Date

- Requested Ship
Date

No

To check eligibility and
create accruals, run
the Create Accruals
for Co-op Programs
scheduled process.

No

Accrual is calculated
based on rebate type
and rebate amounts
defined on program’s
product rules and are
aggregated based on
Program, Business
Unit, Customer
account, Bill To, Item,
UOM, Currency and
Period.

Yes

Customer Annual
Volume Program

Jan - Dec Entire Year

Customer (1 or more,
All not allowed)

« Actual Ship Date
- Invoice Date
- Order Date

- Requested
Arrival Date

« Requested Ship
Date

No

To check eligibility and
create accruals, run
the Create Accruals
for Volume Programs
scheduled process.

Yes

Accruals are calculated
based in tiers defined
on Program and are
aggregated based on
Program, Business
Unit, Customer
account, Bill To, Item,
UOM, Currency,
Tiered rebate and
Period.

No

Chapter 1

Overview of Channel Revenue Management Cloud

Customer Promotion
Program

4-8 weeks

- Customer

- Bill To

- Ship To

« Order Type

- Order Line Type
- Salesperson

- Warehouse

- Custom
Quialifiers

« Actual Ship Date
- Invoice Date
- Order Date

- Requested
Arrival Date

« Requested Ship
Date

Yes

Pricing Algorithms are
used to check program
eligibility.

To create accruals, run
the Create Accruals
for Channel Batch
scheduled process.

No

Accrual is calculated
based on rebate type
and rebate amounts
defined on program’s
product rules. One
accrual is created for
each order line

Yes

Customer Volume
Program

4-8 weeks

- Customer

- Bill To

- Ship To

« Order Type

- Order Line Type
- Salesperson

- Warehouse

- Custom
Quialifiers

« Actual Ship Date
- Invoice Date
. Order Date

- Requested
Arrival Date

« Requested Ship
Date

Yes

Pricing Algorithms are
used to check program
eligibility.

To create accruals, run
the Create Accruals
for Channel Batch
scheduled process.

Yes

Accrual is calculated
based on tiers defined
on Program and one
accrual is created and
for each order line

Yes

Customer Lump Sum
Program

One time, no duration

Customer (only 1)

Not applicable

No

No eligibility check
performed.

One time accrual
creation and
settlement for selected
customer.

No

One accrual record

is created for each
product distribution
added on the Program.

No
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Program Feature Customer Annual Co- Customer Annual Customer Promotion Customer Volume Customer Lump Sum
op Program Volume Program Program Program Program

Product category Yes Yes No Yes No

Category exclusion Yes Yes No No No

Calculation method Not Applicable Retrospective Not Applicable Retrospective Not Applicable

Stepped
Tier prequalification No Yes No No No

for customer

Customer rule and No No Yes Yes No
product rule start and

end dates

Manual adjustments Yes No Yes No Yes

Customer Annual Co-op Program

Co-op advertising is an annual arrangement between a manufacturer or distributor and their channel partners. With co-
op programs, you can accrue rebates based on your sales, spanning the effective date of the program. This program is
a variation of an annual program. It applies to all customers and you can define rebates for each product rule. You can
define product eligibility by item, category, or for all items. Product eligibility supports exclusions by item or category.
Eligible sales are obtained from sales orders, which are imported through a CSV file.

The program provides the ability to:

- Streamline and automate tracking and payment of co-op marketing funds.
- Improve financial visibility to volume program liabilities.

- Improve differentiation and channel awareness of the manufacturers or distributors products and services.

Customer Annual Volume Program

Use customer annual programs to accrue rebates based on cumulative sales volumes across orders.

10
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r

Retrospective

These programs are critical to promoting loyalty from channel partners because higher rebates are provided for more
annual buying; and this reduces the risk of customers defecting to competitors.

Annual volume accruals are summarized and calculated on a periodic basis; not for each sales transaction. If you want
volume rebates for each eligible sales transactions, then use customer volume programs.

This feature provides wholesalers, distributors, and manufacturers the ability to:

Promote greater loyalty from channels.

Improve customer satisfaction.

Reduce cost of ownership.

Reduce invalid deductions.

Reduce Days Deductions Outstanding (DDO).

Improve visibility to annual incentives and liabilities for programs, customers, and the business unit.

Additionally. this program enables you to:

Define volume rules for tiered rebates as a percentage of sales revenue or an amount per unit for eligible
products or exclusions.

Define eligibility based on dates including invoice date which is most typically used.
Prequalify customers with a proven track record to start at a higher tier.
Eligible sales are obtained from sales orders, which are imported through a CSV file.

Execute annual volume agreements with channel customers with the ability to aggregate and track cumulative
sales revenue or quantity across orders for a period and to calculate retrospective volume rebates on periodic
basis.

Track accruals using Checkbook.
Post channel transactions to General Ledger.

n
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- Support rules based subledger accounting.

Customer Promotion Program

Use customer promotion programs to define the rules of a promotional agreement with your customers. Use
configurable templates to create multiple program types. Define customer eligibility based on the customer, bill-to,
or ship-to qualifiers. Define additional conditions based on an order type or a salesperson. Specify rebate amounts in
terms of the percentage or the amount per unit.

This feature benefits wholesalers, distributors, and manufacturers to incent channel sales by offering rebates on eligible
sales transactions.

This program provides the ability to:

Negotiate and activate customer promotions.
Define customer and product eligibility.

- Define accruals by amount or percentage.

Customer Volume Program
Use customer volume programs to accrue volume rebates based on cumulative sales volumes across orders.

®
r

Retrospectwe

1

You can define the product eligibility based on item or for all items. You can also apply exclusions at the item level.

The program encourages the desired channel purchasing behavior within a specific time frame and increases the
channel sell-through.

The program provides the ability to:

Incentivize channel customers to reach predefined purchasing volume levels, and to track these rebates on
each eligible sales transaction.

12
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- Streamline and automates tracking and payment of volume rebates.

- Improve financial visibility to volume program liabilities.

Customer Lump Sum Program
A customer lump sum program is an agreement which pays out an previously agreed-to amount and may require a
customer to carry out certain trade promotion activities.

For example, an advertising campaign, on behalf of a manufacturer. You can create a lump sum program to capture the
terms of the agreement. The incentive is accrued up front when the program is activated and available for immediate
payment.

This program enables you to:

- Define trade promotion activities agreement and terms that:
o Pay out a previously agreed-to amount

o May require a customer to carry out certain trade promotion activities on behalf of the manufacturer or
wholesaler

- Create, track, and pay immediate accruals including slotting fees, marketing incentives, and other non-
transactional incentives.

Related Topics
» Elements of a Customer Annual Co-op Program

- Elements of a Customer Annual Volume Program
« Elements of a Customer Promotion Program

« Elements of a Customer Volume Program

- Elements of a Customer Lump Sum Program

How Customer Programs Work

Customer programs work on top of Deductions and Settlement providing centralized deductions and settlement in
Receivables, and provides promotional settlement of claims.

Use Customer Channel Management to activate customer programs that incentivize channel purchase behavior for a
specific time frame, thus increasing the channel sell-through.

13
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Customer Channel Program Flow

Customer Channel Manager Customer Channel Approvers Any Receivables Channel Operations. Financials
Sweep Channel
Transaction
Accounting
Define Program Activate Invoice L’_Joods . Creats__- Events Post to GL
Program & Services Accounting

View Customer
Checkbook

iew Program

Checkbook Import Invoices

via csv

Create Accruals
TOMolIon

for Channel olume
Batch Programs
Create Accruals Annual
for Volume _eums
} _ Frograms
Programs

Create Accruals

Ce-op

for Co-op e
Programs Programs
Update
Customer
Accruals
Summary
Create Manual
Adjustment
Scheduled Financial
Legend Process Process | Integrafion
1. Operational administrators create program types representing channel business processes.

2. Channel sales managers negotiate and activate the programs based on configured program types.
3. Channel customers purchase products through orders that are fulfilled and invoiced, and expect a rebate if
eligible.
4. Operational administrators ensure sales transactions are imported via CSV, then process these transactions to
create accruals as follows:
o Use the Create Accruals for Channel Batch process to create accruals for customer promotion and
customer volume programs.
o Use the Create Accruals for Volume Programs process to create accruals for customer annual volume
programs.
o Use the Create Accruals for Co-op Programs process to create accruals for customer annual co-op
programs.
5. Create, update, view, or delete manual accrual adjustments to correct missed accruals, reverse invalid accruals,
and to create starting balances for customer rebate, lump sum, and co-op programs.
6. Earned accruals are then tracked in the customer checkbook and program checkbook and posted to GL.
7. Channel claim analysts investigate claims and settle them as promotional against available program accruals.
8. Associated accruals in a claim are relieved in GL.
Related Topics

« How Deductions and Settlement Works with Receivables and Payables

14
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How Customer Programs are Executed Against Invoiced Sales
Orders

Here's how customer programs are executed against invoiced sales orders:

The Import Management framework can be used to import sales orders and invoices using CSV. Eligible rebates are
calculated according to the terms of the program and accrued.

- A set of validations are in place to identify any errors during import.

- The successful upload of the CSV file creates a batch of transactions for processing in the open status. You can
view details of this batch on the Manage Batches page. The batch name is the same as the import activity name
that you entered.

- The following processes check the eligibility of the batch lines and creates accruals for the eligible ones. A
supply chain application administrator can create the channel accruals on demand or schedule it as a periodic
batch process.

o Create Accruals for Channel Batch: This process checks the eligibility of the batch lines and creates
accruals for eligible customer promotion and customer volume programs.

o Create Accruals for Volume Programs: This process checks the eligibility of the batch lines and creates
accruals for eligible customer annual volume programs.

o Create Accruals for Co-op Programs: This process checks the eligibility of the batch lines and creates
accruals for eligible customer annual co-op programs.

After creation, you can:
- Track customer program accruals.
- View the performance of your customer programs using the customer and program checkbooks.

Consideration: If you import sales orders and invoices via the CSV file (Batch Transaction Type =
ORA_SALES_ORDER_CSV), then you must first import the CSV file, and only then schedule the processes to create
accruals.

Note: No eligibility check is performed for customer lump sum programs, hence, you don't need to run any of the
above scheduled processes for these programs.

Related Topics
« Import Customer Invoices

« Overview of Managing Manual Adjustments
« How do | import data?
« How do | map import fields?

Overview of Managing Manual Adjustments

You can manage manual adjustments to:

Enable creation of starting balances in implementations.
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Improve robustness of the solution to handle missed and invalid accruals.

You can use the Channel Customer Manual Adjustments REST API to:

- Create, update, view or delete manual accrual adjustments to correct missed accruals, reverse invalid accruals,
and to create starting balances for customer rebate, lump sum, and co-op programs.

- Create necessary adjustment accruals using the Submit action.

Note: Channel REST APIs are available under the Order Management Tasks.

REST API for Oracle Fusion Cloud SCM

How Customer Claims Are Processed

Here you'll understand how customer claims are processed in Channel Revenue Management.

There are 4 stages in the life cycle of a customer claim.
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Understanding Claims Status Transitions

Receivables User Claims User Interface Channel Operations Applied Transactions

Canceled

Netting In
Progress

ik Yes

: User has Settlement N
Receipt Open P pproval rale? > Pending '
I

|

J=\ Mo 1

Related

Receipt

Approval
Rejected

Settled

Y

Approval
Pending

1. Creation
Claims can be created by the following methods:

o A claim investigation activity, initiated in Receivables by a receivables manager, creates a claim in
Channel Revenue Management.

- Deduction claim: From short payments in a receipt
- Overpayment claim: From over payments in a receipt

o A channel revenue claim, initiated in Receivables by a receivables manager against an invoice application
line of a receipt creates a claim in Channel Revenue Management.

- Invoice Deduction claim: From short payments against the invoice

- Invoice Overpayment claim: From over payments against the invoice
o Claims can be created through Receivables lockbox.
o A manual claim can be created directly in Deductions and Settlement.

o A manual claim initiated by a 3rd party application can be created through a REST service.
Once created, the claim is assigned to a claim owner. A claim owner can be assigned at various levels: business

unit, customer, account, or bill site. The deductions analyst assigned to the claim will investigate and resolve the
claim.

Note: Multiple non-invoice related claim investigation applications can be performed per receipt, as long as
the sum of application amounts is equal to the receipt amount.
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2. Resolution

Chapter 1

Overview of Channel Revenue Management Cloud

This table lists the available settlement methods for each claim source and the action that created the claim.

Receivables Action

Create Claim Investigation

Create Claim Investigation

Create Channel Revenue Claim

Create Channel Revenue Claim

N/A

Claim Source

Deduction

Overpayment

Invoice Deduction

Invoice Overpayment

Manual Claim

Settlement Method

Credit Memo - On Account

Manual Write-off

Auto Write-off

Invoice

Credit Memo on Account

Credit Memo on Invoice

Chargeback

Manual Write-off

Auto Write-off

Invoice

Credit Memo on Account

Custom Settlement Method

Check

Payables Default Payment

Apply Open Transactions

Open Credit Memos

Open Overpayments

Open Deductions

Open Credit Memos

Open Overpayments

Open Deductions

None

o A deduction can be resolved by creating a credit memo on account or invoice, or by applying existing
credit memos or overpayments.

o An overpayment can be resolved by creating an invoice or by applying existing deductions.

o When existing deductions or overpayments are applied, these claims are reserved so that they can't be
accidentally applied again.

ORACLE
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3. Submission
After resolving the claim, the analyst submits it for approval and settlement.

o If the analyst has been assigned the approval role, then the claim goes straight to Settlement Pending
status, awaiting processing by the Settle Customer Claims scheduled process.

o If the analyst doesn't have the approval role, then the claim will move to Approval Pending status,
awaiting approval. The approver can either approve or reject the claim.

o Rejection puts the claim in Approval Rejected status, and the deductions analyst can move it back to
Open status to correct the claim. Only a Receivables analyst can cancel the claim, from the receipt.

4. Settlement

On a periodic basis, you can schedule the Settle Customer Claims process, which performs the creation of the
resolution artifacts or settlement methods in Receivables, and then applies them to the appropriate receipt.
These credit memos and invoices will have the transaction source as Channel Revenue Management.

o If applicable, taxes are calculated and applied to the claim.

o If there is any remaining unsettled amount which is below the set threshold, it's written off.

o If there is any remaining unsettled amount and write-offs don't apply, a child claim is automatically
created and applied to the receipt.
o The original claim investigation is reversed in the receipt.

If an invoice deduction claim is settled with a settlement method other than Credit Memo - On Invoice, the
following happens during settlement:

o Unapplies the invoice application on the receipt and reapplies the invoice application on the receipt for
the original application amount plus the amount settled.
o Applies the Receivables transaction created as the settlement document to the receipt.

o The dispute on the invoice is removed to the extent of the settlement amount.

How Customer Accruals are Accounted

Here you'll understand how customer accruals are accounted in Channel Revenue Management.
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: Sweep Channel
Transaction
Accounting Event

Accrue Earned Customer Channel Incentives

1. Customer Promotions: After channel sales are uploaded, eligible channel incentives can be captured using the
Create Accruals for Channel Batch process.

2. A supply chain application administrator can create these accruals on demand or schedule it as a periodic batch
process.

3. After an accrual is earned, it can be posted to the general ledger.

4. A general accounting manager can post earned accruals to the general ledger on demand or schedule it on a
periodic basis. The integration to general ledger supports the Subledger Accounting architecture to drive the
accounting.

Relieve Customer Channel Accruals

1. Customer claims create in from the Receivables and Lockbox integration. Optionally, manual claims can be
created.

2. After the Settle Customer Claims scheduled process, associated accruals from promotional claims are relieved
by posting to the general ledger.

3. A general accounting manager can post earned accruals to the general ledger on demand or schedule iton a
periodic basis. The integration to general ledger supports the Subledger Accounting architecture to drive the
accounting.

4. Sweep the unprocessed channel journal entries from closed accounting periods to open or future enterable
periods using the Sweep Channel Transaction Accounting Events process. Run the Create Accounting
process to post these to GL.

Related Topics
» Create Accruals for Channel Batch

» Schedule the Accounting of Channel Accruals and Relief of Accruals to General Ledger
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Supplier Programs

Supplier Rebate

Supplier Rebates

Here you can learn about what wholesalers and retailers can do using Channel Revenue Management.
Channel Revenue Management provides wholesalers and retailers the ability to:
- Centralize rebate programs from suppliers

You can:

o Capture program details including the supplier, effective dates, and alternate suppliers if applicable.
o Define product eligibility.
o Support accruals based on amount, or percentage.

- Automate accrual tracking

This leads to better visibility and faster realization of supplier incentives.

- Automate claim processing

This helps reduce margin leakage through accurate claim computation, thereby reducing supplier rejection.
The streamlined process helps wholesalers realize value faster on supplier rebate claims.

- Automate channel accounting

The faster realization from supplier incentives through automation reduces time to implement and the cost of
ownership.
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Supplier Rebate Overview

Chapter 1
Overview of Channel Revenue Management Cloud

Supplier rebates is the process by which the supplier offers incentives to the wholesaler or retailer to purchase more.

These are the five basic steps for a wholesaler/retailer:

1. Supplier offers rebates for specific purchases.

2. Wholesaler/retailer buys from the supplier and supplier ships the goods.
3. Wholesaler/retailer receives the shipment of goods and invoice from the supplier. Accruals are typically earned

upon receipt of supplier invoice for received goods.

4. Accruals are compiled into claims for review and approval.

5. The claims are settled by issuing debit memos (or payments against the supplier invoice for supplier rejections).

How Supplier Rebate Works

You can use Channel Revenue Management to create supplier programs and activate them so that eligible supplier
accruals can be automatically applied to receiving transactions that have been invoiced by the supplier, or to supplier
invoices directly imported into Channel Revenue Management. Here's how

ORACLE
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1. The wholesaler or retailer activates their supplier rebate programs.

2. The wholesaler/retailer buys from the supplier.

3. Supplier ships goods to the wholesaler/retailer and supplier invoices are created for the shipment.
4. The wholesaler or retailer receives the goods, makes corrections or accepts them.

5

. Channel Revenue Management then processes these transactions to create accruals. This can be done in 2
ways:

o Directly process the receiving transactions and their supplier invoices. Accruals can be accrued upon
receipt of shipment or upon receiving the supplier invoice. Typically, accrual happens upon supplier
invoicing.

o Processes supplier invoices imported using CSV files to create accruals.

o

Earned accruals are then tracked, posted, and accrued.
Supplier claims are generated on demand or scheduled on a periodic basis.

N

Chapter 1
Overview of Channel Revenue Management Cloud

8. Approved supplier claims are sent to Payables to collect payment from the suppliers, and accruals are relieved.

If the supplier rejects a claim line, a manual adjustment can be created to reverse the accrual.
9. After payment, the claims are closed.

ORACLE
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Business Process Flow

Supplier Rebate Flow
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Related Topics

« How Supplier Claims Work

« How Supplier Accruals are Accounted

How Supplier Rebate Works with Receiving and Payables

Here's how supplier rebate works with Oracle Fusion Receiving and Oracle Fusion Payables to support inbound receiving
transactions from Oracle Fusion. Accruals can be accrued upon receipt of shipment or upon receiving the supplier
invoice. Typically, accrual happens upon supplier invoicing.

ORACLE
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Load Transactions

The Load Transactions process imports the receiving transactions from Receiving into Channel Revenue Management.
A new batch is created with each load. It:

- Extracts receiving transactions and related PO details.

- Stores them as lines of a batch (1 batch per Load Transactions scheduled process).

Create Accruals from Channel Batch

The Create Accruals for Channel Batch process converts the batch lines into accruals. A supply chain application
administrator can create the channel accruals on demand or schedule it as a batch process on a periodic basis.

If the channel setting Event for Triggering Supplier Rebate Accrual = Receiving Transaction, then

- if the batch line is eligible, then
creates earned accruals

If the channel setting Event for Triggering Supplier Rebate Accrual = Supplier Invoice, then Channel receives the supplier
invoices directly from Payables, or are imported using CSV files.

- if the batch line is eligible but not invoiced, then

creates open accruals

- if eligible and invoiced, then
creates earned accruals

For example, a receiving transaction for a quantity of 10 units can be invoiced for a quantity of 8 units. Here, open
accruals will be recorded for a quantity of 2 units, and earned accruals will be recorded for 8 units.

Related Topics
» How Supplier Claims Work

« How Supplier Accruals are Accounted
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How Supplier Rebate Works with Imported Supplier Invoices

The Import Management framework can be used to import supplier invoices using CSV files into Channel Revenue
Management. Supplier rebate accruals are then accrued according to the terms of the agreement with the supplier.

- A set of validations are in place to identify any errors during import.

- The successful upload of the CSV file creates a batch of transactions for processing in Channel Revenue
Management.

- The Create Accruals for Channel Batch process checks the eligibility of the batch lines and creates accruals
for the eligible ones. A supply chain application administrator can create the channel accruals on demand or
schedule it as a batch process on a periodic basis.

Consideration: If you import supplier invoices via the CSV file (Batch Transaction Type =
ORA_SUPPLIER_INVOICE_CSV), you must first import the CSV file, and then schedule the processes to create accruals
(Create Accruals for Channel Batch).

Related Topics
« Import Supplier Invoices

« How do | import data?
« How do | map import fields?
« Create Accruals from Imported Supplier Invoices

Supplier Annual Rebate

Supplier Annual Program

Supplier annual rebate is the process by which a wholesaler or retailer purchases goods from a supplier over a period of
time, typically a year.

The supplier may offer annual rebates that encourages buying based on accumulated volume attainments for the year.
Target attainments are tiered. For instance, if you purchase under a million dollars, you get 3% discount. If you purchase
between 1and 2 million dollars, you get 5%. Above 2 million, you get 8%.

Channel Revenue Management provides wholesalers and retailers the ability to:
- Centralize annual rebates from suppliers
You can define annual programs based on accumulated attainments across orders, including:

o Percentage rebate based on purchase value tiers
o Amount rebate per UOM based on quantity tiers

- Automate accrual tracking

This leads to better visibility and faster realization of supplier incentives.

- Automate claim processing

This helps reduce margin leakage through accurate claim computation, thereby reducing supplier rejection.
The streamlined process helps wholesalers realize value faster on supplier rebate claims.
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- Automate channel accounting

The faster realization from supplier incentives through automation reduces time to implement and the cost of
ownership.

Tier 3
%

Volume Attainments

Supplier Annual Program Overview

Supplier annual rebate is the process by which a wholesaler or retailer purchases goods from a supplier across a
duration of time, typically a year. What makes supplier annual rebates different from supplier rebates is that volume
attainments are accumulated across orders. In supplier rebates, rebates are in the context of a given transaction. In
supplier annual rebates, rebates are in the context of accumulated volume attainments across orders over a period of a
year.

1. Supplier offers or negotiates an annual rebate.

2. Wholesaler/retailer buys from the supplier and supplier ships the goods.

3. Wholesaler/retailer receives the invoice from the supplier and accumulate volumes across orders.

4. Accruals are calculated as percentage rebates based on purchase value tiers, or as an amount rebate per unit of
measure based on quantity tiers. Retrospective or stepped calculations are supported.

5. Accruals are compiled into claims for review and approval.

6. The claims are settled by issuing debit memos (or payments against the supplier invoice for supplier rejections).
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How Supplier Annual Program Works

You can use Channel Revenue Management to create supplier annual programs and activate them so that eligible
supplier accruals are automatically calculated from supplier invoices imported into Channel Revenue Management.
Here's how the supplier annual program business process works in Channel Revenue Management.

Annual Program Track Accruals

M s .
£ B

« Supplier offers annual « Get supplier invoices
rebate « Accumulate across orders
= Define program + Record accruals
= Purchase goods + Generate accurate
accounting
Settle Fast Accurate Claims

9 =
P 2 —

» [ssue debit to + Compile accruals &
suppliers generate claims
+ Review claims

1. The wholesaler or retailer activates their supplier annual programs.
2. The wholesaler/retailer buys from the supplier.

3. Supplier ships goods to the wholesaler or retailer and supplier invoices are created for the shipment. Volumes
are accumulated across orders.

4. Channel Revenue Management then processes the supplier invoices imported using CSV files to create
accruals.

5. Earned accruals are then tracked, posted, and accrued.
6. Supplier claims are generated on demand or scheduled on a periodic basis.

7. Approved supplier claims are sent to Payables to collect payment from the suppliers, and accruals are relieved.
If the supplier rejects a claim line, a manual adjustment can be created to reverse the accrual.

8. After payment, the claims are closed.
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Business Process Flow
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How Supplier Annual Rebates Work with Imported Supplier Invoices

The Import Management framework can be used to import supplier invoices using CSV files into Channel Revenue
Management. This is the same Import Management framework supported for supplier rebates. Supplier annual rebate
accruals are then accrued according to the terms of the agreement with the supplier.

Consideration: If you import supplier invoices via the CSV file (Batch Transaction Type =
ORA_SUPPLIER_INVOICE_CSV), you must import the CSV file, and then schedule the processes to create accruals
(Create Accruals for Volume Programs).

- A set of validations are in place to identify any errors during import.
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- The successful upload of the CSV file creates a batch of transactions for processing in Channel Revenue
Management.

- The Create Accruals for Volume Programs process checks the eligibility of invoice lines, aggregates and
creates accruals for the eligible ones. A supply chain administrator can schedule the program on a periodic
basis, for example, monthly.

Unlike supplier rebates, supplier annual rebates don't create an accrual for each invoice line. Instead, qualified
invoice lines are aggregated and a single accrual is created. Invoice lines are aggregated by business unit,
program, volume rule, period, item, ship-to location, bill-to location, and alternate supplier site if applicable.
This is an important distinction from supplier rebates.

Related Topics
« How do | import data?

« How do | map import fields?

Supplier Ship and Debit

Supplier Ship and Debit

Here you can understand what distributors can do using Channel Revenue Management.

Channel Revenue Management on the buy side is a supply chain management application that can help prevent margin
leakage in your channel business processes with greater efficiency. With supplier ship and debit, distributors can:

- Centralize ship and debit programs from suppliers.
- Automatically apply eligible supplier programs at order capture.
- Automate accruals tracking and claims processing.

Supplier Ship and Debit Overview:
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Centralize Supplier Programs
Use Channel Revenue Management as your hub to manage ship and debit agreements from suppliers. You can:
- Capture program details including the supplier, effective dates, and supplier authorization number.
Define customer eligibility and product eligibility.
- Support accruals based on amount, new cost, or percentage basis.

Automatically Apply Eligible Programs at Order Capture

Sales can see eligible supplier programs and calculate channel discounts providing margin visibility before they book an
order. Accruals can be included in margin calculations.

Automate Accruals Tracking and Claims Processing

For many distributors, profitability is determined by the ability to track and collect supplier incentives. Channel Revenue
Management automates accrual tracking, providing you with real-time visibility to the earned, collected, and balance
accruals, for each program. Earned accruals are tracked in channel's subledgers and posted to the general ledger. Real-
time supply chain integrations provide accurate supplier balance tracking and compliant accounting practices. You can:

Improve your productivity by generating and processing supplier claims online. Accruals are relieved in General
Ledger after claims are approved, and pending settlement.

- Settle supplier claims through Payables and automatically close the claim.
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Supplier ship and debit is the process by which a distributor ships goods at a lower than usual price to the customer and
debits the supplier for the additional discount from the acquisition price. The additional discount is claimed from the
supplier.

These are the four basic steps for a distributor:

1. Request a Ship and Debit Agreement from Supplier

The salesperson for the distributor can request this new price or can decide on this price to win a deal in hopes
that it will be approved. To debit the supplier for the difference, the distributor requests a special price from the
supplier. If the supplier approves, a supplier ship and debit program can be created and sales are made against
the program.

2. Ship to Customer

The distributor ships to the customer and earns the accrual. Accruals are calculated.
3. Claim Debit from Supplier

The distributor creates a claim with a matching debit memo or a supplier invoice to pay back the transactions (if
it is a supplier rejection), in Payables. Payables issues a debit memo or invoice to the supplier.

4. Settle Claim

The issuance of a debit memo (or payment against the supplier invoice if it is a supplier rejection) closes the
claim.

How Supplier Ship and Debit Works

You can use Channel Revenue Management to create a supplier program and activate it so eligible supplier accruals can
be automatically applied at order capture. Here's how the distributor's supplier ship and debit business process works in
Channel Revenue Management.
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The distributor requests a special price or the supplier issues a special price.
An agreement between the distributor and the supplier is reached with the supplier providing an authorization
number to the distributor.
The distributor defines a supplier ship and debit program capturing the supplier, date effectivity, customer
eligibility, and product eligibility.

o Channel Revenue Management gets supplier sites already defined in Procurement and associates them

to a supplier ship and debit program.
o Date eligibility can be based on requested ship date or ordered date.

o Customers from Trading Community Hub are used to define customer eligibility.

o Item and unit of measure attributes from the Product Information Management work area can be used to
define product eligibility rules.

o The supplier incentive can be defined as a flat amount, a new cost, or a percentage.

o A supplier ship and debit program must belong to the same business unit as the supplier site.

The distributor activates the supplier ship and debit program. Approvals are optional.

The distributor creates a sales order and eligible program accruals are applied automatically or by request.
Earned accruals are tracked and accrued. Manual adjustments can be created for accruals that were missed or
needed correction.

Supplier claims are generated on demand or scheduled on a periodic basis.

Supplier claims are sent to Payables to collect payment from the suppliers, and accruals are relieved.
After payment, the claims are closed.
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How Supplier Ship and Debit Works with Order Capture Systems

Here's how supplier ship and debit works with order capture systems.
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1. Sales creates a sales order in an order capture application specifying the customer, bill-to, and ship-to
information, then adds several items with their quantity, unit of measure, and other fulfillment line details.

2. The order capture application gets the list of all eligible programs.

o Most programs are automatically applied to the line items.

o Atype of program can be defined to be applied by request only. A sales user can apply these manual
programs to line items.
o Most programs can be declined by a sales user, but a type of program can be prevented from being
declined by sales users.
3. With the list of eligible programs, the order capture application calls on Oracle Fusion Pricing to calculate the
incentives.
4. A supply chain application administrator can create channel accruals on demand or schedule it as a batch
process on a periodic basis using the Create Accruals scheduled process. Channel related charge lines from the
order capture application are created as channel transactions.

Related Topics
« Manage Program Types

How Supplier Claims Work

Here's how supplier claims work for the buy side.
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. After an accrual is captured in Channel Revenue Management and earned, it's eligible to be picked up in a

supplier claim. Manual adjustments are also reflected in supplier claims.

A supply chain application administrator can generate a supplier claim on demand or schedule it as a batch
process on a periodic basis, using the Generate Supplier Claims scheduled process.

o The process can generate a single claim for a single supplier site, or multiple claims, at least one claim for
each supplier.

o Various parameters can be used to identify the earned accruals and manual adjustments to be included
for claim generation.

o The generated claim can be immediately sent to Payables for supplier payment or sent to the claim
analyst for review and approval.

The Financials Cloud integration can be configured to collect payment from the supplier.

Claims are settled by the Payables process Import Payables Invoices, with the Source parameter set to Claims.
This checks when payment has been successfully debited and retrieves settlement details such as debit memo
number or check number to confirm the claim settlement.

A general accounting manager can relieve accruals in Channel Revenue Management on demand or schedule it
as a batch process on a periodic basis using the Create Accounting scheduled process.

After payment, a supply chain application administrator can close the settled claims on demand or schedule it
as a batch process on a periodic basis using the Close Settled Claims scheduled process.

If the supplier declines a claim line, the distributor investigates and creates a manual adjustment to reverse the
accrual.
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Related Topics
« Manage Supplier Claim Sources and Settlement Methods

« How Payables Standard Invoice Import Data Is Processed

Overview of Managing Supplier Programs

Here you understand how to manage supplier programs in Channel Revenue Management.
Here's what you can do:
- Create a program or have suppliers create their own program via the Supplier Portal.
Edit a draft program.

- Submit a program for approval.

- Activate a program so channel incentives can be applied to sales orders, receiving transactions, or supplier
invoices.

Edit active programs in a limited fashion.

- Terminate active programs, locking them down from update and further application to sales orders, receiving
transactions, or supplier invoices.

Overview of Managing Adjustments

Here's what you can do.

- Create a positive or negative accrual adjustment.
- Approve the adjustment for supplier rebate adjustments.

Reverse an accrual.

Once created or approved in the case of supplier rebate adjustments, you can't edit or delete an adjustment.
You must create a reversal adjustment to negate an original adjustment.

How Supplier Claims Are Processed

On a periodic basis, a distributor creates supplier claims to collect on channel incentives. Typically, earned incentives are
gathered and associated with a supplier claim.
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. After an accrual is captured in Channel Revenue Management and earned, it's eligible to be picked up in a

supplier claim. Manual adjustments are also reflected in supplier claims.

A supply chain application administrator can generate a supplier claim on demand or schedule it as a batch
process on a periodic basis, using the Generate Supplier Claims scheduled process.

o The process can generate a single claim for a single supplier site, or multiple claims, at least one claim for
each supplier.

o Various parameters can be used to identify the earned accruals and manual adjustments to be included
for claim generation.

o The generated claim can be immediately sent to Payables for supplier payment or sent to the claim
analyst for review and approval.

The Financials Cloud integration can be configured to collect payment from the supplier.

Claims are settled by the Payables process Import Payables Invoices, with the Source parameter set to Claims.
This checks when payment has been successfully debited and retrieves settlement details such as debit memo
number or check number to confirm the claim settlement.

A general accounting manager can relieve accruals in Channel Revenue Management on demand or schedule it
as a batch process on a periodic basis using the Create Accounting scheduled process.

After payment, a supply chain application administrator can close the settled claims on demand or schedule it
as a batch process on a periodic basis using the Close Settled Claims scheduled process.

If the supplier declines a claim line, the distributor investigates and creates a manual adjustment to reverse the
accrual.
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How to Claim Supplier Accruals

1.

W

Schedule the Generate Supplier Claims process. This creates claims for the channel accruals and manual
adjustments.

o Claim status: Settlement Pending

o Each claim settlement line contains the program and the line items on which it was applied.

Import these claims to Payables using the Import Payables Invoices process. The claims are now available in
Payables for payment.

Process the Payables invoice.

Close the claims after payment is confirmed by running the Close Settled Claims process. This updates the
claim with:

o Claim status: Settled

o Invoice or payment instrument details issued by Payables

How Supplier Accruals are Accounted

Here you understand how supplier activity is accounted in Channel Revenue Management.
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Supplier Rebate: After receiving transactions are loaded into Channel Revenue Management and supplier
invoices are received, eligible program discounts can be captured using the Create Accruals for Channel Batch
process.

Supplier Ship and Debit: When an order is created in an order capture application, eligible program discounts
are calculated and applied as channel incentives on an order line. After the order is invoiced, it's eligible to be
brought into Channel Revenue Management as a channel accrual.

A supply chain application administrator can create these accruals on demand or schedule it as a batch process
on a periodic basis.

Accruals that were missed or needs correction can be added as manual adjustments.
After a channel accrual is earned based on its program rules, it's eligible to be posted to the general ledger.

A general accounting manager can post earned accruals to the general ledger on demand, or schedule it as
a batch process on a periodic basis. The integration to General Ledger supports the Subledger Accounting
architecture to derive the accounting.
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Relieve Supplier Accruals

1. You can create claims against the accruals using the Generate Supplier Claims process.

2. After a claim is created (or approved) and is pending settlement, it's eligible to relieve its accruals by posting to
the general ledger.

3. A general accounting manager can post relief of accruals to the general ledger on demand or schedule it as
a batch process on a periodic basis. The integration to General Ledger supports the Subledger Accounting
architecture to derive the accounting.

4. Sweep the unprocessed channel journal entries from closed accounting periods to open or future enterable
periods using the Sweep Channel Transaction Accounting Events process. Run the Create Accounting
process to post these to GL.

5. After payment, close the settled claims using the Close Settled Claims process.

Related Topics
» Overview of Buy Side Scheduled Processes

Sign in to Channel Revenue Management

You must sign in to Channel Revenue Management to access its various features.

1. From your administrator, get the following details:

o URL to access Channel Revenue Management.

o User account with the required privileges to manage the different features of Channel Revenue
Management along with the password.

2. After signing in, select the navigator.

o To access the supplier features of Channel Revenue Management, select Supplier Channel Management
under Order Management or Procurement.

o To access claim settlement and deduction features, select Deductions and Settlement under Order
Management.

o To access centralized rebate features for channel customers, select Customer Channel Management.

Note: If you have the Manage Customer Programs or the View Customer Programs privilege, then you
can see the Customer Channel Management icon on the Fusion home page.

On the buy-side, your supplier contacts can access Channel Revenue Management through the supplier portal:

1. From your administrator, get the following details:

o URL to access the Supplier Portal.
o User account with the required privileges to manage the Supplier Portal along with the password.

2. After signingin, select the navigator. To access the channel programs, select Supplier Portal under Supplier
Portal. From the Supplier Portal dashboard, select Tasks, select Channel Programs, and then select Manage
Supplier Programs.
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2 Implement

Starting Decision Points

Decision Points guide you in identifying the flows and deciding on the features for which you want to opt in as part of
your implementation.

The following decision points help you to evaluate what you must implement:

Sell Side

1.

Identify the flows you want and their respective user communities.

If you require the Deductions and Settlement flow, then under the Order Management offering, you must opt in
to the function area Channel Revenue Management. Now, opt in to the feature Deductions and Settlement.

Use the following table to decide on the additional flows you require.

Supported Coexistence Scenarios Opt into Deduction and Settlement Opt into Customer Channel Management
Settlement of nonpromotional claims Yes No
Settlement of nonpromotional and Yes Yes

promotional claims

Promotional rebates and payment, without = No Yes
bringing in short pays from AR

Buy Side

Identify the flows you want and their respective user communities.

If you require the Deductions and Settlement flow, then under the Order Management offering, you must opt in
to the function area Channel Revenue Management. Now, opt in to the feature Deductions and Settlement.

If you require any buy side flow, then consider whether your user communities already use other Procurement
Cloud applications.

If a user community requires access from Procurement, then under the Procurement offering you must opt in
to the functional area: Supplier Incentives under the Purchasing functional area, and then opt in to the feature:
Supplier Channel Management.

If a user community requires access from Order Management, then under the Order Management offering you
must opt in to the functional area: Channel Revenue Management, and opt in to the feature: Supplier Channel
Management.

Solution Components of Sell Side Flows

Here you'll learn about the solution components of Deductions and sell side flows.
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The following table summarizes the solution components of Deductions and Settlement and sell side flows.

Flows

Deductions and Settlement
(Nonpromotional
settlement)

Customer Promotions
(Promotional settlement)

Program Administration

N/A

Programs Ul
Customer Checkbook Ul
Update Customer Accruals

Summary(scheduled
process)

Inbound Integrations

Claims from Oracle
Receivables

- Claims from Oracle
Receivables

- Import Management
for CSV Sales Orders

- Create Accruals
for Channel Batch
(scheduled process for
Customer Promotions
and Customer Volume
programs)

- Create Accruals for
Volume Programs
(scheduled process
for Customer Annual
Volume programs)

. Create Accruals for
Co-op Programs
(scheduled process for
Customer Annual Co-
op programs)

- Manual adjustments

Claims Administration

Claims Ul

Create Manual Claims Ul

Claims Ul

Create Manual Claims Ul

Outbound Integrations

Integration with Oracle
Receivables happens
when you run the
Settle Customer Claims
(scheduled process).

Integration with Oracle
Receivables happens
when you run the
Settle Customer Claims
(scheduled process).

Create Accounting
(scheduled process)

Sweep Channel Transaction
Accounting Events
(scheduled process)

Roadmap for Setting Up Deductions and Settlement

Use this as a roadmap to implement Deductions and Settlement in Channel Revenue Management.

Sell side channel flow offers and administers discounts to the customers. Although deductions aren't always the results
of discounts to customers, promotional rebates can be the reason behind a customer short pay, and is considered as
a sell side channel flow. End users of Channel Revenue Management get separate Uls for buy side vs sell side channel

flows.

This roadmap can be used as a check list to implement Deductions and Settlement. Each of these setup steps is
explained in detail in the later sections of this guide.

Use the Functional Setup Manager to:

1. Optin to Channel Revenue Management, and Deductions and Settlement.
2. Manage these channel settings:
o Claim Owner

o Automatically Show Available Programs to Associate

ORACLE
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P ow

10.

1.

12

o Settlement Type

o Aging Method for Filtering

o Credit Method for Accounting Rules

o Credit Method for Installments

o Deduction Threshold

o Receivables Activity for Receipt Write-Offs

o Receivables Activity for Write-Off Adjustment

Manage user statuses.
Manage claim types including the standardization of accounting for write offs.

Under the offering: Financials, navigate to the task Manage Legal Entity Configurator Profile Options. Set the
profile Enable Legal Entity Time Zone at the Site level.

Run the ESS job to create index definition and perform initial ingest to OSCS scheduled process to create
index definitions and perform the initial ingest to OSCS for the program index. Running this process enables
smart search.

Set the Default Business Unit profile option at the user level when creating a manual claim and viewing the
customer checkbook.

Manage claim reasons.
Manage these claim sources and their settlement methods:
o Deduction

o Overpayment

o Invoice Deduction

o Invoice Overpayment
o Manual Claim

Manage these setups related to the Oracle Fusion Receivables integration, including the accounting for
Deductions and Settlement:

o Manage transaction sources.
o Manage Receivables activities.
o Manage SLA setup tasks.

Manage these setups related to the Custom Settlement (applicable for manual claims) integration:
o Manage claim sources and applicable custom settlement methods.

o Manage suppliers, if required, for a custom settlement method in an External AP.

Manage these setups related to the Payable integration:
o Manage claim sources and applicable Payables settlement methods.

o Configure suppliers in Customer Trade Profiles for a Payables settlement method, if required.

Scheduled Processes You Must Run

You must schedule the following processes for Deductions and Settlement:

« Settle Customer Claims

- Mass Settle Claims

« Mass Update Claims
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Related Topics
« What are scheduled processes?

« Submit Scheduled Processes and Process Sets
« Statuses of Scheduled Processes

Roadmap for Setting Up Customer Channel
Management

This sell side channel flow receives and administers rebates to customers.

Note: Implement Deductions and Settlement before implementing Customer Channel Management. Start with the
Roadmap for Setting Up Deductions and Settlement.

Use this roadmap as a check list to implement the sell side promotion flows. Each of these setup steps is explained in
detail in the later sections of this guide.

Use the Functional Setup Manager to:

1. Optin to Channel Revenue Management, and Customer Channel Management.

2. If you need deductions from Receivables, then opt in to the Deductions and Settlement feature. Then opt in to
the Manage Deduction Claims Using Redwood Pages feature.

3. Under the offering: Financials and functional area: Receivables, navigate to the task Manage Receivables
System Options. Search for and select your business unit. Click the Cash Processing tab. Select the Enable
channel revenue management integration check box and click Save.

4. Under the offering: Financials, navigate to the task Manage Legal Entity Configurator Profile Options. Set the
profile Enable Legal Entity Time Zone at the Site level.

5. Run the ESS job to create index definition and perform initial ingest to OSCS scheduled process to create
index definitions and perform the initial ingest to OSCS for the program index. Running this process enables
smart search.

6. Optionally, you can set the Default Business Unit profile option at the user level when creating a program and
viewing the customer checkbook.

7. Configure program types.

Program Type Configuration Steps

Customer Annual Co-op a. Configure program types based on the customer annual co-op program template.
b. Negotiate and activate programs based on the configured program type.

Customer Annual Volume a. Configure program types based on the customer annual volume program template.
b. Negotiate and activate programs based on the configured program type.

Customer Promotion a. Configure program types based on the customer promotion program template.
b. Negotiate and activate programs based on the configured program type.

Customer Volume a. Configure program types based on the customer volume program template.
b. Negotiate and activate programs based on the configured program type.

Customer Lump Sum a. Configure program types based on the customer lump sum program template.
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Program Type Configuration Steps

b. Negotiate and activate programs based on the configured program type.

8. Optionally, configure user statuses for programs.
9. Manage the channel settings:
o Automatically Show Available Programs to Associate: By default, Available Programs to Associate are
displayed. Change this setting if you don't want to display the programs available for association.
o Catalog: Use this setting for customer annual co-op programs and for customer annual volume
programs.
o Calendar: Use this setting to determine periodic basis of aggregated accruals for customer annual co-op
programs and for customer annual volume programs.
o Settlement Type: This is an optional setting.
10. Set up the product catalog in Product Information Management. Set up the category's hierarchy and assign the
items to the respective categories.
11.  Run the Refresh Product Hub Snapshots scheduled process after setting up the product catalog.
12. Use the Manage Pricing Parameters Functional Setup Manager task under the Pricing functional area to
specify the catalogs in the Product Catalogs pricing parameter.
13. Manage user statuses.
14. Manage customer claim types.
15. Manage customer claim reasons.
16. Manage the claim source for Deductions, Invoice Deductions and Manual Claims. Configure a default

settlement method based on your business required. For example Credit Memo - On Account for deductions,
invoice deductions or manual claims.

I Note: Use Check or Payable Default Payments only for manual claims.

17. Manage SLA setup tasks.

Schedule Processes You Must Run

You must schedule the following processes for customer channel management programs, as required:

Schedule the Loading of CSV Sales Orders and Invoices

Note: If you're setting up the customer lump sum program, then don't run this process.

Run the following processes, as required, for the program type you selected:
o Create Accruals for Co-op Programs - run this process for customer annual co-op programs

o Create Accruals for Volume Programs - run this process for customer annual volume programs

o Create Accruals for Channel Batch - run this process for customer promotion and customer volume
programs

Schedule the Accounting of Channel Accruals and Relief of Accruals to General Ledger

Sweep Channel Transaction Accounting EventsSchedule the Clean Up of Unprocessed Accounting Events for
Channel Transactions

Settle Customer Claims

Related Topics
« Roadmap for Setting Up Deductions and Settlement
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The following table summarizes the solution components of Supplier Rebate and Supplier Ship and Debit flows.

Flow

Supplier Ship and
Debit

Supplier Rebate

Supplier Annual
Rebate

Programs
Administration

Supplier Portal

Manage Supplier
Programs Ul

Supplier
Checkbook Ul

Supplier Portal

Manage Supplier
Programs Ul

Supplier
Checkbook Ul

Supplier Portal

Manage Supplier
Programs Ul

Supplier
Checkbook Ul

Inbound
Integrations

Oracle Order
Management

Oracle Inventory
Management
Cloud, Oracle
Procurement
Cloud, Oracle
Financials Cloud

Load Transactions
(scheduled
process)

Import
Management
for CSV Supplier
Invoices

Import
Management
for CSV Supplier
Invoices

Create Accruals

Create Accruals
(scheduled
process)

Create Accruals
for Channel
Batch (scheduled
process)

Create Accruals for
Volume Programs
(scheduled
process)

Adjustments

Manage Supplier
Ship and Debit
Adjustments Ul

Manage
Supplier Rebate
Adjustments Ul

Manage
Supplier Rebates
Adjustments Ul

Claims
Administration

Generate Supplier
Claims (scheduled
process)

Manage Supplier
Claims Ul

Generate Supplier
Claims (scheduled
process)

Manage Supplier
Claims Ul

Generate Supplier
Claims (scheduled
process)

Manage Supplier
Claims Ul

Outbound
Integrations

Synchronously
upon claim
approval

Oracle Financials
Cloud

Close Settled
Claims (scheduled
process)

Synchronously
upon claim
approval

Oracle Financials
Cloud

Close Settled
Claims (scheduled
process)

Synchronously
upon claim
approval

Oracle Financials
Cloud

Close Settled
Claims (scheduled
process)

Roadmap for Setting Up Buy Side: Supplier Rebates

The buy side channel flow receives and administers discounts from suppliers and manufacturers. End users of Channel
Revenue Management get separate Uls for buy side vs sell side channel flows.
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Use this roadmap as a check list to implement the buy side supplier rebate channel flow. Each of these setup steps is
explained in detail in the later sections of this guide.

Use the Functional Setup Manager to:

Opt in to Channel Revenue Management, and Supplier Channel Management
Manage the channel setting: Event for Triggering Supplier Rebate Accrual
Manage user statuses

Manage programs types

Manage adjustment types and reasons

Manage claim types

Manage claim reasons

Manage these claim sources and their settlement methods:

PNV AWNA

o Supplier Rebate - Claim
o Supplier Rebate - Debit Claim
9. Manage SLA setup tasks

Scheduled Processes You Must Run

You must schedule these processes for supplier rebates:

- Load Transactions - run this scheduled process if you use direct integration with receiving transactions. If you
don't use the direct integration with receiving transactions, then import supplier invoices using the CSV file
from Tools > Import Management.

Create Accruals for Channel Batch
« Subledger Accounting: Create Accounting
« Sweep Channel Transaction Accounting Events

Import Payables Invoices (Oracle Fusion Payables scheduled process). The Source parameter must be set to
Claims.

Generate Supplier Claims
Close Settled Claims

Related Topics
» Overview of Buy Side Scheduled Processes

- How Payables Standard Invoice Import Data Is Processed

Roadmap for Setting Up Buy Side: Supplier Annual
Rebates

The buy side channel flow receives and administers discounts from suppliers and manufacturers. End users of Channel
Revenue Management get separate Uls for buy side vs sell side channel flows.

Use this roadmap as a check list to implement the buy side supplier annual rebate channel flow. Each of these setup
steps is explained in detail in the later sections of this guide.
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Use the Functional Setup Manager to:

XNV ARWNA

10.

Opt in to Channel Revenue Management, and Supplier Channel Management
Manage the channel setting: Calendar for Accrual Calculation

Manage user statuses

Manage programs types

Manage adjustment types and reasons

Manage claim types

Manage claim reasons

Manage these claim sources and their settlement methods:

o Supplier Annual Program - Claim
o Supplier Annual Program - Debit Claim

Manage SLA setup tasks

To leverage supplier categories in program definition and reporting:
o Create a supplier catalog in PIM with no functional area.

o Create a supplier trade profile at supplier level and specify the supplier catalog.

Scheduled Processes You Must Run

You must schedule these processes for supplier annual rebates:

Create Accruals for Volume Programs

« Subledger Accounting: Create Accounting

« Sweep Channel Transaction Accounting Events

Import Payables Invoices (Oracle Fusion Payables scheduled process). The Source parameter must be set to
Claims.

Generate Supplier Claims

Close Settled Claims

Related Topics

« Overview of Buy Side Scheduled Processes
- How Payables Standard Invoice Import Data Is Processed

Roadmap for Setting Up Buy Side: Supplier Ship and
Debit

The buy side channel flow receives and administers discounts from suppliers and manufacturers. End users of Channel
Revenue Management get separate Uls for buy side vs sell side channel flows.

Use this roadmap as a check list to implement the buy side supplier ship and debit channel flow. Each of these setup
steps is explained in detail in the later sections of this guide.
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Use the Functional Setup Manager to:

Opt in to Channel Revenue Management, and Supplier Channel Management
Manage user statuses

Manage programs types

Manage adjustment types and reasons

Manage claim types

Manage claim reasons

Manage these claim sources and their settlement methods

NoUhAUWUNRA

o Supplier Ship and Debit - Claim
o Supplier Ship and Debit - Debit Claim

8. Manage SLA setup tasks
You must also perform the setups required for the integration with Oracle Fusion Pricing.

Scheduled Processes You Must Run

You must schedule these processes for supplier ship and debit:

Create Accruals
« Subledger Accounting: Create Accounting
- Sweep Channel Transaction Accounting Events

Import Payables Invoices (Oracle Fusion Payables scheduled process). The Source parameter must be set to
Claims.

Generate Supplier Claims

Close Settled Claims

Related Topics
« Overview of Buy Side Scheduled Processes

- How Payables Standard Invoice Import Data Is Processed

Starting an Implementation

Identify the channel revenue flows and the offering(s) your user communities will access flows from. This decision
determines how you should opt in. Unlike other Fusion apps, some channel flows can be accessed from the Order
Management or Procurement offering.

Opt In To Channel Revenue Management
Modify the Predefined Offering

Channel Revenue Management requires opt in. You must first enable it as a functional area under Order Management
or Procurement to access its setup tasks.
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Access from Order Management

From the Navigator, select Setup and Maintenance.

On the Setup: page, select Order Management from the drop-down list.

Click Change Feature Opt In.

On the Opt In: Order Management page, select the check box in the Enable column for the functional area:
Channel Revenue Management.

Click the Features icon.

In the Edit Features page, enable the following based on your business flow:

POUN

o un

o Deductions and Settlement

o Supplier Channel Management

o Customer Channel Management

o Manage Deduction Claims Using Redwood Pages

I Note: After 23D, this opt in is mandatory.
o Approve Customer Claims with BPM Workflow

Note: Opt into this feature only if you choose to use BPM workflow-based approvals to process and
route the approval to the designated approvers.

7. Click Done.
8. From the roadmap check list, finish each setup task as necessary, depending on your business requirements.

Access from Procurement

From the Navigator, select Setup and Maintenance.

On the Setup: page, select Procurement from the drop-down list.

Click Change Feature Opt In.

On the Opt In: Procurement page, select the check box in the Enable column for the functional area: Supplier
Incentives, which is under Purchasing.

Click the Features icon for Supplier Incentives.

In the Edit Features page, enable Supplier Channel Management.

Click Done.

From the roadmap check list, finish each setup task as necessary, depending on your business requirements.

POAUN

ONo WU

If you find that modifying the predefined offering doesn't meet your business requirements, then create a new
implementation.

Create a New Implementation Project

If the predefined offering doesn't meet your business requirements for some reason, then create a new implementation
project.

1. From the Navigator, select Setup and Maintenance.

2. On the Setup page, open the Tasks panel and select Manage Implementation Projects.

3. Onthe Implementation Projects page, click the Create icon, or select Create from the Actions drop-down list to
create a new project.

4. On the Create Implementation Project: Enter Basic Information page, modify the values as necessary, and then
click Next.
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5.

6.

On the Create Implementation Project: Select Offerings to Implement page, in the Name list:
o Order Management

Expand Order Management. Enable the Include option for Order Management and Channel Revenue
Management.
o Procurement

Expand Procurement > Purchasing. Enable the Include option for Procurement, Purchasing, and Supplier
Incentives.

Click Save and Open Project.

You can create one or more implementation projects for the offerings and options. Each Oracle application
creates the task list you must finish for each project you create. An Application Implementation Manager can
set up these task lists, and assign and track each task that these lists contain.

On the Implementation Project page, in the Task list, expand and perform the tasks that your business flow
requires.

Export Setup Data

This procedure shows you how to export setup data using offering or functional area. You need appropriate roles
assigned to export setup data.

1.

Click Navigator > My Enterprise > Setup and Maintenance.
In the Setup and Maintenance work area, select the offering you want to export from the Offering menu.
To export setup data:

o For an entire offering, select and open the Actions menu in the page header, and then select Export.

o For a specific functional area, select and open the Actions menu corresponding to the functional area,
and then select Export.
Select Create New to create a new export process.

Optionally, specify appropriate scope values to filter exported setup data. By default, all existing setup data

is exported for each business object processed during export. However, if scope is supported by any of those
business objects, you can select scope values to filter the exported setup data. To specify scope values for one
or more of the business objects:

a. Select the applicable business object from the Business Objects table and then click Add. If no related
business object supports scope, then the table remains empty.

b. Search and select the value you want to use as scope for the business object and click Apply.

c. Repeat the previous step to add more scope values if needed. Click Done when finished.
Click Submit to start the export process.
Monitor the status of the export process until it completes by selecting Export from the Actions menu. Up to
three most recent processes are listed, and are ordered from newest to oldest. Each process indicates its status
at the time, and if it was completed already, then the time stamp when it was processed.

While the process is still in progress, you may select the status to view how much progress the process has
made at the time. A message shows you how many business objects were already processed out of the total
number of objects to be processed. Click View Progress to review the details on the business objects that were
already processed. Click the Refresh button to get the most recent information. Refer to the topic Review of
Export and Import Process Results for detailed description of the process results.

When the export process completes, select the status link to go to the Export Offering Data Results page.

o If the process completes successfully, the status is set to Ready to download.
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i. Click Download File to download the configuration package .zip file and save it at an appropriate
location. Use this file to import setup data in the target environment.

ii. In addition, review the list of post export tasks. If any tasks are listed, then those tasks aren't
migrated by export and import process. You must migrate that data manually in the target
environment.

o On the other hand, if the process completes with errors, the status displays Ready for error review.

i. The Business Objects table shows all business objects that had errors during processing. Refer
to the topic Review of Export and Import Process Results for detailed description of the process
results.

ii. Click Download Log File from the page header, which includes the error log of all business
objects that experienced error. Alternatively, you can also click Actions > Download Log File
corresponding to a specific business object to download error log specific to that business object.

iii. After correcting the cause of the errors, create a new export process.

Note: You can export the Order Management or Procurement Offering or the Channel Revenue Management
Functional Area.

Import Setup Data

This procedure shows you how to import setup data using an offering or functional area. You need appropriate roles
assigned to import setup data.

1.
2.
3.

Click Navigator > My Enterprise > Setup and Maintenance.
In the Setup and Maintenance work area, select the offering you want to import from the Offering menu.
If the configuration package you want to import was created by exporting:

o An offering, select Import from the Actions menu in the page header.
o Afunctional area, select Import from the Actions menu corresponding to that functional area.

Select Create New to create a new import process.

Browse and select the configuration package file that contains the setup data you want to import. View the
Configuration Package Details to verify that you selected the correct file.

o If the offering or functional area selected during export doesn't match the offering or functional area you
chose for the import process, an error message appears. Click the Update button to browse and select
the correct file.

Expand the Import Options section.

o Best practice is to select the Compare setup data prior to import option. If you select this option, the
import process automatically runs a comparison of the setup data in the configuration package file with
that in the target environment before importing the setup data.

Note: Comparing setup data prior to import requires additional time. You may skip this step by not
selecting the Compare setup data prior to import option. However, if you skip this step, you can't
review how the setup data is similar or different in the source and target, and how the import process
changes setup data in the target environment.

o Optionally, select the Import feature selection option to import the opt-in configuration of the offering
or functional area you're importing. This imports the enabled dependent functional areas and features of
the offering or functional area.

54

ORACLE



SCM Cloud Chapter 2
Implementing Channel Revenue Management Implement

© N

10.

n.

12.

13.

14.
15.

16.
17.

18.

o The Pause process each time an error occurs option is selected by default. If an error occurs, the import
process pauses so that you can take corrective action and resume the import. If you don't want the
import process to be interrupted even if there are errors, deselect the option. However, note that if any
prerequisite data fails, additional dependent data might not be imported correctly.

o The Pause process each time manual import setup data is required option is selected by default. The
import process pauses each time there's some data that you must manually import. You can deselect this
option if the data to be imported manually already exists in your target environment.

Click Submit to start the import process.
If any setup data requires manual entry before the import can start, a warning message appears. This message
shows you the tasks you must perform before submitting the process.

o If you verified that the setup data for those tasks are already entered in the target environment, click
Submit.

o Otherwise, click Cancel. Create a new import process after you ensure that the setup data is entered in
the target environment.

Monitor the import process by clicking Actions > Import. Up to three most recent processes are listed and
ordered from newest to oldest. Each process indicates its status at the time and, if the process is completed, the
time stamp when it was processed.
While the process is in progress, you can select the status to view how much progress the process made at
the time. A message shows you how many business objects were already processed out of the total number
of the objects to be processed. Click View Progress to review the details of the business objects that finished
processing. Click the Refresh button to view the most recent information. Refer to the topic Review of Export
and Import Process Results for detailed information about the process results.
If you selected the Compare setup data prior to import option, once the comparison completes, the status
reads Waiting for comparison review. Select the status to go to the Import Offering Data Results page to
review the comparison results. Refer to the topic Compare Setup Data Using Offering or Functional Area for a
detailed description of the comparison results.
Click Continue to Import from the Import Offering Data Results page to start the import process if you're
satisfied with the comparison results.
Alternatively, if you didn't select the Compare setup data prior to import option, the import process starts
automatically.
Monitor the process as before, until it completes.
If any setup data requires manual data entry during import, the process pauses, and the status reads Waiting
for manual import.
a. Select the status to go to the Import Offering Data Results page and review the details.
b. Alist displays the business objects that require manual data entry before import.
c. For each of the listed business objects, click Go to task. This displays a list of related tasks. Select each
task to enter the required data.
d. After you enter the setup data for all the listed business objects, click Resume from the Import Offering
Data Results page to restart the import process.
e. Click Confirm in the confirmation message that appears to resume the import process.
Continue to monitor the process until it completes.
If the import process completes successfully:
a. Review the results to verify successful completion.
b. If any post import tasks are listed, ensure that their setup data is entered. Otherwise, the setup data
remains incomplete, and you experience errors when processing transactions.
If the import process completes with errors:
a. The Business Objects table displays all business objects which encountered errors while processing. Refer
to the topic Review of Export and Import Process Results for a detailed description of the process results.
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b. Click the Download Log File from the page header level. This includes the error log of all business
objects that encountered errors. Alternatively, click Actions > Download Log File corresponding to a
specific business object to download the error log specific to that business object.

c. Create a new import process after correcting the errors.

Export Setup Data to a CSV File

To export setup data to a CSV file, follow these steps:

1. Click Navigator > My Enterprise > Setup and Maintenance.

2. Inthe Setup and Maintenance work area, select the offering whose task requires setup data entry using CSV
file.

3. Identify the setup data as appropriate:

o For all tasks associated with the offering, click Actions > Export to CSV File.

o For all tasks associated with a functional area, select the functional area and click Actions > Export to
CSV File.

o For specific tasks:

i. Select the appropriate functional area and go to the Tasks table.
ii. Select Columns > View > Actions to make the applicable task actions visible.
iii. Select the task, and from the corresponding Actions menu, select Export to CSV File.

Note: The Export to CSV file option is disabled if the task doesn't support export.
4. Select Create New. You can export all existing setup data represented by the task.

o If Scope is supported for any of the selected setup tasks, you can select appropriate scope values to filter
the setup data you want to export.

o You can also download the template for managing setup data without exporting the existing setup data
in the environment. To do so, select the Export only template files check box.

Click Submit to start the export process.

Select Export to CSV file for the offering, or functional area, or task as appropriate, to see the latest process.
Monitor the process at any level until it completes.

7. Select the process after it's complete and review the results. Verify that the process completed without any error
before you download the CSV file package.

o w

If there are more than one business objects associated with the task, you may find more than one CSV files.

Modify Setup Data in a CSV File

To enter or modify setup data before importing it into the target environment, you must edit the CSV file. While editing,
ensure that you maintain the exact format for dates, numbers, and any other value that's present in the original
exported CSV file.

CAUTION: Never delete any CSV file from the downloaded CSV package. Deleting a CSV file will cause errors during
import. If you don't want to include setup data from a particular CSV file, remove all records (rows) from the CSV file
except the heading row. Even if that CSV file is empty, you must include it in the CSV package to be imported.
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If your file contains setup data with Date attributes, you must specify the correct date format that appears in the
exported setup data file.

1.

4.

5.

Open the original exported file using a CSV editor such as WordPad and review the date format attribute (for
example, 2015/10/25).

Open the CSV file using Microsoft Excel.

Select the Date attribute and click Format Cells. Change the Category to Custom and provide the same format
that appeared in the original file. In the same way, provide the format for all date columns.

Note: Depending on the setup data, you must use the custom format to match the correct data format in
columns as suggested in the following table.

Columns Data in CSV Custom Format Cells

Date 2018/03/02 yyyy/mm/dd

Date and Time 2018/02/28 12:07:48:48 yyyy/mm/dd hh:mm:ss.SSS
Long Number 123456789123 Custom > 0

Modify the remaining setup data as per your requirement.

Tip: If you require further information to understand how to fill up the CSV file, refer to the Help associated
with the task.

Save the file in CSV format and immediately close it to prevent any other change. Ensure that the CSV file size
doesn't exceed 10MB. The CSV file is ready for import.

If your file contains setup data with special characters for other languages such as Chinese, you might need to specify
Text as the column format to represent such information.

OO U A UWNRA

10.
n.

Open Microsoft Excel and click the Data tab.

In the Get External Data group, click From Text.

Navigate to and select the CSV file you downloaded. .

Select Delimited as Data Type and click Next.

Select Comma as delimiter and click Next.

Select Text as column data format for all columns and click Finish. You can now edit the file.
Save the file as file type Unicode Text (.txt) and close it.

Open the file again using Notepad++:

a. Find and replace all tab characters with commas.
b. Change the encoding to Encode in UTF-8.
Save and close the file.
Change the file extension from .txt to .csv.
Save the CSV into a .zip file. Ensure that the CSV file size doesn't exceed 10MB. You can now import the file.
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Import Setup Data from a CSV File

To upload the new or modified setup data, follow these steps:

1. Select Import from CSV file from the Actions menu of an offering, a functional area, or a task as appropriate.

2. Select Create New.

3. Select the appropriate .zip file. The application validates that the file corresponds to the selected offering,

functional area, or task before you can submit the process.

Click Submit.

Select Import from CSV file to see the latest processes. Monitor the process until it completes.

6. Select the process once it completes to review the results. If any error occurs, review the details listed in Status
Details in the Business Objects section. Fix the issues and import again, if necessary.

7. After you import the setup data successfully, you can verify the loaded data by selecting the task from the
Setup page.

v A

Related Topics
- Starting Decision Points

Time Zones in Channel Revenue Management

Here you will understand how to configure time zones in Channel Revenue Management.
The channel application takes into consideration these time zones:

- Server time zone: The time zone configured on the application server. In the case of cloud servers, this time
zone is set as Coordinated Universal Time (UTC).

Legal entity time zone: The time zone in which the business unit's legal entity exists. This is defined as part of
the legal address linked to the legal entity. If you want the transactions to be accounted for in this time zone,
you must select the legal entity time zone check box in the legal entity definition.

All dates in Channel Revenue Management use the legal entity time zone for the business unit. If the legal entity time
zone is not set, then the application uses the UTC (Coordinated Universal Time).

Important Considerations

Before commencing enablement for the legal entity time zone feature, there are implementation considerations that
need to be taken into account. Consider if your server time zone is different than your legal entity time zone.

Note: Existing dates in channel programs, claims, adjustments and transactions will remain unchanged after the
upgrade. The dates in existing programs, claims, adjustments and transactions will be treated as being in the legal
entity time zone. Hence, a supplier claim may have older accruals with accrual date in the server time zone and newer
accruals in the legal entity time zone.

For Deductions and Settlement:

Existing dates stamped in server time zone by Channel in existing claims and set ups will be treated as in the
legal entity time zone.

New claims and their processing are treated in the legal entity time zone.

58
ORACLE



SCM Cloud Chapter 2
Implementing Channel Revenue Management Implement

For Supplier Channel Management:

Existing dates stamped in server time zone by Channel in existing programs, accruals, adjustments and claims
will be treated as in the legal entity time zone.

New inbound transactions and new processing are treated in the legal entity time zone, including CSV uploads.
So consider the business processes around the preparation of inbound transactions, as imported dates will be
treated in the legal entity time zone.

- There are 2 exceptions for purchase order related dates:

o Requested Delivery Date and Requested Ship Date are displayed in Channel, as they were entered in the
PO. Purchase Order does not capture a time zone for these dates. Channel will process these dates as is
without any conversions.

o The processing of the dates within the eligibility service REST will be in the legal entity time zone.
However, all dates returned by the eligibility service REST are in Coordinated Universal Time (UTC).

Set Up Legal Entity Time Zones

To enable legal entity time zone, perform the following steps.

1. With roles having the required access, Opt-in to the Use the Legal Entity Time Zone in Channel Revenue
Management feature.

Note: Currently, this opt-in feature is a temporary opt-in. The opt-in will become mandatory from Release
22D.

2. With roles having the required access, navigate to the Setup and Maintenance work area. Click Tasks and
search for the Manage Administrator Profile Values task. In the Profile Option Code field, query for the
option XLE_ENABLE_LEGAL_ENTITY_TIMEZONE with Enable Legal Entity Time Zone as the Profile Option
Display Name.

3. Inthe Profile Values record, add a new row, and enter the following information:

o Profile Level - Set the profile level to Site. Don't use any other level because it would result in
inconsistent data in Channel Revenue Management.

o Profile Value - Set the profile value to Yes to enable the legal entity time zone in Channel Revenue
Management.

Note: It is recommended that you don't update the profile option once you have set it to Yes.

4. With roles having the required access, navigate to the Setup and Maintenance work area:
o Offering: Order Management
o Functional Area: Legal Structures
o Task: Manage Legal Entity
5. Onthe Scope dialog box, select Search Legal Entities, and click Apply and Go to Task.
6. Onthe Manage Legal Entities page, search for and select the legal entity you require, and select Edit from the
Actions menu.
7. Inthe Legal Entity Addresses section on the Edit Legal Entity page, select the Primary address. Select Edit
address from the Actions menu, and in the Edit Address dialog, select the Time Zone for the primary legal
entity.

Channel Revenue Time Zones

This table describes how Channel handles and processes various dates in the application.
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How Channel Uses Dates From

Programs, Accruals, Claims, and Adjustments Yes
User Interface

REST (except eligibility) Yes

ESS Scheduled Processes Yes

Create Accruals Scheduled Process

Create Accruals for Channel Batch
Scheduled Process

Create Accruals for Volume Programs
Scheduled Process

Generate Supplier Claims Scheduled
Process

Settle Supplier Claims Scheduled Process

Mass Settle Scheduled Process

WHO Columns No
Descriptive Flexfield Attributes No
FSM UI No
All dates in CSVs Yes
Order Management: Yes

.

Ordered Date
Requested Ship Date

Procurement Yes

.

Purchase Order Date
Requested Delivery Date
Requested Ship Date

Inventory Management Yes

.

Receipt Transaction Date

ORACLE

Displayed and Processed as LETZ

Chapter 2
Implement

Additional Information

All user enterable dates are in the legal entity
time zone. By default, the current date with
time is converted to the legal entity time zone.

All dates passed to the REST are assumed to be
in the LE time zone. By default, the current date
with time is converted to the legal entity time
zone. All functional dates returned by REST
should be in LE time zone. WHO column dates
should be in the server time zone.

By default, the current date with time is
converted to the legal entity time zone.

WHO column dates always use the server time
zone.

No conversion is applicable to date and
datetime attributes.

For FSM Ul using the Reference Set, the start
and end dates must be in reference to the
respective transaction using it. WHO columns
continue to use the server time zone. There is
no impact on the following items:

1. User Statuses
Program Types
Adjustment Types
Claim Types
Claim Reasons
Claim Sources

o v s uwN

The Ordered Date and the Requested Ship Date
are datetime attributes and they are in UTC.
Channel converts these dates to the legal entity
time zone and passes this information to the
eligibility service.

The Purchase Order Date, the Requested
Delivery Date, and the Requested Ship Date

are datetime attributes and they are in UTC.
Channel converts these dates to the legal entity
time zone and passes this information to the
eligibility service.

The Receipt Transaction Date and the Shipped
Date are datetime attributes and they are in
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- Shipped Date UTC. Channel converts these dates to the legal

entity time zone and passes this information to
the eligibility service.

How to Enable Smart Search

This feature uses Oracle Search Extension Framework to provide a powerful index-based search engine combined with
Oracle's next user experience so you can quickly and easily perform full-text searches for programs or claims across
dozens of attributes.

1. Run the scheduled process ESS job to create index definition and perform initial ingest to OSCS to create
index definition and perform initial ingest to Oracle Search with the following parameter values:

Parameter Name Parameter Value Description
Index Name to Create fa-cjm-customer-programs This parameter enables
and Ingest you to register the

customer program
index and load initial
index data, if any, to the
Oracle Search server.
To do this, you must
also have the Manage
Customer Programs

privilege.
Index Name to Create fa-fscm-customerclaim This parameter enables
and Ingest you to register customer

claim index and load
intial data for customer
claims, if any, to the
Oracle Search server.
To do this, you must
also have the Manage
Customer Claims
privilege.

This creates index definitions and adds data to the Oracle search server. The time taken to run the batch process
depends on the amount of data.

Note: If you resubmit the ESS job to create index definition and perform initial ingest to OSCS process after the
index is already created, then the process clears the index and reingests the entire data again.

For additional details on implementing Oracle Search Extension Framework, see the section entitled Search Extension
Framework in the Search chapter of the guide Implementing Applications.

1. Ensure you have the following Supply Chain Application Administrator predefined job role to run the ESS job to
create index definition and perform initial ingest to OSCS to create and update the index:
2. Ensure that you have the appropriate privileges to view or manage programs:
o Manage Customer Programs

o View Customer Programs
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3. Ensure that you have the appropriate privileges to view or manage claims:
o Manage Customer Claims

o View Customer Claims

4. If you have one of the following predefined duty roles, you have the required privileges to search and view
programs in the Programs page:

o Customer Channel Program Management
o Customer Channel Program Viewing

5. If you have one of the following predefined duty roles, you have the required privileges to search and view
programs in the Claims page:

o Channel Claims Management

o Channel Claims Viewing

Related Topics
» Elements of a Customer Promotion Program

« Elements of a Customer Claim

Security Tasks

Here are some of the security tasks that are required for Channel Revenue Management.

- Create Implementation Users
Manage HCM User Accounts
Manage Data Security Policies
Manage Duties
Manage User Principal
Provision Roles to Implementation Users

Owners in Channel Programs, Claims and Adjustments must be set up as HCM workers.

Run the Validate Channel Owner Data scheduled process to report on owners who are not HCM workers. This report
display owners of programs, claims or adjustments who aren't set up as HCM workers. Select a value from the Owner

User Name list to run this process for a specific username. Alternatively, leave this field blank to run the process for all
usernames.

For more information, see Getting Started with Oracle Fusion Applications: Common Implementation (1387777.1) on My
Oracle Support at https://support.oracle.com.

You can do these tasks using the Security Console as a super user:

Manage Job Roles

Manage Role Templates

62
ORACLE


https://www.oracle.com/pls/topic/lookup?ctx=fa24c&id=u30240750
https://www.oracle.com/pls/topic/lookup?ctx=fa24c&id=u30240758

SCM Cloud Chapter 2
Implementing Channel Revenue Management Implement

Related Topics
- Manage HCM User Accounts

« Create User Accounts for Implementation Users
« Create Application Users
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Chapter 3
Integrate

Integrating Channel Revenue Management with Other

Oracle Cloud Applications

Channel Revenue Management is integrated with the following Oracle applications depending on the channel flow.

For Deductions and Settlement
o Oracle Fusion Receivables

For Sell Side - Customer Annual Co-op Programs
o Tools > Import Management for CSV file import

o Oracle Fusion Subledger Account

o Oracle Fusion Receivables

For Sell Side - Customer Annual Volume Programs
o Tools > Import Management for CSV file import

o Oracle Fusion Subledger Account

o Oracle Fusion Receivables

For Sell Side - Customer Promotion Programs

o Tools > Import Management for CSV file import
o Oracle Fusion Pricing for program eligibility

o Oracle Fusion Subledger Account
o Oracle Fusion Receivables

For Sell Side - Customer Volume Programs

o Tools > Import Management for CSV file import

o Oracle Fusion Subledger Account
o Oracle Fusion Receivables

For Sell Side - Customer Lump Sum Programs

o Tools > Import Management for CSV file import

o Oracle Fusion Subledger Account
o Oracle Fusion Receivables

For Buy Side - Supplier Rebate

o Oracle Fusion Receiving, Purchasing, and Payables for direct integration to inbound receiving

transactions

o Tools > Import Management for CSV file import

o Oracle Fusion Subledger Accounting
o Oracle Fusion Payables

ORACLE
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For Buy Side - Supplier Annual Program
o Tools > Import Management for CSV file import

o Oracle Fusion Subledger Accounting
o Oracle Fusion Payables
For Buy Side - Supplier Ship and Debit
o Oracle Fusion Pricing
o Oracle Fusion Order Management for direct integration to inbound sales orders
o Oracle Fusion Subledger Accounting
o Oracle Fusion Payables

Oracle Fusion Receivables Integration

Integration with Receivables lets you create and settle claims against receipts for deductions or overpayments. You must
enable Channel Revenue Management in your Receivables application for this.

How to Enable the Integration

1. With roles having the required access, navigate to the Setup and Maintenance work area.
o Offering: Financials
o Functional Area: Receivables
o Task: Manage Receivables System Options

Search for and select your business unit.

Click the Cash Processing tab.

Select the Enable channel revenue management integration check box.
Click Save.

vhWN

Standardize Claim Reasons

Some customers may have their own set of reason codes for raising a dispute or short paying you. You can standardize
your customer claim reasons by translating the reason for the dispute provided by your customers to a standard

set of reason codes. You can create a mapping between your claim reasons and those provided by your customers,
which can be used to automatically categorize the reason for the claim. This mapping can be created in the Manage
Customer Trade Profiles page. This streamlines the initial classification of claims for immediate visibility into queues

of work. This translation is supported in Lockbox, in the Receivables integration, in the Manual Claim Ul, and in the
channelCustomerClaims REST service.

Manage Transaction Types

The accounting for settlement is handled by Receivables, driven through the Channel mappings to Receivables
transactions and activities. For credit memos and invoices, Receivables performs the subledger accounting based on the
Receivables transactions and activities created by Channel Revenue Management settlement.

- Claim Type setup for a deduction includes a one to one mapping to a Receivables credit memo transaction type.

- Claim Type setup for an overpayment includes a one to one mapping to a Receivables invoice transaction type.
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- Claim Reason setup for a deduction includes a one to one mapping to a Receivables credit memo reason.

You can manage transaction types here:

- Offering: Financials
Functional Area: Customer Billing
- Task: Manage Transaction Types

I Note: You must set up the subledger accounting for any new Receivables transaction types.

Manage Transaction Sources

Configure the predefined transaction source, Channel Revenue Management, which is available as the transaction
source for the receivables credit memo or invoices created during settlement of a claim.

- Offering: Financials
Functional Area: Customer Billing
- Task: Manage Transaction Sources

Manage Receivables Activities

The accounting for claim investigation is derived from the receivables activity associated with the claim investigation
application. Configure the predefined receivables activity for the activity type Channel Claim Investigation available
under Manage Receivables Activities. Add the Activity GL Account for your business unit.

- Offering: Financials
Functional Area: Receivables
- Task: Manage Receivables Activities

Date Population in Receivables upon Settlement
Receipt Application Date

o Will be the same as Override Transaction Date if it's a future date and after the Receipt Date.

o Else, if Override Transaction Date isn't set, and Claim Accounting Date is a future date and after the
Receipt Date, then Receipt Application Date will be the Claim Accounting Date.
o Else, if the Receipt Date is in the future, then Receipt Application Date will be the Receipt Date.

o Else it will be the System Date (settlement system date).

For example, System Date = May 28
o Override Transaction Date = 5th June, Receipt Date = 4th June

Then Receipt Application Date = 5th June
o Override Transaction Date = 3rd June, Receipt Date = 6th June

Then Receipt Application Date = 6th June
o OQOverride Transaction Date =1st May, Receipt Date = 2nd May
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o Will be the same as Claim Accounting Date, if it's a future date and after the Receipt Accounting Date.

o Else, if the Receipt Accounting Date is in the future, then Receipt Application Accounting Date will be the

Receipt Accounting Date.
o Else it will be the System Date (settlement system date).

For example, System Date = May 28

o Claim Accounting Date = 5th June, Receipt Accounting Date = 4th June

Then Receipt Application Accounting Date = 5th June
o Claim Accounting Date = 3rd June, Receipt Accounting Date = 6th June

Then Receipt Application Accounting Date = 6th June
o Claim Accounting Date =1st May, Receipt Accounting Date = 2nd May

Then Receipt Application Accounting Date = 28th May

Note: In the Settle Customer Claims scheduled process, the Receivables integration for settlement synchronously
calls the Receivables API and not the asynchronous Auto Invoice interface. The log file for the scheduled process
documents the claims processed in Receivables.

Privileges for Quick Links to Receivables Transactions

You must assign these privileges to users to enable them to view the Receivables transactions directly from Channel

Revenue Management.

This table contains the privileges required for a user to view the Receivables transactions directly from Channel Revenue

Management.

Privilege Usage

View Receivables Activities = DATA
Data

View Receivables Credit Function
Memo

View Receivables Invoice Function
View Receivables Receipt Function

ORACLE

Code

AR_VIEW_RECEIVABLES_
ACTIVITIES_DATA

AR_VIEW_RECEIVABLES_
CREDIT_MEMO

AR_VIEW_RECEIVABLES_
INVOICE

AR_VIEW_RECEIVABLES_
RECEIPT

Description

View Receivables activities
data.

View a Receivables receipt.

View a Receivables invoice.

View a Receivables credit
memo.

Assigned to Duty Role

Channel Claims Manager

Channel Claims
Management Duty

Channel Claims
Management Duty

Channel Claims
Management Duty
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Related Topics
» Requirements for Completing a Receivables Transaction

» How canl arrange the creation of transaction types?

- Receivables Activity Types

« Predefined Receivables Data in Subledger Accounting
« Receivables Accrual Accounting Entries

Oracle Fusion Receiving, Purchasing, and Payables for
Direct Integration to Inbound Receiving Transactions

To claim rebates from suppliers, Channel Revenue Management directly integrates with Oracle Receiving to get the
receipt of goods. When Receiving receives goods, the Load Transactions process can be used to extract these receiving
transactions and related PO details into channel batches.

For supplier rebates, supplier invoices from Payables can be used to trigger the accruals for received shipments. The
Load Transactions process extracts receiving transactions into channel batches. The Create Accruals for Channel
Batch process creates potential accruals in the open status for receipts in the batch without supplier invoices. Earned
accruals are recognized for receipts in the batch with invoices.

Note: Drop Ship purchase orders, Consignment orders, and Inclusive Tax on Purchase Order aren't in scope for the
Procurement integration.

Note: Invoice cancellations, Payables Invoice Corrections - Quantity, Payables Invoice Corrections - Amount, and
Payables Invoice Corrections - Price aren't in scope for the Payables integration.

Supplier Portal Integration

The Fusion Supplier Portal enables a buying company (wholesaler/distributor) to negotiate and communicate channel
agreements with their suppliers.

As a supplier contact on the Supplier Portal, you can create, submit, and view your channel programs and interact with
your sales channel partner. It leverages the Portal’s existing security model, allowing supplier contact access to supplier
programs based on their data access at supplier and supplier site levels. This integration helps you to:

Invite suppliers to securely create and offer programs directly from the Supplier Portal.
- Centralize the definition of supplier incentives.
Reduce and share administrative load of managing programs.

Suppliers create their program in a draft status, which is then reviewed and approved by the supplier channel manager
prior to program activation. For wholesalers and distributors this self service capability reduces and shares the
administrative load of manage programs with their suppliers.
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Actions Required for Manage Supplier Programs

The Managing supplier programs through the supplier portal is delivered disabled. The following actions must be taken
to use this feature.

- The enablement for the supplier portal integration requires the enablement of Supplier Channel Management,
which involves the following opt ins:
a. Optin to the Supplier Incentives functional area under the Procurement offering.
b. Then opt in to the Supplier Channel Management feature.

After you opt in, perform the following tasks:

Provision access to Supplier Portal for the supplier and their contacts.

Configure applicable Program Types.

Specify the Default Program Owner in the Supplier Trade Profile.

Configure supplier items using the Trading Partner ltem page in the Product Information Management work
area.

PWONa

Access for Manage Supplier Programs

- Access to this feature is through the shipped job role Supplier Sales Representative.

- Access to this feature is through shipped privileges:
o Manage Supplier Programs in Supplier Portal

o View Supplier Programs in Supplier Portal
- The Manage Channel Programs (from Supplier Portal) business processes is affected by this feature.

You can additionally capture notes in a claim and capture attachments in a claim. This capability helps to justify the
resolution taken during approval and audit.

Notes and attachments for supplier claims are delivered disabled. Actions must be taken to use this feature.

- Access to this feature is through the Supplier Channel Manager job role.
- Access to this feature is through any role with the Manage Supplier Claims privilege.

- The Manage Channel Programs business processes is affected by this feature.

Oracle Fusion Payables Integration for Settlement

Supplier claims are paid through the Payables cloud. The two settlements methods for Channel Revenue Management
for payment of these supplier claims are AP Debit and AP Default Payment.

This table shows details of the Payables integration for supplier claim settlement.

Settlement Method AP Debit AP Default Payment

Claim Class DEBIT CLAIM CLAIM
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Settlement Method

Usage

Payment Method

Settlement Document Type

Claim Closure

AP Debit

When a supplier claim is positive, this amount
is collected from the supplier through a debit
memo with a negative amount. This is typical of
a promotional supplier claim. The debit memo
is applied to a payment instrument like a check.
The check may be for a payment to a supplier (a
positive amount).

Supplier Claim - positive amounts
Debit Memo - negative amounts
Instrument - positive amounts

Instrument (refund) - negative amounts

Transaction (applied to check, EFT)

Immediately available to be closed after
Settlement Pending status, as a debit memo
may be applied to any outstanding balance.

Chapter 3
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AP Default Payment

When a supplier claim is negative, this amount
is paid to the supplier through a check or EFT
and is common when a supplier rejects a claim
accrual and you want to issue a refund check
immediately to the supplier. A payables invoice
is created and a payment instrument is issued.
There may be multiple checks if the original
check is canceled and reissued.

Supplier Claim - negative amounts
Invoice - positive amounts

Instrument - positive amounts

Instrument (settled by check, EFT)

After Invoice is fully paid.

Oracle Fusion Subledger Accounting Integration

Oracle Fusion Subledger Accounting for Sell Side Integration

Subledger Accounting integration enables you to define and configure accounting rules and generate detailed
accounting for business transactions in Channel Revenue Management.

Predefined Subledger Accounting Setup

Channel Revenue Management has been registered as a subledger application. The setup tasks are available in the
Channel Revenue Management functional area to help you set up your subledger. It enables corporations to comply
with corporate, local and managerial accounting and audit requirements via increased control, visibility and efficiency.

Journal Source and Categories

Journal entries created for transactions from Channel Revenue Management are assigned the following journal source
and categories. Channel Revenue Management assigns default journal categories to each event class. You can configure
the assignment in the Subledger Accounting Options task.

This table gives the journal sources and journal categories for Channel Revenue Management.

Field

Journal Sources

ORACLE

Values

Channel Revenue

7



SCM Cloud

Implementing Channel Revenue Management

Field Values

Journal Category Channel Accrual

Channel Claim

Channel Revenue Management Sell Side Event Classes

Chapter 3
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An accounting event is a business event in Channel Revenue Management that has an accounting impact. Subledger
Accounting categorizes accounting events as event types. Event types are grouped into event classes. The Channel
Revenue Management accounting event model is predefined for you, and includes each event class and its life cycle.
This accounting event model forms the basis for creating subledger accounting. An event class enables Subledger

Accounting to handle the accounting for similar business events in a consistent manner.

For the sell side flows, the Subledger Accounting integration is centered on deriving accounting rules for two

accounting event classes:

Event Class Event Types

Customer Accrual .

Customer Claim Settlement .
Customer Claim Settlement by Extensible .
Payables

Customer Claim Settlement by Extensible .
Receivables

Customer Accrual Adjustment

Customer Accrual Creation

Customer Claim Settlement Reversal
Claim Settlement by Payables Default
Claim Settlement by Check

Claim Settlement by Credit Memo

Payables Extensible Settlement Reversal

Claim Settlement by Extensible Payables

Receivables Extensible Settlement Reversal

Claim Settlement by Extensible Receivables

I Note: If a claim or deduction is nonpromotional it isn’'t interfaced to Subledger Accounting or General Ledger.

Customer Accrual Event

For all accruals that are created, an accrual event triggers its accounting to General Ledger. Accounting events are raised
with the respective event types for all accruals created in Channel Revenue Management. Customer accrual events:

- Debit Sales or Expense Account

- Credit Accrual Liability Account

For example:

ORACLE

72



SCM Cloud Chapter 3

Implementing Channel Revenue Management Integrate
Debit or Credit Account Amount
Dr. Sales or Expense USD 100
Cr. Accrual Liability USD 100

Predefined Accounting Rules for Customer Accruals

The following subledger accounting rules are used to generate accounting for customer accruals if predefined journal
entry rule set is in use. The accounts to debit and credit are defined in the Subledger Accounting mapping sets.

Event Class Name Journal Entry Rule Journal Line Rule Side Account Rule Mapping Set
Set
Customer Accrual Customer Accrual Rule  Sales or Expense Debit Sales or Expense Sales or Expense
Account Account
Customer Accrual Customer Accrual Rule  Accrual Liability Credit Accrual Liability Accrual Liability
Account Account

Customer Claim Settlement Event

When a claim or deduction is associated with promotional accruals or earnings, and the claim is being settled by credit
memo, another accounting event is triggered. Channel Revenue Management passes the Receivables Clearing Account
to Receivables and creates the following customer claim settlement entries:

- Debit Claim Accrual Liability Account
- Credit Receivables Clearing Account

For example:
Debit or Credit Account Amount
Dr. Claim Accrual Liability Account USD 100
Cr. Receivables Clearing Account USD 100

When a claim is associated with promotional accruals or earnings, and the claim is being settled by Payables Default
Payment or check, then another accounting event is triggered. Channel Revenue Management passes the Payables
Clearing Account to Payables and creates the following customer claim settlement entries:

- Debit Claim Accrual Liability Account
- Credit Payables Clearing Account

Debit or Credit Account Amount
Dr. Claim Accrual Liability Account USD 100
Cr. Payables Clearing Account USD 100
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Predefined Accounting Rules for Customer Claim Settlements

The following subledger accounting rules are used to generate accounting for customer claim settlements if predefined
journal entry rule set is in use. The accounts to debit and credit are defined in the Subledger Accounting mapping sets.

Event Class Name Journal Entry Rule Journal Line Rule Side Account Rule Mapping Set

Set
Customer Claim Customer Claim Claim Accrual Liability = Debit Claim Accrual Liability = Claim Accrual Liability
Settlement Settlement Rule Account Account
Customer Claim Customer Claim Receivables Clearing Credit Receivables Clearing Receivables Clearing
Settlement Settlement Rule for Credit Memo Account Account

Customer Claim

Customer Claim Customer Claim Payables Clearing for = Credit Payables Clearing Payables Clearing
Settlement Settlement Rule Check and AP Default Account for Customer = Account for Customer
Customer Claim Claim Claim
Customer Claim Customer Claim Exchange Gain or Loss Credit Exchange Gain or Loss - Exchange Gain
Settlement Settlement Rule for Customer Claim Account for Customer Account for
Claim customer claim

Exchange Loss
Account for
customer claim

Customer Claim Settlement by Extensible Payables Event
When a manual promotional claim is settled with Payables related custom settlement method, then an accounting event
is triggered. Channel Revenue Management passes the Payables Clearing Account for Customer Claim to Payables and
creates the following customer claim settlement entries:

- Debit Claim Accrual Liability Account

- Credit Payables Clearing Account for Customer Claim Account

Debit or Credit Account Amount
Dr. Claim Accrual Liability USD 100
Cr. Payables Clearing Account for Customer Claim = USD 100

Predefined Accounting Rules for Customer Claim Settlement by Extensible Payables

The following subledger accounting rules are used to generate accounting for customer claim settlements by extensible
Payables if predefined journal entry rule set is in use. The accounts to debit and credit are defined in the Subledger
Accounting mapping sets.
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Event Class Name

Customer Claim
Settlement by
Extensible Payables

Customer Claim
Settlement by
Extensible Payables

Customer Claim
Settlement by
Extensible Payables

Journal Entry Rule
Set

Payables Extensible
Settlement Rule

Payables Extensible
Settlement Rule

Payables Extensible
Settlement Rule

Journal Line Rule Side

Claim Accrual Liability = Debit
for Payables Extensible
Settlement

Payables Clearing for = Credit
Extensible Customer
Claim

Exchange Gain or Loss Credit
for Payables Extensible
Customer Claim

Account Rule

Claim Accrual Liability
Account

Payables Clearing
Account for Customer
Claim

Exchange Gain or Loss
Account for Customer
Claim

Customer Claim Settlement by Extensible Receivables Event

When a manual promotional claim or deduction is settled with a Receivables related custom settlement method,
then an accounting events is triggered. Channel Revenue Management passes the Receivables Clearing Account to

Receivables and creates the following customer claim settlement entries:

- Debit Claim Accrual Liability Account

- Credit Receivables Clearing Account

Debit or Credit

Dr.

Cr.

Account

Claim Accrual Liability Account

Receivables Clearing Account

Amount

usD 100

UsD 100
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Mapping Set

Claim Accrual Liability
Account

Payables Clearing
Account for Customer
Claim

- Exchange Gain
Account for
customer claim

- Exchange Loss
Account for
customer claim

Predefined Accounting Rules for Customer Claim Settlement by Extensible

Receivables

The following subledger accounting rules are used to generate accounting for customer claim settlements by extensible
Receivables if predefined journal entry rule set is in use. The accounts to debit and credit are defined in the Subledger
Accounting mapping sets.

Event Class Name

Customer Claim
Settlement by
Extensible Receivables

Customer Claim

Settlement by
Extensible Receivables

ORACLE

Journal Entry Rule
Set

Receivables Extensible
Settlement Rule

Receivables Extensible
Settlement Rule

Journal Line Rule Side

Claim Accrual Liability = Debit
for Receivables
Extensible Settlement

Receivables Clearing Credit
for Extensible
Customer Claim

Account Rule

Claim Accrual Liability
Account

Receivables Clearing
Account

Mapping Set

Claim Accrual Liability
Account

Receivables Clearing
Account
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Event Class Name Journal Entry Rule Journal Line Rule Side Account Rule Mapping Set

Set

Customer Claim Credit
Settlement by

Extensible Receivables

Receivables Extensible Exchange Gain or

Settlement Rule Loss for Receivables
Extensible Customer
Claim

Exchange Gain or Loss .
Account for Customer
Claim

Exchange Gain
Account for
customer claim

- Exchange Loss
Account for
customer claim

Reversal Event Type for Customer Claim Settlements

If Claim is reopened from Settlement Pending status because of any issues, Settle Customer Claims scheduled process
verifies that the event was processed successfully or not.
- If the first event was processed successfully, then the application creates a reversal event.

- If the first event isn't processed, then the application deletes the existing event.

Manage Mapping Sets for Channel Revenue Management Sell Side

The following predefined mapping sets are available for Channel Revenue Management Sell Side. These map the
predefined input sources with the Chart of Accounts for your ledger.

Mapping Set

Accrual Liability Account

Claim Accrual Liability Account

Exchange Gain Account for
customer claim

Exchange Loss Account for
customer claim

Receivables Clearing Account
Payables Clearing Account for

Customer Claim

Sales or Expense Account

ORACLE

Usage

Mapping set for the accrual liability
account.

Mapping set for the claim accrual
liability account.

Mapping set for the exchange gain
account for customer claim.

Mapping set for the exchange loss
account for customer claim.

Mapping set for the receivables

clearing account.

Mapping set for the customer
claims payables clearing account.

Mapping set for the sales or
expense account.

Output Type

Account combination

Account combination

Account combination

Account combination

Account combination

Account combination

Account combination

Input Sources
Customer Accrual Business
Unit

Customer Adjustment Type

Customer Claim Business Unit

Customer Claim Type

Customer Claim Business Unit

Customer Claim Business Unit

Customer Claim Business Unit

Customer Claim Type

Customer Claim Business Unit
Customer Claim Type
Customer Accrual Business
Unit

Customer Adjustment Type
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Assign Accounts to Predefined Mapping Sets

You must associate at least one output value for your ledger's chart of accounts for each of the above mapping sets if
you're using the predefined journal entry rule sets.

1. With roles having the required access, navigate to the Setup and Maintenance work area.
o Offering: Order Management/Procurement

o Functional Area: Channel Revenue Management/Supplier Incentives
o Task: Manage Mapping Sets

2. The Manage Mapping Sets: Channel Revenue Management page opens, where you can see the mapping sets
for your subledger. Select a mapping set to edit it.

3. Inthe Chart of Accounts section of the Edit Mapping Set, click the Add Row icon. Select the chart of accounts
from the drop-down list.

4. Inthe Mappings section, add the Input source to Output type mappings for your account. If applicable, select
the Default button to identify a default account to be used in case there is no mapping available for the input
source value.

5. Click Save.

I Note: Create a custom mapping set only if you must map the account to different input sources.

Sweeping the Transactions

The Sweep Channel Transaction Accounting Events scheduled process is used to sweep unaccounted channel
transactions to open or future enterable period.

Oracle Fusion Subledger Accounting for Buy Side Integration

Subledger Accounting integration enables you to define and configure accounting rules and generate detailed
accounting for business transactions in Channel Revenue Management. General Ledger integration enables the posting
of accounting journals to the general ledger for financial reporting.

Predefined Subledger Accounting Setup

Channel Revenue Management has been registered as a subledger application. The setup tasks are available in the
Channel Revenue Management functional area to help you set up your subledger.

Journal Source and Categories

Journal entries created for transactions from Channel Revenue Management are assigned the following journal source
and categories. Channel Revenue Management assigns default journal categories to each event class. You can configure
the assignment in the Subledger Accounting Options task.

This table gives the journal sources and journal categories for Channel Revenue Management.

Field Values

Journal Sources Channel Revenue
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Field Values
Journal Category Channel Accrual

Channel Claim

Channel Revenue Management Event Classes

An accounting event is a business event in Channel Revenue Management that has an accounting impact. Subledger
Accounting categorizes accounting events as event types. Event types are grouped into event classes. The Channel
Revenue Management accounting event model is predefined for you, and includes each event class and its life cycle.
This accounting event model forms the basis for creating subledger accounting. An event class enables Subledger
Accounting to handle the accounting for similar business events in a consistent manner.

For Channel Revenue Management, the Subledger Accounting integration is centered around deriving accounting rules
for two accounting event classes:

Event Class Event Types
Supplier Accrual Supplier Accrual Creation

Supplier Accrual Adjustment

Supplier Claim Settlement Supplier Claim Settlement by Check/Wire/EFT/AP Default

Supplier Claim Settlement by AP Debit

Supplier Accrual Event

For all accruals that are created, an accrual event triggers it's accounting to General Ledger. Accounting events are
raised with the respective event types for all accruals created in Channel Revenue Management. Supplier accrual events:

- Debit the Accrual Asset account

- Credit the Income or Discount on COGS account

For example:
Dr/Cr Account Amount
Dr. Accrual Asset USD 100
Cr. Income or Discount on COGS USD 100

Predefined Accounting Rules for Supplier Accruals

The following subledger accounting rules are used to generate accounting for supplier accruals if predefined journal
entry rule set is in use. The accounts to debit and credit are defined in the Subledger Accounting mapping sets.
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Event Class Name Journal Entry Rule Journal Line Rule Side Account Rule Mapping Set
Set
Supplier Accrual Supplier Accrual Rule ~ Accrual Asset Debit Accrual Asset Account  Accrual Asset Account

Income or Discount on Income or Discount on
COGS Account

Income or Discount on  Credit
COGS COGS Account

Supplier Accrual Supplier Accrual Rule

Supplier Claim Settlement Event

For all promotional claims that are settled after association to earnings, another accounting event is triggered.
Accounting events are raised after the claim is initiated for settlement. Supplier claim settlement events:

- Credit the Claim Accrual account
- Debit the Payables Clearing account

- Credit the Primary Ledger Exchange Gain and Loss account (from conversion rate differences between when
it's accrued vs paid)

For example:
Dr/Cr Account Amount
Cr. Claim Accrual Asset account USD 100
Dr. Payables Clearing account USD 100

Predefined Accounting Rules for Supplier Claim Settlements

The following subledger accounting rules are used to generate accounting for supplier claim settlements if predefined
journal entry rule set is in use. The accounts to debit and credit are defined in the Subledger Accounting mapping sets.

Event Class Name Journal Entry Rule Journal Line Rule Side Account Rule Mapping Set

Set
Supplier Claim Supplier Claim Payables Clearing Debit Payables Clearing Payables Clearing
Settlement Settlement by Account Account

Payables Rule
Supplier Claim Supplier Claim Claim Accrual Asset Credit Claim Accrual Asset Claim Accrual Asset
Settlement Settlement by Account Account

Payables Rule
Supplier Claim Supplier Claim Primary Ledger Credit Claim Gain or Loss Exchange Gain
Settlement Settlement by Exchange Gain or Loss Account Account

Payables Rule

ORACLE
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Manage Mapping Sets

The following predefined mapping sets are available for Channel Revenue Management. These map the predefined
input sources with the Chart of Accounts for your ledger.

Mapping Set

Accrual Asset Account

Claim Accrual Asset Account

Exchange Gain Account

Exchange Loss Account

Income or Discount on COGS
Account

Payables Clearing Account

Usage

Map the accrual asset account
to the accrual business unit and
adjustment type.

Map the claim accrual asset
account to the claim business unit
and claim type.

Map the exchange gain account to
the claim business unit.

Map the exchange loss account to
the claim business unit.

Map the income or discount on
the cost of goods sold account
to the accrual business unit and
adjustment type.

Map the Payables clearing account
to the claim business unit and
claim type. The Payables clearing
account is used for claims settled
through Payables settlement
methods.

Output Type

Account combination

Account combination

Account combination

Account combination

Account combination

Account combination

Assign Accounts to Predefined Mapping Sets

You must associate at least one output value for your ledger's chart of accounts for each of the above mapping sets if
you're using the predefined journal entry rule sets.
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Input Sources

Accrual Business Unit

Adjustment Type

- Claim Business Unit

Claim Type

Claim Business Unit

Claim Business Unit

- Accrual Business Unit

Adjustment Type

Claim Business Unit

- Claim Type

1. With roles having the required access, navigate to the Setup and Maintenance work area.

o Offering: Order Management/Procurement

o Functional Area: Channel Revenue Management/Supplier Incentives

o Task: Manage Mapping Sets

2. The Manage Mapping Sets: Channel Revenue Management page opens, where you can see the mapping sets
for your subledger. Select a mapping set to edit it.

3. Inthe Edit Mapping Set > Chart of Accounts section, click the Add Row icon. Select the chart of accounts from

the drop-down list.

4. Inthe Mappings section, add the Input source to Output type mappings for your account. If applicable, select
the Default button to identify a default account to be used in case there is no mapping available for the input

source value.

ORACLE
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5. Click Save.

Note: Create a custom mapping set only if you must map the account to different input sources.

Posting to General Ledger

General Ledger integration enables the posting of accounting journals to the general ledger for financial reporting for
program accruals and claims processing.

The Create Accounting process creates the subledger entries. To transfer the entries to general ledger, select the
following while scheduling the process:

- Transfer to General Ledger field as Yes.

- Post in General Ledger field as Yes.

Related Topics
« Overview of Buy Side Scheduled Processes

« Overview of Sell Side Scheduled Processes

Oracle Fusion Pricing Integration

Manage Your Integration

These are the Pricing tasks required for your implementation.

Manage Service Mappings for Channel Revenue Management
Manage Matrix Classes for Channel Revenue Management
Manage Algorithms for Channel Revenue Management
Manage Price Elements for Channel Revenue Management

Manage Pricing Bases for Channel Revenue Management

Program Eligibility

Determine Supplier Ship and Debit Program Eligibility

Program eligibility determines the supplier programs that can be applied to a sales order line.

Program eligibility works by evaluating the date effectivity, program, market, and product rules against the
corresponding attributes on the sales order line to determine if there is a match. If there is a match, the supplier
program is applied to the sales order line. Pricing calculates these accruals and returns them as charge components for
each supplier program applied.
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Manage Service Mappings for Channel Revenue Management

Service mappings store the eligibility attributes used for eligibility algorithms. To view the service mapping for Channel
Revenue Management:

1. From the Navigator, select Pricing Administration.

2. On the Overview page, open the Tasks panel and select Manage Service Mappings.

3. On the Manage Serve Mappings page, select Sales to manage service mappings for Channel Revenue
Management.

o Service Mapping: Sales
o Service Name: ProgramEligibility

Manage Matrix Classes for Channel Revenue Management

Matrix classes capture the conditions and results (dimensions) for a matrix. The predefined matrix class for Channel
Revenue Management is Channel Program Eligibility. Each of the program and market qualifiers in the program must
be setup as condition columns in the Channel Program Eligibility matrix class. The predefined qualifiers have already
been setup in the Channel Program Eligibility matrix class.

Custom Dimensions for Using Custom Qualifiers
To implement a custom qualifier in the program, you must add it as a dimension with domain in Pricing. After adding

the dimension, you can use it as a custom qualifier in your program types. For example, you want to set up a program or
market rule as Ship To Country Equals Canada. For this you must first create a custom qualifier for Ship To Country:

1. Add an entry in the lookup code for qualifiers ORA_CIM_QUALIFIER_TYPE. Make note of the lookup code and
meaning.

For example, Lookup Code = SHIP_TO_COUNTRY_ID; Meaning = Ship To Country

Sign in to Order Management with administrative privileges.

From the Navigator, select Pricing Administration.

From the Tasks panel click Manage Matrix Classes.

On the Manage Matrix Classes page, select Channel Program Eligibility.

On the Edit Matrix Class: Channel Program Eligibility page you can see the predefined dimensions.

Click the Add Row icon.

In Name field, enter the meaning for the lookup code you entered in ORA_CIJM_QUALIFIER _TYPE along with
the operator that should be used in the program and market rules.

OygouUhAWUN

For example, Ship To Country Equals

9. Inthe Source Code Name field, enter the lookup code you entered in ORA_CIM_QUALIFIER _TYPE
concatenated with the operator abbreviation. The supported operator abbreviations are E for equal to, NE for
not equal to, EGT for greater than or equal to, and ELT for less than or equal to.

For example, SHIP_TO_COUNTRY_ID_E
10. Inthe Comparison field, choose the comparison operator.

For example, =
11. From the Compare to Attribute drop-down list, select the order header, line, order header EFF, or order line
EFF attributes that you want to compare.

For example, Line.ShipToLocationCountry
12. Leave the Required check box deselected.
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13. Select the Allow Null and Null Is Wildcard check boxes.
14. From the Domain list, select the Domain type. Choose Lookup, Custom, or None.

o If you select Lookup, choose the lookup from the Lookup drop-down list.

o If you select Custom, choose Text or Number from the Data Type drop-down list. Specify the domain
values.

o If you select None, choose Text or Number from the Data Type drop-down list. The user specified values
for the dimension (qualifier) isn't validated with this option.

15. Click Save.

Manage Algorithms for Channel Revenue Management

The Price Sales Transaction process consists of a series of algorithm steps used to determine a base list price and
arrive at a final price for items.

1. Sign in to Order Management with administrative privileges.
. From the Navigator, select Pricing Administration.
3. From the Tasks panel click Manage Algorithms. The predefined algorithm for program eligibility is Get Eligible
Programs.

Note: If you have previously extended your algorithms, you will need to create a new version from version 0,
reconcile your algorithm extension changes to this new version, and then promote the algorithms.

Related Topics
» Promote Pricing Algorithms Into the Latest Update

« Pricing Algorithms
- How Service Mappings, Pricing Algorithms, and Matrixes Work Together

Pricing Execution

Eligibility service determines which programs are applied to the order line, based on the eligible channel programs, and
Pricing calculates the value of the accruals.

Accruals are deferred discounts which impact revenue and margin. Including accruals in the calculation of the margin
provides visibility into the true profitability of the sale. When an order line is eligible for a supplier accrual, this accrual
is displayed as a charge component and is included in the price breakdown on the order line. Pricing supports the
calculations for amount based accruals, percentage based accruals that are a percentage of price or a cost, and New
Cost based accruals.

Manage Price Elements for Channel Revenue Management
To manage the channel accrual price element:

1. In the Setup and Maintenance work area, go to:

o Offering: Order Management
o Functional Area: Pricing
o Task: Manage Price Elements
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2. Use the Manage Price Elements page to create and manage your channel price elements. These must be of
element type Cost or Price.

Manage Pricing Bases for Channel Revenue Management

Select the task Manage Pricing Bases to manage your pricing basis, or create a new one. The basis usage Accrual basis
is predefined for Channel Revenue Management.

You can create pricing basis for Channel Revenue Management with price element types Price and Cost. Once this is set
to active, it can be referenced in the channel program types. The pricing basis can be deleted as long as it's inactive and
not referenced in a pricing setup.

Note: Cost elements aren't supported for other types of bases.

Pricing Bases for New Cost and Percent Discount Types

To create a pricing basis for new cost or percent discount type:

Click the Create icon in the Manage Pricing Bases page.

Enter the name of the pricing basis in the Name field.

From the Price Element drop-down list, select a price element based on the element type Cost or Price.
From the Usage drop-down list select Accrual basis.

Select the Active check box.

Click Save. This creates the pricing basis which is now available for selection in channel program types.

CUVuhAWUNA

I Note: Basis isn't used for the Amount discount type.

Calculate Supplier Ship and Debit Accruals

Amount

You can directly specify the accrual amount in the program product rule. Pricing calculates accruals after net price, and
returns charge components of element type Accrual. Accruals with the adjustment type Accrual Amount are calculated
and returned.

New Cost

You can specify the new cost value in the program product rule. The accrual amount is calculated based on the basis for
new cost, specified in the program type. New Cost accruals are calculated based on a cost or price.

The accrual amount is calculated as the difference between the charge component referenced in the basis and the new
cost specified in the product rule. Accruals are calculated after net price, and returns charge components of element
type Accrual. Accruals with the adjustment type Accrual Difference are calculated and returned.

Calculation
Assuming the new program cost is captured on the program line (pricing term),
New Program Cost = Pricing Term.AdjustmentAmount (Value captured on the program)

Accrual Basis Calculation: This value is calculated by taking the charge component referenced in the Accrual Basis on
the Pricing Term.

Accrual Difference Calculation = Value of Accrual Basis - New Program Cost
For example: Average Cost =100 USD, New Program Cost = 80 USD, Quantity =1
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Unit Price (USD) Charge Component
500 Net Price
-100 Average Cost
20 Accrual
420 Margin

Note: Algorithm extensions may be needed to derive these costs if they're not defined in Pricing.

Percent

You can specify the discount in percentage in the product rule. The accrual amount is calculated based on the basis for
percent, specified in the program type. Pricing calculates accruals after net price, and returns charge components of
element type Accrual. Accruals with the adjustment type Accrual Percent are calculated and returned.

Returns

Referenced Returns: The polarity of the accrual charge components is reversed for the unit prices, and the extended
amounts are calculated based on unit price multiplied by returned quantity. Charges can be marked as refundable in
the Manage Pricing Charge Definitions page. As part of the standard returns processing, Pricing checks whether the
charge is refundable, and if non-refundable, the base list price, list price, and net price are set to zero. Accruals are also
calculated.

Un-referenced Returns: Pricing will price the un-referenced order line as an outbound line, apply automatic eligible
programs, and then reverse the polarity of the charges. Authorized users can decline programs and add manual
incentives.

Related Topics
- Manage Pricing Elements

- Manage Pricing Bases

Extensible Flexfields

How to Set Up Custom Qualifiers Based on Order Header
Extensible Flexfields

Here's how you can set up and use custom qualifiers based on order header extensible flexfields in your Supplier Ship
and Debit programs.
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Identify the Order Header Flexfields

1. With roles having the required access, navigate to the Setup and Maintenance work area.
o Offering: Order Management
o Functional Area: Orders
o Task: Manage Order Extensible Flexfields
2. On the Manage Order Extensible Flexfields page, in the Search area, enter Header Information as the name,
then click Search.

Select the flexfield from the search results and click Edit.
4. On the Edit Extensible Flexfield: Header Information page, click to expand Additional Header Information in
the Category section.

5. Onthe Associated Contexts tab, click Manage Contexts, create a new context with required details, and then
save your work. For example:

W

Field Value

Display Name Channel Program2

Code Channel Program2

APl Name ChannelProgram?

Enabled Ensure that the check box is selected
Behavior Single Row

Description Channel Program Quialifier

Context Usages Additional Header Information

Add these additional details to your sales order through Order Management > Create Order > Actions > Edit
Additional Information.

6. Inthe Context Sensitive Segments section of the Edit Context page, click Actions > Create to add a new
segment for example:

Field Value

Name Service Level

Code Service Level

API Name serviceLevel

Enabled Ensure that the check box is selected

7. Click Create Value Set.
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8. On the Create Value Set page, enter the details, and save your work. For example:

Field Value

Value Set Code Service Level
Description Service Level
Module Order Management
Validation Type Independent

Value Data Type Character

9. In the Definition section, enter the following details, and save your work. For example:

Field Value
Value Subtype Text
Maximum Length 10

10. Click Manage Values and ensure that the values are enabled, and save your work. For example:

Attribute Value Description
Value Gold Gold Level
Value Silver Silver Level
Value Bronze Bronze Level

11. Return to the Create Segment page, enter the required details, and save your work. For example:

Region Attribute Value

Column Assignment
Column Assignment
Validation
Validation

Display Properties
Display Properties
Display Properties

Display Properties

ORACLE

Data Type

Table Column

Value Set

Value Set Description
Prompt

Display Type

Display Size

Display Height

Character
ATTRIBUTE_CHAR1
Service Level
Service Level
Service Level

List of Values

10
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12. On the Edit Context page, ensure that the details in the Context Sensitive Segments section show accurately.

13.
14.

15.
16.

17.

18.

19.

For example:
Field Value
Sequence 10
Name Service Level
Code Service Level
Value Data Type Character
Display Type List of Values
Value Set Service Level
Enabled Ensure that this check box is selected
Prompt Service Level

Navigate to the Manage Context page and search for the Header Information EFF and click Edit.

On the Edit Extensible Flexfield: Header Information page, select Additional Header Information from the
Category list and add an Associated Context in the Additional Header Information Details section.

Search for and add the context you created. For example, Channel Program2. Save your work.

Click on the Pages tab. Click Actions > Create to create a new page and add the required details. For example:

Field Value

Display Name Channel Program Quialifiers2
Code Channel Program Qualifiers2
Description Channel Program Quialifiers
Usage Additional Header Information

Select the page you just created, search for, and associate the context you created with this page. For example,
Channel Program2. Save your work.

On the Manage Order Extensible Flexfields page, search for the Header Information extensible flexfield, and
click Deploy Flexfield. Wait for the deployment dialog to indicate that deployment successfully finished, then
click OK.

Verify your setup.

Download the Flexfield Archive and Obtain the View Object Details for the Extensible
Flexfields Context

1.

From the Manage Order Extensible Flexfields page, select your flexfield.
From the Actions menu, select Download Flexfield Archive. Wait for the dialog to indicate that the archive

successfully finished, then click Download. Save the 10008_DOO_HEADERS_ADD_INFQ.zip file to your local

hard drive.
Open the file, extract, and get the information for the context from the location:

88

ORACLE



SCM Cloud Chapter 3
Implementing Channel Revenue Management Integrate

4.

5.

10008_DOO_HEADERS_ADD_INFO\oracle\apps\scm\doo\processOrder\flex\headerContextsB\view

Open the XML file HeaderEffBChannelProgram2privateVO.xml. See the VO name for your flexfield. For
example, name = HeaderEffBChannelProgram2privateVO.
You can also get the attribute name from the XML file. For example, ViewAttribute Name=serviceLevel.

Manage Service Mapping Setup Using Sandbox after Identifying the Order Extensible
Flexfields

CUuhUNRA

10.
1n.

12.

With the appropriate pricing administrator role, navigate to the Sandboxes page.

In the Navigator, click Sandboxes.

On the Sandbox page, click Create Sandbox.

On the Create Sandbox page, enter a name for the sandbox.

Select the check box for the Manage Service Mappings tool, then click Create and Enter.

Navigate to the Pricing Administration work area. Select Manage Service Mappings from the panel.

Note: A yellow banner displays at the top of the page to indicate that you're in the sandbox.

On the Manage Service Mappings page, click Sales. Pricing comes predefined with the Sales service mapping
that prices sales orders and order lines.

On the Edit Service Mappings: Sales page, click the Entities tab. You use the Entities tab to define the entity and
its attribute details that receive the output of the service mapping. On the Entities tab, click Action > Add Row,
and enter the following details:

Field Value
Entity Name of your entity, for example, ServiceLevel_Custom
Description A description containing information about the entity for the flexfield on the order header.

In the Details section, add the following attributes, for example, and then save your work.

Attribute Type Primary Key Allow Null
Headerld_Custom Long Selected Selected
ServicelLevelCode_Custom String Leave this blank Selected

To specify the services, click the Services tab, and select ProgramEligibility.
In the Program Eligibility: Details section, select the Entities tab, click Actions > Add Row, enter the following
values, for example, and then save your work.

Field Value

Entity ServiceLevelCode_Custom
Read Selected

Write Selected

In the Details section, add the following attributes, for example, and then save your work.
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Attribute Alias Read Write Parent Attribute
Headerld_Custom Leave this blank. Selected Leave this blank. Leave this blank.
ServicelLevelCode_ Leave this blank. Selected Leave this blank. Leave this blank.

Custom

13. On the Edit Service Mappings: Sales page, select the Sources tab. Pricing comes predefined with the Sales
service mapping that prices sales orders and order lines.

14. For each of the following sources, add the entity you created, and add the following details in the Entity
Mappings tab of the Details section:

Source - ChannelProgramsforOrder

Field Value

Source ChannelProgramsForOrder

Entity The name of the entity you created. For example, ServiceLevel_Custom

Type View object

View Object The name of the view object. You retrieve this information from the downloaded flexfield

definition XML file. For example, HeaderEffBChannel__Program2privateVO
Query Type Unique identifier

Query Attribute Headerld

In the details section of your entity, click the Attributes Mappings tab. Enter the attributes of the entity that you
created and the view object attributes from the XML file, for example:

Field Value
Headerld_Custom Headerld
ServiceLevelCode_Custom serviceLevel

Source - ChannelProgramsforOrderLine

Field Value

Source ChannelProgramsForQOrderLine

Entity The name of the entity you created. For example, ServiceLevel_Custom
Type View object
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Field Value
View Object The name of the view object. You retrieve this information from the downloaded flexfield

definition XML file. For example, HeaderEffBChannelProgram2privateVO
Query Type Unique identifier
Query Attribute Headerld

In the details section of your entity, click the Attributes Mappings tab. Enter the attributes of the entity that you
created and the view object attributes from the XML file, for example:

Attribute View Object Attribute
Headerld_Custom Headerld
ServiceLevelCode_Custom servicelLevel

Source - ManualChannelProgramsforOrder

Field Value

Source ManualChannelProgramsForOrder

Entity The name of the entity you created. For example, ServiceLevel_Custom

Type View object

View Object The name of the view object. You retrieve this information from the downloaded flexfield

definition XML file. For example, HeaderEffBChannel__Program2privateVO
Query Type Unique identifier
Query Attribute Headerld

In the details section of your entity, click the Attributes Mappings tab. Enter the attributes of the entity that you
created and the view object attributes from the XML file, for example:

Attribute View Object Attribute
Headerld_Custom Headerld
ServiceLevelCode_Custom servicelLevel

15. Click Save.
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Pricing Algorithm Setup

Note: If you have implemented algorithm extensions for the Get Eligible Programs algorithm, then you must
perform the Merge Algorithm Extensions steps described in the Post-Update Steps section of the Oracle SCM Cloud:
Performing Your 22C Quarterly Update guide available from Oracle Fusion Cloud SCM: Performing Your Quarterly
Update (Doc ID 2337485.1).

After making any customizations, you must update the changes in the Pricing algorithm and publish it.

1. From the Navigator, select Pricing Administration.
2. From the Tasks panel, click Manage Algorithms. Select the algorithm for program eligibility, Get Eligible
Programs.

Note: You can either create a new version of Get Eligible Programs or you can modify the existing version. To
modify the existing version, first set it to inactive, make the changes, make it active again, and then publish it.

3. If you're setting up for supplier rebate programs, then on the Edit Algorithm: Get Eligible Programs page, from
the Algorithm tab, select the step Process Supplier Rebate Programs. Select the Process Each Program
Header row, then select Process Header Eligibility, , and then select Invoke Header Eligibility Matrix. Add
the entity you created using Service Mappings. Add the following details below the Header data set row:

Field Value

Name Enter your custom entity name here. For example, ServiceLevel_Custom.

Variable Path Add the variable path to your custom entity here. For example, EligibilityRequest.ServiceLevel _
Custom.

Primary Leave this blank.

Cardinality Zero or one

Data Set Join [Headerld_Custom:{Header.Headerld}]

Order By Leave this blank.

4. If you're setting up for supplier ship and debit or customer rebate programs, then on the Edit Algorithm: Get
Eligible Programs page, from the Algorithm tab, select the step Process Supplier Ship and Debit or Customer
Rebate Programs. Select the row Process Eligible Program Headers and add the entity you created using
Service Mappings. Add the following details below the Header data set row:

Field Value

Name Enter your custom entity name here. For example, ServiceLevel_Custom.

Variable Path Add the variable path to your custom entity here. For example, EligibilityRequest.ServiceLevel_
Custom.

Primary Leave this blank.

Cardinality Zero or one
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Field Value
Data Set Join [Headerld_Custom:{Header.Headerld}]
Order By Leave this blank.

5. On the Edit Algorithm: Get Eligible Programs page, in the Data Sets section of the Algorithm tab, select
Process Each Program Candidate, select Process Program Eligibility and select the Invoke Program

Eligibility Matrix Row add the entity you created using Service Mappings. Add the following details below the
Header data set row:

Field Value

Name Enter your custom entity name here. For example, ServiceLevel_Custom.

Variable Path Add the variable path to your custom entity here. For example, EligibilityRequest.ServiceLevel_
Custom.

Primary Leave this blank.

Cardinality Zero or one

Data Set Join [Headerld_Custom:{Line.Headerld}]

Order By Leave this blank.

6. Verify your setup, save, and then click Actions and Publish to publish the algorithm.

Adding the Qualifier

1. Inthe Setup and Maintenance work area, go to:
o Offering: Order Management

o Functional Area: Channel Revenue Management
o Task: Manage Channel Lookups

2. Onthe Manage Channel Lookups page, search for ORA_CIM_QUALIFIER_TYPE as the Lookup Type.
3. Click Action > New to add the following lookup code:

Field Value

Lookup Code Enter a name here. For example, SERVICE_LEVEL.
Enabled Selected

Meaning Service Level

Click Save and Close.

From the Navigator, select Pricing Administration.

In the Overview page, from the Tasks panel select Manage Matrix Classes.
In the Manage Matrix Classes pages, select Channel Program Eligibility.

NOo U b
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8.
Field Value
Name Add the name of the qualifier that you entered in the lookup to the Condition Columns of the

Source Code Name

Comparison

Compare to Attribute

Required
Allow Null

Null is Wildcard

Edit Matrix Class: Channel Program Eligibility page. For example, Service Level Equals.

Enter the lookup code that you entered in ORA_CIM_QUALIFIER _TYPE concatenated with the
operator abbreviation. The source code name of the matrix condition must match the newly
created lookup code. The supported operator abbreviations are E for equal to, NE for not equal
to, EGT for greater than or equal to, and ELT for less than or equal to. For example, SERVICE_
LEVEL_E.

Choose the comparison operator. For example, =.

Select the required attribute. If you're unable to view the attribute, make any update to the
description of the Channel context and save it before publishing the sandbox.

Note: The format of the Compare To Attribute must be Entity Name.Attribute Name (from
Service Mappings). For example, ServiceLevel_Custom.ServiceLevelCode_Custom

Leave this blank.
Selected

Selected

9. Click the icon next to Domain to edit the column domain values.

Field

Name

Default Value
Default is fixed value
Domain Type

Data Type

Value

Enter a name here. For example, Service Level Equals.
Leave this blank

Don't select this.

Custom

Text

Add the required Domain Values, for example:

Field

Domain Value
Display Value
Domain Value

Display Value

ORACLE

Value

Gold
Gold
Silver

Silver
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Field Value
Domain Value Bronze
Display Value Bronze

10. Click Save and Close.

You can now add the qualifier value used in the program in the EFF context field to the sales order line additional
information.

Related Topics
- Use Extensible Flexfields with Pricing

- How Service Mappings, Pricing Algorithms, and Matrixes Work Together

How to Set Up Custom Quialifiers Based on Order Line Extensible
Flexfields

Here's how you can setup and use custom qualifiers based on order line extensible flexfields in your Supplier Ship and
Debit programs.

Create a New EFF Attribute in OM Order Line

1. With roles having the required access, navigate to the Setup and Maintenance work area.

o Offering: Order Management
o Functional Area: Orders
o Task: Manage Order Extensible Flexfields

2. Onthe Manage Order Extensible Flexfields page, in the Search area, enter Fulfillment Line Information as the
name, then click Search.

Select the flexfield from the search results and click Edit.

4. C(Click Manage Contexts and then create a new context, and then save your work. For example:

W

Field Value

Display Name Channel Program

Code ChannelProgram

APl Name ChannelProgram

Enabled Ensure the check box is selected
Behavior Single Row

Description Channel Program Qualifier
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Field Value

Context Usages Additional Fulfillment Line Information

5. Add a new Segment, add the segment details, and save your work. For example:

Field Value

Name SSD Authorization Code

Code SSD Authorization Code

API Name ssdAuthorizationCode

Description Channel Program SSD Authorization Code
Data Type Character

Table Column ATTRIBUTE_CHAR1

6. Click Create Value Set.

Field Value

Value Set Code SSD Authorization Code
Description SSD Authorization Code
Module Order Management
Validation Type Format Only

Value Data Type Character

7. In the Definition section, enter the following details, and save your work.

Field Value
Value Subtype Text
Maximum Length 10

8. Return to the Create Segment page, enter details, and save your work. For example:

Region Attribute Value
Column Assignment Data Type Character
Column Assignment Table Column ATTRIBUTE_CHAR1

ORACLE

Chapter 3
Integrate
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Region Attribute Value
Validation Value Set SSD Authorization Code
Validation Value Set Description SSD Authorization Code
Display Properties Prompt SSD Authorization Code
Display Properties Display Type Text Box
Display Properties Display Size 10
Display Properties Display Height 1

9. Navigate to the Manage Context page and search for the Fulfillment Line Information EFF and click Edit.

10. On the Edit Extensible Flexfield: Fulfillment Line Information page, select Additional Fulfillment Line
Information from the Category list and add an Associated Context in the Additional Fulfillment Line
Information section.

11. Search for and add the context you created, for example Channel Program. Save your work.

12. Click the Pages tab, and then click Actions > Create to create a new page. Add required details, for example:

Field Value

Display Name Channel Program Qualifiers

Code Channel Program Qualifiers
Description Channel Program Qualifiers

Usage Additional Fulfillment Line Information

13. Search and associate the context you created with this page, fo example Channel Programs.

14. Click Save and Close.

15. On the Manage Order Extensible Flexfields page, search for the Fulfillment Line Information extensible flexfield,
and click Deploy Flexfield. Wait for the deployment dialog to indicate that deployment successfully finished,
then click OK.

16. Navigate to the Create Orders page and verify your setup.

Note: These additional details are added to your sales order through Order Management > Create Order >
Select the order line > Actions > Edit Additional Information.

Obtain the View Object Details for the Extensible Flexfields Context

1.
2.

From the Manage Order Extensible Flexfields page, select your flexfield.

From the Actions menu, select Download Flexfield Archive. Wait for the dialog to indicate that the archive
successfully finished, then click Download. Save the 10008_DOO_FULFILL_LINES_ADD_INFO.zip file to your
local hard drive.

Open the file, extract and get the information for the context from the location:

10008 _DOO_FULFILL LINES ADD INFO\oracle\apps\scm\doo\processOrder\flex\fulfillLineContextsB\view

Open the XML file FulfillLineEffBChannelProgramprivateVO.xml. for your flexfield to see the VO name. For
example, name = FulfillLineEffBChannelProgramprivateVO.
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5. You can also get the attribute name from the XML file. For example, ViewAttribute
Name=ssdAuthorizationCode.

Manage Service Mapping Setup Using Sandbox after Identifying the Order Line
Extensible Flexfields

With the appropriate pricing administrator role, navigate to the Sandboxes page.

In the Navigator, click Sandboxes.

On the Sandbox page, click Create Sandbox.

On the Create Sandbox page, enter a name for the sandbox.

Select the check box for Manage Service Mappings tool, then click Create and Enter.

Navigate to the Pricing Administration work area, select Manage Service Mappings from the panel.

cuhlhunNA

Note: A yellow banner displays at the top of the page to indicate that you're in the sandbox.

7. Onthe Manage Service Mappings page, click Sales to edit the service mapping. Pricing comes predefined with
the Sales service mapping that prices sales orders and order lines.

8. On the Edit Service Mappings: Sales page, click Entities. You use the Entities tab to define the line entity and
its attribute details that receives the output of the service mapping. Click Action > Add Row and enter the
following details, for example:

Field Value
Entity SSDAuthCode_Custom
Description Enter a description.

9. Inthe Details section, add the following attributes, and then save your work.

Attribute Type Primary Key Allow Null
Lineld_Custom Long Selected Selected
SSDCode_Custom String Leave this blank Selected

10. Click the Services tab, select ProgramEligibility.
11. In the ProgramEligibility: Details section, add the entity and its details that you just created.

Field Value

Entity SSDAuthCode_Custom
Read Selected

Write Selected
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12. In the Details section, add the following attributes, and then save your work.

Attribute Alias Read Write Parent Attribute
Lineld_Custom Leave this blank. Selected Leave this blank. Leave this blank.
SSDCode_Custom Leave this blank. Selected Leave this blank. Leave this blank.

13. Click Save and Close.

14. On the Edit Service Mappings: Sales page, select the Sources tab. Pricing comes predefined with the Sales
service mapping that prices sales orders and order lines.

15. For each of the following sources, add the entity you created, and add the following details in the Entity
Mappings tab of the Details section:

Source - ChannelProgramsforOrder

Field Value

Source ChannelProgramsForOrder

Entity The name of the entity you created. For example, SSDAuthCode_Custom.

Type View Object

View Object Add the view object from the XML file. For example, FulfillLineEffBChannelProgram2privateVO.
Query Type Join

Query Attribute FulfillLineld

Joined Entity Line

Joined Entity Attribute Lineld

Note: Ensure you add the custom entity below the Line entity.

In the details section of your entity, on the Attributes Mappings tab, enter the attributes of the entity you
created and the view object attributes from the XML file, for example:

Attribute View Object Attribute

Lineld_Custom FulfillLineld
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Attribute View Object Attribute
SSDCode_Custom ssdAuthorizationCode

Source - ChannelProgramsforOrderLine

Field Value

Source ChannelProgramsForOrderLine

Entity The name of the entity you created. For example, SSDAuthCode_Custom.

Type View Object

View Object Add the view object from the XML file. For example, FulfillLineEffBChannelProgram2privateVO.
Query Type Join

Query Attribute FulfillLineld

Joined Entity Line

Joined Entity Attribute Lineld

Note: Ensure you add the custom entity below the Line entity.

In the details section of your entity, on the Attributes Mappings tab, enter the attributes of the entity you
created and the view object attributes from the XML file, for example:

Attribute View Object Attribute
Lineld_Custom FulfillLineld
SSDCode_Custom ssdAuthorizationCode

Source - ManualChannelProgramsforOrder

Field Value

Source ChannelProgramsForOrder

Entity The name of the entity you created. For example, SSDAuthCode_Custom.

Type View Object

View Object Add the view object from the XML file. For example, FulfillLineEffBChannelProgram2privateVO.
Query Type Join
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Field Value
Query Attribute FulfillLineld
Joined Entity Line
Joined Entity Attribute Lineld

Note: Ensure you add the custom entity below the Line entity.

In the details section of your entity, on the Attributes Mappings tab, enter the attributes of the entity you
created and the view object attributes from the XML file, for example:

Attribute View Object Attribute

Lineld_Custom FulfillLineld

SSDCode_Custom ssdAuthorizationCode
16. Click Save.

Pricing Algorithm Setup

After any customizations you must update the changes in the Pricing algorithm and publish it.

1. Sign in to Order Management with administrative privileges.

2. From the Navigator, select Pricing Administration.

3. From the Tasks panel click Manage Algorithms. Select the algorithm for program eligibility, Get Eligible
Programs.

Note: If you have previously extended your algorithms, you will need to create a new version from version O,
reconcile your algorithm extension changes to this new version, and then promote the algorithms.

4. On the Edit Algorithm: Get Eligible Programs page, in the Data Sets section of the Algorithm tab, select Process
Each Program Candidate, select the Process Program Eligibility, and then select the Invoke Program
Eligibility Matrix Row add the entity you created using Service Mappings. Add the following details below the
Line data set row:

Field Value

Name Enter your custom entity name here. For example, SSDAuthCode_Custom.
Variable Path EligibilityRequest.SSDAuthCode_Custom

Primary Leave this blank.

Cardinality Zero or one

Data Set Join [Lineld_Custom:{Line.Lineld}]

Order By Leave this blank
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5. Verify your setup and then click Actions and Publish to publish the algorithm.

Adding the Qualifier
1. In the Setup and Maintenance work area, go to:

o Offering: Order Management

o Functional Area: Channel Revenue Management

o Task: Manage Channel Lookups
2. Search for the configurable lookup: ORA_CIM_QUALIFIER_TYPE. Add the qualifier to the lookup code. For
example, Lookup Code = SSDAuthCode; Meaning = SSD Auth Code.
Click Save and Close.

4. From the Navigator, select Pricing Administration. In the Overview page, from the Tasks panel select Manage
Matrix Classes.

5. Inthe Manage Matrix Classes pages, select Channel Program Eligibility. Enter the following details:

W

Field Value

Name Enter the meaning for the lookup code you entered in ORA_CIM_QUALIFIER _TYPE along with
the operator. For example, SSDAuthCode.

Source Code Name Enter the lookup code you entered in ORA_CIM_QUALIFIER _TYPE concatenated with the
operator abbreviation. The supported operator abbreviations are E for equal to, NE for not
equal to, EGT for greater than or equal to, and ELT for less than or equal to. For example,
SSDAuthCode_E.

Comparison Choose the comparison operator. For example, =.

Compare to Attribute Select the attribute you created using service mappings.

Note: The format of the Compare To Attribute must be Entity Name.Attribute Name (from
Service Mappings). For example, SSDAuthCode_Custom.SSDCode_Custom.

Required Leave this blank.
Allow Null Selected

Null is Wildcard Selected
Domain Text

6. Click Save and Close.

Now you should be able to enter the qualifier value used in the program in the EFF context field to the sales order line
additional information.
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How to Set Up Custom Qualifiers Based on Supplier Invoice
Header Descriptive Flexfields

Here's how you can set up and use custom qualifiers based on Supplier Invoice Header descriptive flexfields in your
Supplier Rebate programs.

I Note: This setup doesn't apply to Supplier Rebate programs with direct integration to PO, Receiving, and AP.

Configure Document Header Descriptive Flexfield
1. With roles having the required access, navigate to the Setup and Maintenance work area.

o Offering: Order Management
o Functional Area: Channel Revenue Management
o Task: Manage Channel Descriptive Flexfields

2. Onthe Manage Channel Descriptive Flexfield page, search for the Channel Document Header DFF as the name,
and click to edit it.

3. On the Edit Descriptive Flexfields: Channel Document Header DFF page, in the Global Segments section, click
Actions > Create to create a new Global Segment.

Field Value

Name Supplier_Product_Color_headerdff
Code Supplier_Product_Color_headerdff
APl Name supplierProductColorHeaderdff
Enabled Ensure the check box is selected

4. C(lick Create Value Set.
5. On the Create Value Set page, enter the details, and save your work. For example:

Field Value

Value Set Code Supplier_Product_Color
Description Supplier_Product_Color
Module Channel Revenue Management
Validation Type Independent

Value Data Type Character
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6. In the Definition section, enter the following details, and save your work. For example:

Field Value
Value Subtype Text
Maximum Length 15

7. Click Manage Values and ensure the values are enabled, and save your work. For example:

Attribute Value Description Enabled

Value Black Black Selected

Note: This attribute value should have been specified in the supplier invoice and available in the imported
CSV file to qualify the program.

8. Return to the Create Segment page, enter the required details, and save your work. For example:

Region Attribute Value

Column Assignment Data Type Character

Column Assignment Table Column ATTRIBUTE_CHAR2

Validation Value Set Supplier_Product_Color

Validation Value Set Description Supplier_Product_Color

Display Properties Prompt Supplier_Product_Color_headerdff
Display Properties Display Type List of Values

9. Onthe Manage Channel Descriptive Flexfields page, search for the Channel Document Header DFF, and click
Actions > Deploy Flexfield. Wait for the deployment dialog to indicate that deployment successfully finished,
then click OK.

10. Verify your setup.

Download the Flexfield Archive and Obtain the View Object Details for the Channel
Document Header Descriptive Flexfields Context

1. From the Manage Channel Document Header Descriptive Flexfields page, select your flexfield.

2. From the Actions menu, select Download Flexfield Archive. Wait for the dialog to indicate that the archive
successfully finished, then click Download. Save the 10566_CIJM_DOCUMENT_HEADER_DFF.zip file to your
local hard drive.

3. Open the file, extract and get the information for the context from the location:

10566_CJM DOCUMENT HEADER DFF\oracle\apps\flex\scm\cjm\indirectSales\documentHeaderFlex\view

4. Open the XML file CjmDocumentHeaderDFFVO.xml for your flexfield to see the VO name. For example, name =
CjmDocumentHeaderDFFVO
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5. You can also get the attribute name from the XML file. For example, ViewAttribute Name =
supplierProductColorHeaderdff.

Manage Service Mapping Setup Using Sandbox after Identifying the Channel
Document Header Descriptive Flexfields

1. With the appropriate pricing administrator role, navigate to the Sandboxes page.

2. Inthe Navigator, click Sandboxes.

3. Onthe Sandbox page, click Create Sandbox.

4. On the Create Sandbox page, enter a name for the sandbox.

5. Select the check box for the Manage Service Mappings tool, then click Create and Enter.

6. Navigate to the Pricing Administration work area, select Manage Service Mappings from the panel.
Note: A yellow banner displays at the top of the page to indicate that you're in the sandbox.

7. Onthe Manage Service Mappings page, click Channel.

8. On the Edit Service Mapping: Channel page, click the Entities tab. You use the Entities tab to define the entity
and its attribute details that receives the output of the service mapping. On the Entities tab, click Action > Add
Row, and enter the following details:

Field Value
Entity Name of your entity, for example, SupplierProductColorHeaderdff_Custom
Description A description containing information about the entity for the flexfield on the order header. For

example, SupplierProductColorHeaderdff_Custom.

9. Inthe Details section, add the following attributes, for example, and then save your work.

Attribute Type Primary Key Allow Null
DocumentHeaderld_Custom Long Selected Selected
SupplierProductColorHeaderdff_  String Leave this blank Selected
Custom

10. To specify the services, click the Services tab, select ProgramEligibility.

11. In the ProgramEligibility: Details section, select the Entities tab, click Actions > Add Row, enter the following
values, for example, and then save your work.

Field Value

Entity SupplierProductColorHeaderdff_Custom
Read Selected

Write Leave this blank
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12. In the Details section, add the following attributes, for example, and then save your work.

Attribute Alias Read Write Parent Attribute
DocumentHeaderld_ Leave this blank. Selected Leave this blank. Leave this blank.
Custom
SupplierProductColorHead Leave this blank. Selected Leave this blank. Leave this blank.
Custom

13. On the Edit Service Mappings: Channel page, select the Sources tab.

14. For each of the following sources, add the entity you created, and add the following details in the Entity
Mappings tab of the Details section:

Field Value

Source ChannelProgramsForSupplierDocument

Entity The name of the entity you created. For example,SupplierProductColorHeaderdff_Custom.
Type View object

View Object The name of the view object. You retrieve this information from the downloaded flexfield

definition XML file. For example, CjmDocumentHeaderDFFVO

Query Type Unique identifier
Query Attribute DocumentHeaderld
Use Existing View Object Selected

In the details section of your entity, on the Attributes Mappings tab, enter the attributes of the entity you
created and the view object attributes from the XML file, for example:

Attribute View Object Attribute
DocumentHeaderld_Custom DocumentHeaderld
SupplierProductColorHeaderdff_ supplierProductColorHeaderdff
Custom

15. Click Save and Publish the sandbox. Once it is published, when the Eligibility REST is described, the attributes
should be visible in the payload.

Pricing Algorithm Setup

Note: If you have implemented algorithm extensions for the Get Eligible Programs algorithm, then you must
perform the Merge Algorithm Extensions steps described in the Post-Update Steps section of the Oracle SCM Cloud:
Performing Your 22C Quarterly Update guide available from Oracle Fusion Cloud SCM: Performing Your Quarterly
Update (Doc ID 2337485.1).
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After any customizations you must update the changes in the Pricing algorithm and publish it.

1. From the Navigator, select Pricing Administration.
2. From the Tasks panel click Manage Algorithms. Select the algorithm for program eligibility, Get Eligible
Programs.

Note: You can either create a new version of Get Eligible Programs or you can modify the existing version by
first setting it to inactive, making the changes, making it active again, and publishing it.

3. On the Edit Algorithm: Get Eligible Programs page, in the Data Sets section of the Algorithm tab, select Process
Supplier Rebate Programs > Process Each Program Header > Invoke Header Eligibility Matrix and add the
data set you created using Service Mappings. Add the following details below the Header data set row:

Field Value
Name Enter your custom entity name here. For example, SupplierProductColorHeaderdff_Custom.
Variable Path Add the variable path to your custom entity here. For example,

EligibilityRequest.SupplierProductColorHeaderdff_Custom.

Primary Leave this blank.

Cardinality Zero or one

Data Set Join [DocumentHeaderld_Custom:{Header.Headerld}]
Order By Leave this blank.

4. Verify your setup, save, and then click Actions and Publish to publish the algorithm.

Adding Custom Dimension based on DFF Setup
1. With the appropriate pricing administrator role, navigate to the Manage Matrix Classes page.

o Offering: Order Management
o Functional Area: Pricing Administration
o Task: Manage Matrix Classes

2. C(lick Channel Program Eligibility to select and edit it.
3. Click Actions > Add Row in the Condition Columns section.

Field Value

Name Enter a entity name here. For example, Supplier Product Color Equals.

Source Code Name Enter a value for example, SUPPLIER_PRODUCT_COLOR_E.

Comparison =

Compare to Attribute SupplierProductColorHeaderdff_Custom.SupplierProductColorHeaderdff_Custom
Allow Null Selected
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Field Value
Null is Wildcard Selected
Domain Text

4. Click the icon next to Domain to edit the column domain values.

Field Value

Name Enter a name here. For example, Supplier Product Color Equals.
Default Value Leave this blank

Default is fixed value Don't select this.

Domain Type None

Data Type Text

Adding the Lookup code to the Channel Lookup
1. With the appropriate channel role, navigate to the Setup and Maintenance page.

o Offering: Order Management
o Functional Area: Channel Revenue Management
o Task: Manage Channel Lookups

2. Onthe Manage Channel Lookups page, search for ORA_CIM_SUP_REBATE_QUAL as the Lookup Type.
3. Click Action > New to add the following lookup code:

Field Value

Lookup Code Enter a name here. For example, SUPPLIER_PRODUCT_COLOR.
Enabled Selected

Meaning Enter a description here. For example, SUPPLIER_PRODUCT_COLOR.

How to Set Up Custom Qualifiers Based on Supplier Invoice Line
Descriptive Flexfields

Here's how you can set up and use custom qualifiers based on Supplier Invoice Line descriptive flexfields in your
Supplier Rebate programs.

I Note: This setup doesn't apply to Supplier Rebate programs with direct integration to PO, Receiving and AP.
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Configure Document Line Descriptive Flexfield
1. With roles having the required access, navigate to the Setup and Maintenance work area.

o Offering: Order Management
o Functional Area: Channel Revenue Management
o Task: Manage Channel Descriptive Flexfields

2. Onthe Manage Channel Descriptive Flexfield page, search for the Channel Document Line DFF as the name,
and click to edit it.

3. On the Edit Descriptive Flexfields: Channel Document Line DFF page, in the Global Segments section, click
Actions > Create to create a new Global Segment.

Field Value

Name SupplierNumber_Linedff

Code SupplierNumber_Linedff

APl Name supplierNumberLinedff
Enabled Ensure the check box is selected

4. Click Create Value Set.
5. Onthe Create Value Set page, enter the details, and save your work. For example:

Field Value

Value Set Code Numbersequence

Description Numbersequence

Module Channel Revenue Management
Validation Type Independent

Value Data Type Number

6. Click Manage Values and ensure the values are enabled, and save your work. For example:

Attribute Value Description Enabled

Value 2 2 Selected

Note: This attribute value should have been specified in the supplier invoice and available in the imported
CSV file to qualify the program.

7. On the Manage Channel Descriptive Flexfields page, search for the Channel Document Header DFF, and click
Actions > Deploy Flexfield. Wait for the deployment dialog to indicate that deployment successfully finished,
then click OK.
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8. Verify your setup.

Download the Flexfield Archive and Obtain the View Object Details for the Channel
Document Line Descriptive Flexfields Context

1. From the Manage Channel Document Header Descriptive Flexfields page, select your flexfield.

. From the Actions menu, select Download Flexfield Archive. Wait for the dialog to indicate that the archive
successfully finished, then click Download. Save the 10566_CIJM_DOCUMENT_LINE_DFF.zip file to your local
hard drive.

3. Open the file, extract and get the information for the context from the location:

10566_CJM DOCUMENT LINE DFF.zip\oracle\apps\flex\scm\cjm\indirectSales\documentLineFlex\view

4. Open the XML file CijmDocumentLineDFFVO.xml for your flexfield to see the VO name. For example, name =
CjmDocumentLineDFFVO

5. You can also get the attribute name from the XML file. For example, ViewAttribute Name =
suppliernumberLinedff.

Manage Service Mapping Setup Using Sandbox after Identifying the Channel
Document Line Descriptive Flexfields

With the appropriate pricing administrator role, navigate to the Sandboxes page.

In the Navigator, click Sandboxes.

On the Sandbox page, click Create Sandbox.

On the Create Sandbox page, enter a name for the sandbox.

Select the check box for the Manage Service Mappings tool, then click Create and Enter.

Navigate to the Pricing Administration work area, select Manage Service Mappings from the panel.

ok UNRA

Note: A yellow banner displays at the top of the page to indicate that you're in the sandbox.

7. Onthe Manage Service Mappings page, click Channel.

8. On the Edit Service Mapping: Channel page, click the Entities tab. You use the Entities tab to define the entity
and its attribute details that receives the output of the service mapping. On the Entities tab, click Action > Add
Row, and enter the following details:

Field Value
Entity Name of your entity, for example, SuppliernumberLinedff_Custom
Description A description containing information about the entity for the flexfield on the order header. For

example, SuppliernumberLinedff_Custom.

9. Inthe Details section, add the following attributes, for example, and then save your work.

Attribute Type Primary Key Allow Null
DocumentLineld_Custom Long Selected Selected
SuppliernumberLinedff_Custom Long Leave this blank Selected

10. To specify the services, click the Services tab, select ProgramEligibility.
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11. In the ProgramEligibility: Details section, select the Entities tab, click Actions > Add Row, enter the following
values, for example, and then save your work.

Field Value

Entity SuppliernumberLinedff_Custom
Read Selected

Write Leave this blank

12. In the Details section, add the following attributes, for example, and then save your work.

Attribute Alias Read Write Parent Attribute
DocumentLineld_Custom Leave this blank. Selected Leave this blank. Leave this blank.
SuppliernumberLinedff_ = Leave this blank. Selected Leave this blank. Leave this blank.
Custom

13. On the Edit Service Mappings: Channel page, select the Sources tab.

14. For each of the following sources, add the entity you created, and add the following details in the Entity
Mappings tab of the Details section:

Field Value

Source ChannelProgramsForSupplierDocument

Entity The name of the entity you created. For example,SuppliernumberLinedff_Custom.

Type View object

View Object The name of the view object. You retrieve this information from the downloaded flexfield

definition XML file. For example, CjmDocumentLineDFFVO

Query Type Join

Query Attribute DocumentLineld
Joined Entity Line

Joined Entity Attribute Lineld

In the details section of your entity, on the Attributes Mappings tab, enter the attributes of the entity you
created and the view object attributes from the XML file, for example:

Attribute View Object Attribute

DocumentLineld_Custom DocumentLineld
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Attribute View Object Attribute
SuppliernumberLinedff_Custom suppliernumberLinedff

15. Click Save and Publish the sandox. Once it is published, when the Eligibility REST is described, the attributes
should be visible in the payload.

Pricing Algorithm Setup

After any customizations you must update the changes in the Pricing algorithm and publish it.

1. From the Navigator, select Pricing Administration.

2. From the Tasks panel click Manage Algorithms. Select the algorithm for program eligibility, Get Eligible
Programs.

Note: You can either create a new version of Get Eligible Programs or you can modify the existing version by
first setting it to inactive, making the changes, making it active again, and publishing it.

3. On the Edit Algorithm: Get Eligible Programs page, in the Data Sets section of the Algorithm tab, select Process
Supplier Rebate Programs > Process Each Program Header > Invoke Program Eligibility Matrix and add
the data set you created using Service Mappings. Add the following details below the header row:

Field Value
Name Enter your custom entity name here. For example, SuppliernumberLinedff_Custom.
Variable Path Add the variable path to your custom entity here. For example,

EligibilityRequest.SuppliernumberLinedff_Custom.

Primary Leave this blank.

Cardinality Zero or one

Data Set Join [DocumentLineld_Custom:{Line.Lineld}]
Order By Leave this blank.

4. Verify your setup, save, and then click Actions and Publish to publish the algorithm.

Adding Custom Dimension based on DFF Setup
1. With the appropriate pricing administrator role, navigate to the Manage Matrix Classes page.

o Offering: Order Management
o Functional Area: Pricing Administration
o Task: Manage Matrix Classes
2. C(lick Channel Program Eligibility to select and edit it.
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3. Click Actions > Add Row in the Condition Columns section and add a column, for example:

Field Value
Name Enter a entity name here. For example, Supplier Number Equals.
Source Code Name Enter a value for example, SUPPLIER_NUMBER_E.

Comparison =

Compare to Attribute SuppliernumberLinedff_Custom.SuppliernumberLinedff_Custom.
Allow Null Selected.
Null is Wildcard Selected
Domain Number

4. C(lick the icon next to Domain to edit the column domain values.

Field Value

Name Enter a name here. For example, Supplier Number Equals.
Default Value Leave this blank

Default is fixed value Don't select this.

Domain Type None

Data Type Number

Adding the Lookup code to the Channel Lookup
1. With the appropriate channel role, navigate to the Setup and Maintenance page.

o Offering: Order Management
o Functional Area: Channel Revenue Management
o Task: Manage Channel Lookups

2. On the Manage Channel Lookups page, search for ORA_CIM_SUP_REBATE_QUAL as the Lookup Type.
3. Click Action > New to add the following lookup code:

Field Value

Lookup Code Enter a name here. For example, SUPPLIER_NUMBER.
Enabled Selected

Meaning Enter a description here. For example, SUPPLIER_NUMBER.
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4. Click Action > New to add another lookup code:

Field Value

Lookup Code Enter a name here. For example, SUPPLIER_NUMBER.
Enabled Selected

Meaning Enter a description here. For example, SUPPLIER_NUMBER.

How to Set Up Custom Qualifiers Based on Sales Invoice Header
Descriptive Flexfields

Here's how you can set up and use custom qualifiers based on Sales Invoice Header descriptive flexfields in your
Customer Rebate programs.

Configure Document Header Descriptive Flexfield

1. With roles having the required access, navigate to the Setup and Maintenance work area.
o Offering: Order Management

o Functional Area: Channel Revenue Management
o Task: Manage Channel Descriptive Flexfields

2. Onthe Manage Channel Descriptive Flexfields page, search for the Channel Document Header DFF as the
name, and click to edit it.

3. On the Edit Descriptive Flexfields: Channel Document Header DFF page, in the Global Segments section, click
Actions > Create to create a new Global Segment.

Field Value

Name Customer_Project_headerDff
Code Customer_Project_headerDff
APl Name customerProjectHeaderdff
Enabled Ensure the check box is selected

4. C(lick Create Value Set.
5. On the Create Value Set page, enter the details, and save your work. For example:

Field Value
Value Set Code Customer_Project
Description Customer_Project
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Field Value
Module Channel Revenue Management
Validation Type Independent
Value Data Type Character

6. In the Definition section, enter the following details, and save your work. For example:

Field Value
Value Subtype Text
Maximum Length 15

7. Click Manage Values and ensure the values are enabled and save your work. For example:

Attribute Value Description Enabled
Value Project1 Project1 Selected
Value Project2 Project2 Project2
Value Project3 Project3 Project3

Note: This attribute value should have been specified in the sales order and available in the imported CSV
file to qualify the program.

8. Return to the Create Segment page, enter the required details, and save your work. For example:

Section Attribute Value

Column Assignment Data Type Character

Column Assignment Table Column ATTRIBUTE_CHAR1
Validation Value Set Customer_Project

Validation Value Set Description Customer_Project

Display Properties Prompt Customer_Project_headerDff
Display Properties Display Type List of Values

On the Manage Channel Descriptive Flexfields page, search for the Channel Document Header DFF, and click
Actions > Deploy Flexfield. Wait for the deployment dialog to indicate that deployment successfully finished,
then click OK

9. Verify your setup.
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Download the Flexfield Archive and Obtain the View Object Details for the Channel
Document Header Descriptive Flexfields Context

1. From the Manage Channel Document Header Descriptive Flexfields page, select your flexfield.

2. From the Actions menu, select Download Flexfield Archive. Wait for the dialog to indicate that the archive
successfully finished, then click Download. Save the 10566_CIJM_DOCUMENT_HEADER_DFF.zip file to your
local hard drive.

3. Open the file, extract and get the information for the context from the location:
10566_CIM_DOCUMENT_HEADER_DFF\oracle\apps\flex\scm\cjm\indirectSales\documentHeaderFlex\view

4. Open the XML file CimDocumentHeaderDFFVO.xml for your flexfield to see the VO name. For example, name =
CjmDocumentHeaderDFFVO

5. You can also get the attribute name from the XML file. For example, ViewAttribute Name
=customerProjectHeaderdff.

Manage Service Mapping Setup Using Sandbox after Identifying the Channel
Document Header Descriptive Flexfields

1. With the appropriate pricing administrator role, navigate to the Sandboxes page.

2. In the Navigator, Configuration, click Sandboxes.

3. Onthe Sandboxes page, click Create Sandbox.

4. On the Create Sandbox page, enter a name for the sandbox. For example, CR_Sandbox1

5. Select the check box for the Manage Service Mappings tool, then click Create and Enter. Ensure that
Publishable is set to Yes.

6. Navigate to the Pricing Administration work area, select Manage Service Mappings from the panel.

Note: A yellow banner displays at the top of the page to indicate that you're in the sandbox.

7. On the Manage Service Mappings page, click Channel.

8. On the Edit Service Mapping: Channel page, click the Entities tab. Use the Entities tab to define the entity and
its attribute details that receive the output of the service mapping. On the Entities tab, click Actions > Add Row,
and enter the following details:

Field Value
Entity Name of your entity, for example, CustomerProjectHeaderDff_Custom.
Description A description containing information about the entity for the flexfield on the order header. For

example, CustomerProjectHeaderDff_Custom.

9. In the Details section, add the following attributes, for example, and then save your work.

Attribute Type Primary Key Allow Null
DocumentHeaderld_Custom Long Selected Selected
CustomerProjectHeaderDff_ String Leave this blank Selected
Custom

10. To specify the services, click the Services tab, select ProgramEligibility.
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11. In the ProgramEligibility: Details section, select the Entities tab, click Actions > Add Row, enter the following
values, for example, and then save your work.

Field Value

Entity Select the name of the enttity from the list. For example, CustomerProjectHeaderDff_Custom.
Read Selected

Write Leave this blank

12. In the Entities section for the entity you created, add the following attributes, for example, and then save your

work.
Attribute Alias Read Write Parent Attribute
DocumentHeaderld_ Leave this blank Selected Leave this blank Leave this blank
Custom
CustomerProjectHeaderDi Leave this blank Selected Leave this blank Leave this blank
Custom

13. On the Edit Service Mappings: Channel page, select the Sources tab.
14. For each of the following sources, add the entity you created, and add the following details in the Entity
Mappings tab of the Details section:

Field Value

Source ChannelProgramsForCustomerDocument

Entity The name of the entity you created. For example, CustomerProjectHeaderDff_Custom .
Type View object

View Object The name of the view object. You retrieve this information from the downloaded flexfield

definition XML file. For example, CjmDocumentHeaderDFFVO

Query Type Unique identifier
Query Attribute DocumentHeaderld
Use Existing View Object Selected

In the details section of your entity, on the Attributes Mappings tab, enter the attributes of the entity you
created and the view object attributes from the XML file, for example:

Attribute View Object Attribute
DocumentHeaderld_Custom DocumentHeaderld
CustomerProjectHeaderDff_Custom customerProjectHeaderdff
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15. Click Save and Publish the sandbox. Once it is published, when the Eligibility REST is described, the attributes
should be visible in the payload.

Pricing Algorithm Setup

Note: If you have implemented algorithm extensions for the Get Eligible Programs algorithm, then you must perform
the Merge Algorithm Extensions steps described in the Post-Update Steps section of the Oracle SCM Cloud:

Performing Your 22C Quarterly Update guide available from Oracle Fusion Cloud SCM: Performing Your Quarterly
Update (Doc ID 2337485.1).

After any customizations you must update the changes in the Pricing algorithm and publish it.

1. From the Navigator, select Pricing Administration.
From the Tasks panel click Manage Algorithms. Select the algorithm for program eligibility, Get Eligible
Programs.

Note: You must create a new version of Get Eligible Programs to make changes and publish it. You cannot
modify published versions, for example, Version 0 and Version 1. If you're unable to create a new version, click
Actions and select Promote All before creating a new version.

3. On the Edit Algorithm: Get Eligible Programs page, select Process Supplier Ship and Debit or Customer
Rebate Programs > Process Eligible Program Headers. In the Data Sets section of the Algorithm tab, add the
data set you created using Service Mappings. Add the following details below the Header data set row:

Field Value
Name Enter your custom entity name here. For example, CustomerProjectHeaderDff_Custom.
Variable Path Add the variable path to your custom entity here. For example,

EligibilityRequest.CustomerProjectHeaderDff_Custom.

Primary Leave this blank.

Cardinality Zero or one

Data Set Join [DocumentHeaderld_Custom:{Header.Headerld}]
Order By Leave this blank.

4. Inthe Data Sets section of the Algorithm tab, select Process Each Program Candidate > Process Program
Eligibility > Invoke Program Eligibility Matrix. Add the following details below the Header data set row:

Field Value
Name Enter your custom entity name here. For example, CustomerProjectHeaderDff_Custom.
Variable Path Add the variable path to your custom entity here. For example,

EligibilityRequest.CustomerProjectHeaderDff_Custom.

Primary Leave this blank.
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Field Value
Cardinality Zero or one
Data Set Join [DocumentHeaderld_Custom:{Line.Headerld}]
Order By Leave this blank.

5. Verify your setup, save, and then click Actions and Publish to publish the algorithm.

Adding Custom Dimension based on DFF Setup
1. With the appropriate pricing administrator role, navigate to the Manage Matrix Classes page.
o Offering: Order Management
o Functional Area: Pricing Administration
o Task: Manage Matrix Classes

2. C(Click Channel Program Eligibility to select and edit it.
3. Click Actions > Add Row in the Condition Columns section.

Field Value

Name Enter an entity name here. For example, XX_Project Equals.

Source Code Name Enter a value for example, XX_PROJECT_E.

Comparison =

Compare to Attribute CustomerProjectHeaderDff_Custom.CustomerProjectHeaderDff_Custom
Allow Null Selected

Null is Wildcard Selected

Domain Text

4. C(lick the icon next to Domain to edit the column domain values.

Field Value

Name Enter a name here. For example, XX_Project Equals.
Default Value Leave this blank

Default is fixed value Don't select this.

Domain Type Custom

Data Type Text
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Adding the Lookup code to the Channel Lookup

1. o With the appropriate channel role, navigate to the Setup and Maintenance page.

- Offering: Order Management

- Functional Area: Channel Revenue Management

- Task: Manage Channel Lookups
2. Onthe Manage Channel Lookups page, search for ORA_CIM_CUST_REBATE_QUAL as the Lookup Type.
3. Click Actions > New to add the following lookup code:

Field Value

Lookup Code Enter a name here. For example, XX_Project.

Display Sequence 12

Enabled Selected

Meaning Enter a description here. For example, Custom Project.

How to Set Up Custom Qualifiers Based on Sales Invoice Line
Descriptive Flexfields

Here's how you can set up and use custom qualifiers based on Sales Invoice Line descriptive flexfields in your Customer
Rebate programs.

Configure Document Line Descriptive Flexfield
1. With roles having the required access, navigate to the Setup and Maintenance work area.
o Offering: Order Management
o Functional Area: Channel Revenue Management
o Task: Manage Channel Descriptive Flexfields

2. Onthe Manage Channel Descriptive Flexfields page, search for the Channel Document Line DFF as the name-
and click to edit it.

3. On the Edit Descriptive Flexfields: Channel Document Line DFF page, in the Global Segments section, click
Actions > Create to create a new Global Segment.

Field Value

Name Ship-to Country_Linedff

Code Ship-to Country_Linedff

API Name shipToCountryLinedff

Enabled Ensure the check box is selected
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4. Click Create Value Set.
5. On the Create Value Set page, enter the details, and save your work. For example:

Field Value

Value Set Code Country_Code

Description Country_Code

Module Channel Revenue Management
Validation Type Independent

Value Data Type Character

6. Inthe Definition section, enter the following details, and save your work. For example:

Field Value
Value Subtype Text
Maximum Length 15

7. Click Manage Values and ensure the values are enabled and save your work. For example:

Attribute Value Description Enabled
Value CAN Canada Selected
Value IND India Selected
Value USA United States of America Selected
Value ZMB Zambia Selected

Note: This attribute value should have been specified in the sales order and available in the imported CSV
file to qualify the program.

8. Return to the Create Segment page, enter the required details, and save your work. For example:

Section

Column Assignment
Column Assignment
Validation
Validation

Display Properties

ORACLE

Attribute

Data Type

Table Column

Value Set

Value Set Description

Prompt

Value

Character
ATTRIBUTE_CHAR2
Country_Code
Country_Code

Ship-to Country_Linedff
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Section Attribute Value
Display Properties Display Type List of Values

9. On the Manage Channel Descriptive Flexfields page, search for the Channel Document Line DFF, click Actions
and select Deploy Flexfield. Wait for the deployment dialog to indicate that deployment successfully finished,
then click OK

10. Verify your setup.

Download the Flexfield Archive and Obtain the View Object Details for the Channel
Document Line Descriptive Flexfields Context

1. From the Manage Channel Document Header Descriptive Flexfields page, select your flexfield.

2. From the Actions menu, select Download Flexfield Archive. Wait for the dialog to indicate that the archive
successfully finished, then click Download. Save the 10566_CIJM_DOCUMENT_LINE_DFF.zip file to your local
hard drive.

3. Open the file, extract and get the information for the context from the location:
10566_CIM_DOCUMENT_LINE_DFF.zip\oracle\apps\flex\scm\cjm\indirectSales\documentLineFlex\view

4. Open the XML file CjmDocumentLineDFFVO.xml for your flexfield to see the VO name. For example, name =
CjmDocumentLineDFFVO

5. You can also get the attribute name from the XML file. For example, ViewAttribute Name =
shipToCountryLinedff.

Manage Service Mapping Setup Using Sandbox After Identifying the Channel
Document Line Descriptive Flexfields

With the appropriate pricing administrator role, navigate to the Sandboxes page.

In the Navigator, Configuration, click Sandboxes.

On the Sandboxes page, click Create Sandbox.

On the Create Sandbox page, enter a name for the sandbox. For example, CR_Sandbox2.

Select the check box for the Manage Service Mappings tool, then click Create and Enter.

Navigate to the Pricing Administration work area, select Manage Service Mappings from the panel.

CUVAWNRA

Note: A yellow banner displays at the top of the page to indicate that you're in the sandbox.

7. On the Manage Service Mappings page, click Channel.

8. On the Edit Service Mapping: Channel page, click the Entities tab. You use the Entities tab to define the entity
and its attribute details that receives the output of the service mapping. On the Entities tab, click Actions > Add
Row, and enter the following details:

Field Value
Entity Name of your entity, for example, ShipToCountryLineDff_Custom.
Description A description containing information about the entity for the flexfield on the order header. For

example, ShipToCountryLineDff_Custom.
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9. In the Details section, add the following attributes, for example, and then save your work.

Attribute Type Primary Key Allow Null
DocumentLineld_Custom Long Selected Selected
ShipToCountryLineDff_Custom = Long Leave this blank Selected

10. To specify the services, click the Services tab, select ProgramEligibility.

11. In the ProgramEligibility: Details section, select the Entities tab, click Actions > Add Row, enter the following
values, for example, and then save your work.

Field Value

Entity ShipToCountryLineDff_Custom
Read Selected

Write Leave this blank

12. In the Entities section for the entity you created, add the following attributes, for example, and then save your

work.
Attribute Alias Read Write Parent Attribute
DocumentLineld_Custom Leave this blank Selected Leave this blank Leave this blank
ShipToCountryLineDff_ Leave this blank Selected Leave this blank Leave this blank
Custom

13. On the Edit Service Mappings: Channel page, select the Sources tab.

14. For each of the following sources, add the entity you created, and add the following details in the Entity
Mappings tab of the Details section:

Field Value

Source ChannelProgramsForCustomerDocument

Entity The name of the entity you created. For example, ShipToCountryLineDff_Custom.

Type View object

View Object The name of the view object. You retrieve this information from the downloaded flexfield

definition XML file. For example, CjmDocumentLineDFFVO

Query Type Join
Query Attribute DocumentLineld
Use Existing View Object Selected
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Field Value
Joined Entity Line
Joined Entity Attribute Lineld

In the details section of your entity, on the Attributes Mappings tab, enter the attributes of the entity you
created and the view object attributes from the XML file, for example:

Attribute View Object Attribute
DocumentLineld_Custom DocumentLineld
ShipToCountryLineDff_Custom shipToCountryLinedff

15. Click Save and Publish the sandbox. Once it is published, when the Eligibility REST is described, the attributes
should be visible in the payload.

Pricing Algorithm Setup

After any customizations you must update the changes in the Pricing algorithm and publish it.

1. From the Navigator, select Pricing Administration.

2. From the Tasks panel click Manage Algorithms. Select the algorithm for program eligibility, Get Eligible
Programs.

Note: You must create a new version of Get Eligible Programs to make changes and publish it. You cannot
modify published versions, for example, Version O and Version 1.

3. Inthe Algorithm tab, select Process Each Program Candidate > Expand Process Program Eligibility > Invoke
Program Eligibility Matrix. Add the following details below the Header data set row:

Field Value
Name Enter your custom entity name here. For example, ShipToCountryLineDff_Custom.
Variable Path Add the variable path to your custom entity here. For example,

EligibilityRequest.ShipToCountryLineDff_Custom.

Primary Leave this blank.

Cardinality Zero or one

Data Set Join [DocumentLineld_Custom:{Line.Lineld}]
Order By Leave this blank.

4. Verify your setup, save, and then click Actions and Publish to publish the algorithm.
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Adding Custom Dimension Based on DFF Setup
1. With the appropriate pricing administrator role, navigate to the Manage Matrix Classes page.
o Offering: Order Management
o Functional Area: Pricing Administration
o Task: Manage Matrix Classes

2. Click Channel Program Eligibility to select and edit it.
3. Click Actions > Add Row in the Condition Columns section and add a column, for example:

Field Value

Name Enter an entity name here. For example, Ship To Country.
Source Code Name Enter a value for example, SHIP_TO_COUNTRY_E.

Comparison =

Compare to Attribute ShipToCountryLineDff_Custom.ShipToCountryLineDff_Custom
Allow Null Selected

Null is Wildcard Selected

Domain Text

Adding the Lookup Code to the Channel Lookup

1. o With the appropriate channel role, navigate to the Setup and Maintenance page.

- Offering: Order Management

- Functional Area: Channel Revenue Management

- Task: Manage Channel Lookups
2. Onthe Manage Channel Lookups page, search for ORA_CIM_CUS_REBATE_QUAL as the Lookup Type.
3. Click Actions > New to add the following lookup code:

Field Value

Lookup Code Enter a name here. For example, SHIP_TO_COUNTRY.
Enabled Selected

Meaning Enter a description here. For example, Ship To Country.
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Oracle Fusion Order Management Integration

When creating or revising a sales order, eligible channel programs can be applied to the order line in the form of
incentives.

Channel program details are exposed in order management extension rules to write additional rules to control how
channel programs are applied and managed on the order.

Note:

- Channel Revenue Management supports Requested Ship Date as a qualifier. In the Sales Order page, the
Request Type is Ship On.

- Requested Arrival Date isn't supported as a qualifier. In the Sales Order page, the Request Type is Arrive On.

Related Topics
» Overview of Using Extensible Flexfields in Order Management
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4 Workflow Approvals and Notifications

Overview of BPM Workflow-based Approvals

With Business Process Management workflow, you can configure customer claim and program approval rules that the
application uses to process and route approvals to designated approvers.

BPM Workflow-based approvals are only available for customer claims and customer programs. Approvers receive
notifications to take action on customer claims or customer programs.

Use the approval rules to:

- Automate your approval business process

Improve business rules flexibility through:
o Serial and parallel routing

o Escalation

Facilitate approver actions to:
o Request for additional information, Approve, Reject

o Reassignment

Improve auditability with:
o Approval history

You can configure notifications to:

- Control when to send notifications to users involved with the task

Disable or enable in-app or email notifications, or both

Related Topics
» Configure Workflow Approvals and Notifications

Program Approvals

In this topic, you'll learn about how program approvals work with BPM Workflow.

If you've opted into the Approve Customer Programs with BPM Workflow feature, then configure program approval
rules through Business Process Management workflow to process and route to designated approvers.

When a customer program is submitted for approval, the application routes it to the designated approvers. If you are a
program approver, then you receive workflow notifications and emails when programs are submitted for approval. You
can configure process rules using predefined program attributes.

You can:

Manage Stuck Approvals using the Transaction Console:
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o View in-flight and completed approval processes using the keyword Customer Program.
o Terminate the approval process and move the program to Open status.
o Restart the approval process after correcting the approval rule.

- Submitted claim reverts to Draft status

o The submitted program will move from Approval Pending to Draft status if the approval task flow is in
error. This can happen if there are no active stages or participants.

« Program attributes in approval rules
o Program attributes used in approval rules must be prefixed by
Task.payload.getCustomerProgramResponse..

Understanding Status Transitions
Programs
Start Draft Active
Approval Terminated
Rejected
Approver
Approval Pending
Legend System Status User Action

- Submitted programs are created in Draft status.
- Programs are submitted for BPM based approvals move to an Approval Pending status.

- Submitted programs move from Approval Pending to Approval Rejected status if the program is rejected. You
can move Approval Rejected programs to Draft status using the Return to Draft action.

- Submitted programs move from Approval Pending to Active status if the progam is approved.

Active programs can be terminated, removing a program immediately from further accruals.

Claim Approvals

In this topic, you'll learn about how claim approvals work with BPM Workflow.

If you've opted into the Approve Customer Claims with BPM Workflow feature, then configure claim approval rules
through Business Process Management workflow to process and route to designated approvers. If you've not opted into
the feature, then the application uses privilege based approvals.

You can:

- Manage Stuck Approvals using the Transaction Console:
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o View in-flight and completed approval processes using the keyword Customer Claim.
o Terminate the approval process and move the claim to Open status.
o Restart the approval process after correcting the approval rule.

- Skip approvals

o If you settle a claim using only Open Deductions, Open Overpayments, or Open Credit Memos, then the
application skips the approval process and moves the claim directly from Open to Settlement Pending
status. This applies only if the Approve Customer Claims with BPM Workflow feature is opted in.

- Submitted claim reverts to Open status

o The submitted claim will move from Approval Pending to Open status if the approval task flow is in error.
This can happen if there are no active stages or participants.

- Settlement amount used for approval

o The settlement amount used for approval will not include the amount from Open Deductions, Open
Overpayments, and Open Credit Memos.

- Claim attributes in approval rules
o Claim attributes used in approval rules must be prefixed by Claim..

Configure Workflow Approvals and Notfications

The BPM Worklist enables you to configure claim and program approvals through a set of workflows.
Here are some examples of what you can do to configure workflow tasks, including notifications:

- Set how many levels of approval are needed for transactions over a particular amount

Define the assignees based on the following hierarchies:

o Supervisory hierarchy: Use this to create approval rules based on the supervisor hierarchy in Oracle
Human Capital Management Cloud. The approval process ascends the defined supervisor hierarchy.

o Position hierarchy: Use this to create approval rules based on the position hierarchy in Oracle Human
Capital Management Cloud. The approval process ascends the defined position hierarchy, starting at the
position level specified in the approval rule, and continuing until a sufficient position is found, based on
other conditions in the rule.

Reviewers can view the comments from the submitter in the approval notification.

- Create approval groups so that the workflow task can be assigned to the set of users in the group instead of an
individual user

- Control when to send notifications to users involved with the task
Disable or enable in-app or email notifications, or both

Here's a summary of the configuration tasks:

- Signin as a supply chain administrator.

- Opt into the Approve Customer Claims with BPM Workflow feature to use the BPM Workflow feature to approve
customer claims.

- Optinto the Approve Customer Programs with BPM Workflow to use the BPM Workflow feature to approve
programs.
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To access the BPM Worklist, run the Manage Task Configurations for Supply Chain Management task in the
Customers functional area as follows:
o For customer claims approvals, search for the ChannelCustomerClaimsApprovalTask.

o For program approvals, search for the ChannelCustomerProgramsApprovalTask.

- Update the workflow tasks by including details of deadlines and escalation policy.
- Select the notification type and provide additional details to configure the notification.
- Create approval groups that include a predefined set of users configured to act on the notification.

- Create approval rules that include conditions for approval.

Predefined Attributes Used in Program Approval Rules

Predefined attributes are provided for use in program approval rules.

The following table contains the list of predefined attributes used in program approval.

Attribute Prefixed by Description Sample Value
Task.payload.getCustomerProgramResponse..

accountedEstimatedAmount Indicates the estimated amount in the 3400
functional currency.

accountedLumpSumAmount Indicates the amount defined for the lump-sum
program in the functional currency. Applies only
to lump sum programs.

businessUnitld Value that uniquely identifies the business unit.  300100578911837

currencyCode Abbreviation that identifies the currency used uUsD
for the customer program.

estimatedAmount Indicates the estimated amount for the 3400
program.

functionalCurrencyCode Abbreviation that identifies the functional usb
currency.

lumpSumAmount Lump-sum program amount. Applies only to

lump sum programs.

pricingDateFrom Date from when the program is applicable. 2023-10-01

pricingDateTo Date until when the program is applicable. 2023-11-30

programld Value that uniquely identifies the customer 300100578945838
program.

programOwner Username of the user who created the PGM_MGR_109

customer program.

programTemplateCode Abbreviation that identifies the predefined CUSTOMER_REBATE
program template on which the customer
program is based. A list of accepted values
is defined in the lookup type ORA_CIM_
PROGRAM_TYPE.

130
ORACLE



SCM Cloud
Implementing Channel Revenue Management

Chapter 4
Workflow Approvals and Notifications

Attribute Prefixed by
Task.payload.getCustomerProgramResponse.

Description Sample Value

promotionCode Abbreviation that uniquely identifies the CREB39023
customer program.
submitterPositionld Value that uniquely identifies the position of 300100478945123

the submitter in HCM. The submitter must

be a HCM worker. This attribute is used for
setting up approval rules based on the position
hierarchy.

Predefined Attributes Used in Claim Approval Rules

Predefined attributes are provided for use in claim approval rules.

The following table contains the list of predefined attributes used in claim approval.

Attribute Description Sample Value
Claim.billToAccountNumber Number of the bill-to customer account. 1008
Claim.billToCountryCode Abbreviation that identifies the country for the = US

Claim.billToCustomer

bill-to address.

Name of the bill-to customer.

Seven Corporation

Claim.businessUnitld Value that uniquely identifies the business unit. 2304
Claim.claimCurrencyCode Abbreviation that identifies the currency used uUsD
for the channel claim.
Claim.claimDate Date when a claim is created. 2023-08-10
Claim.claimld Value that uniquely identifies the channel claim.. 300100578945838
Claim.claimNumber Number that indicates the customer claim. CLM37054
Claim.claimOwnerUsername Username of the user who created the claim. ANALYST109
Claim.claimReasonCode Abbreviation that identifies the channel claim SHIPPING
reason.
Claim.claimSalespersonNumber Value that uniquely identifies the claim's
salesperson.
Claim.claimSourceCode Abbreviation that identifies the claim source. CLAIM
Claim.claimTypeCode Abbreviation that identifies the channel claim DAMAGES
type.
Claim.functionalCurrencyCode Abbreviation that identifies the functional uUsD
currency.
Claim.invoiceSalespersonNumber Value that uniquely identifies the claim 49032

ORACLE

salesperson associated with the invoice.
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Attribute

Claim.settlementAmount

Claim.settlementMethod

Claim.settlementMethodCode

Claim.settlementTypeCode

Claim.shipToCountryCode

Claim.shipToCustomerld

Claim.submittedBy

Claim.submitterPositionld

Claim.Task.Creator

Description

Amount associated with the settlement
method. It doesn't include the amount from
Open Deductions, Open Overpayments, or
Open Credit Memos.

The name of the payment method used to
settle the claim.

Abbreviation that identifies the payment
method used to settle the claim.

Abbreviation that identifies the settlement type
selected to settle the claim.

Abbreviation that identifies the country for the
ship-to address.

Value that uniquely identifies the ship-to
customer.

Username of the claim submitter.

Value that uniquely identifies the position of
the submitter in HCM. The submitter must

be a HCM worker. This attribute is used for
setting up approval rules based on the position
hierarchy.

Username of the user submitting the claim.

Chapter 4
Workflow Approvals and Notifications

Sample Value

935.32

Credit Memo

CM_ON_ACCOUNT

ORA_NON_PROMOTIONAL

us

1008

ANALYST109

300100578945848

ANALYST109

Migrate Pending Approvals to BPM Workflow

The Migrate Pending Approvals to BPM Workflow scheduled process to enable BPM workflow-based approvals for
channel entities in pending approval status.

If there are claims in Approval Pending status when you opt in to the Approve Customer Claims with BPM Workflow
feature, then the claims for the netting use cases are considered as approved and moved to Settlement Pending status.
This means that when you settle a using only Open Deductions, Open Overpayments, or Open Credit Memos, then

these claims are considered approved and moved to settlement pending status.

Parameter

Migrate Customer Claims

ORACLE

Description

Select a value from the list to decide whether to

migrate customer claims. By default, this is No.

Select Yes to run the scheduled process. If there

are no claims in approval pending status, then
no claims will be processed.

Required

No

132



SCM Cloud Chapter 5
Implementing Channel Revenue Management Set Up Channel Settings

5 Set Up Channel Settings

Manage Channel Settings

Use the Manage Settings page to review and update values for the predefined Channel Revenue Management settings.
You can't create a new setting, or delete existing ones. You can update them based on your business needs.

In the Setup and Maintenance work area, go to:

- Offering: Order Management/Procurement
- Functional Area: Channel Revenue Management/Supplier Incentives

- Task: Manage Channel Settings

Note: Some of these settings are required tasks.

Category Setting Description Required

Assighment Claim Owner Use this setting to assign a claim No, but recommended.
owner for your claims at the BU
level.

Note: The value you add in this
setting is used as the default

if you haven't configured the
Customer Trade Profile or the
Supplier Trade Profile. However,
itis recommend that you
configure the owner for the
Customer Trade Profile and the
Supplier Trade Profile.

To create a new assignment:

1. Inthe Assignment - Claim
Owner: Values section, click
the Add icon.

2. From the list, select the
Business Unit for which you
want to assign a claim owner.
You can see only the BUs you
have access to.

3. Select the Claim Owner from
the list.

4. Enter a Value Code. This acts
as a unique identifier for the
setting, and is required.

5. Click Save.
Customer Channel Calendar Specify the calendar used Yes, for Customer Annual Volume
to determine the periods for Programs

customer channel processing.
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Category

Customer Channel

Customer Claim

Customer Claim

Customer Claim

Customer Claim

Customer Claim

Customer Claim

Customer Claim

Manage Claims

ORACLE

Setting

Catalog

Automatically Include Programs
with Zero Balances

Automatically Show Available
Programs to Associate

Override Threshold

Pay Over Earnings

Settlement Type

Threshold Type

Threshold Value

Aging Method for Filtering

Description

Specify the catalog created in
Oracle Fusion Product Information
Management for customer channel
processing.

Use this setting to specify whether
programs with zero balances
should be displayed for accrual
association. By default, this is set
to Yes and programs with zero
balances and programs without
accruals (in case pay over is
enabled) are displayed for accrual
association. No indicates that
programs with zero balances and
programs without accruals (in
case pay-over is enabled) aren't
displayed for accrual association.

By default, programs available
to be associated are displayed.
Change this setting if you don't
want to display the programs
available for association.

Use this setting to specify whether
threshold values for pay over
earnings can be overridden.

Use this setting to specify whether
payments are allowed to exceed
program earnings.

Use this setting to choose the
default settlement type. You can
choose between Promotional and
Nonpromotional.

Use this setting to choose the
threshold type for pay over
earnings.

Use this setting to choose the
threshold value for pay over
earnings.

Use this setting to select the aging
bucket that should be used to filter
claims at your site. Aging Methods
can be created in Receivables using
the task: Manage Aging Methods.

Chapter 5
Set Up Channel Settings

Required

Yes, for Customer Annual Volume
Programs

Yes for Customer Promotion
Programs.

Yes for Customer Promotion
Programs.

Yes for Customer Promotion

Programs.

Yes for Customer Promotion
Programs.

Yes, for Deductions and Settlement
and Customer Promotion
Programs.

Yes for Customer Promotion
Programs.

Yes for Customer Promotion
Programs.

Yes, for Deductions and Settlement
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Category Setting

Settlement by Credit Memo - On Credit Method for Accounting
Invoice Rules

Settlement by Credit Memo - On Credit Method for Installments

Invoice

ORACLE
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Description Required
Note:

You can select only one aging

method, and it must belong to

the Common Set.

If you don't configure the aging
method, Manage Claims page
won't have the capability to filter
by age.

Use this setting to select the Yes, for Deductions and Settlement
receivables method that must be

used to reverse accounting entries

for the settlement method Credit

Memo - On Invoice, if accounting

rules are used in the original

invoice.

1. In the Settlement by Credit
Memo - On Invoice - Credit
Method for Accounting Rules:
Values section, select a value
from the Credit Method for
Accounting Rules list.

LIFO: Last In First Out. Starts
from the last accounting
period and reverses all prior
periods till the credit memo is
used up.

Prorate: Credits an equal
percentage to all the account
assignments for the invoice.
This is the value which is
enabled by default.

Unit: Reverses revenue for the
number of units specified in
the original invoice line.

2. The Value Codeis SITE, as
this is a site level setting.

3. Click Save.
Use this setting to select the Yes, for Deductions and Settlement
receivables method that must be
used to credit installments for the
settlement method Credit Memo
- On Invoice, if there are multiple
installments in the original invoice.

1. In the Settlement by Credit
Memo - On Invoice - Credit
Method for Installments:
Values section, select a value
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Category Setting Description Required

from the Credit Method for
Installments list.

FIFO: First in First Out. Credits
the first installment first.

LIFO: Last In First Out. Credits
the last installment first.

Prorate: Credit the
installments of the credited
transactions and prorate
them based on the amount
remaining for each
installment. This is the value
which is enabled by default.

2. The Value Code is SITE, as
this is a site level setting.

3. Click Save.

Settlement by Write-off Deduction Threshold Use this setting to set the threshold Yes, for Deductions and Settlement
amount for your deduction write-
offs.

1. In the Settlement by Write-
off - Deduction Threshold:
Values section, click the Add
icon.

2. From the list, select the
Business Unit for which
you're setting up the write-off
threshold. You can see only
the BUs you have access to.

3. Enter the threshold amount
in the Deduction Threshold
field. This is in the ledger
currency of the BU you
selected.

4. Enter a Value Code. This acts
as a unique identifier for the
setting, and is required.

5. Click Save.

Note:

ORACLE

When you update the threshold
amount, there's no impact on
existing deductions which are
already eligible for write-offs.

The write-off threshold
amount in Channel Revenue
Management must be between
the From Write-off Limit

per Receipt and To Write-

off Limit per Receipt in the
Receivables System Options
page > Cash Processing tab for
the corresponding BU.
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Category Setting

Settlement by Write-off Receivables Activity for Receipt

Write-Offs

Settlement by Write-off Receivables Activity for Write-Off

Adjustment

Settlement by Write-off Write-off Reviewer

ORACLE
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Description Required

Use this setting to select the Yes, for Deductions and Settlement
receivables activity that should be
used for receipt write-offs for non-

invoice related deductions.

1. In the Settlement by Write-
off - Receivables Activity for
Receipt Write-Offs: Values
section, click the Add icon.

2. From the list, select the
Business Unit for which
you're setting up the write-
off. You can see only the BUs
you have access to.

3. Select the Receivables
Activity from the list.

4. Enter a Value Code. This acts
as a unique identifier for the
setting, and is required.

5. Click Save.
Use this setting to select the Yes, for Deductions and Settlement
receivables activity that should be
used for write-off adjustments for
invoice related deductions.

1. In the Settlement by Write-
off - Receivables Activity for
Write-Off Adjustment: Values
section, click the Add icon.

2. From the list, select the
Business Unit for which
you're setting up write-offs.
You can see only the BUs you
have access to.

3. Select the Receivables
Activity from the list.

4. Enter a Value Code. This acts
as a unique identifier for the
setting, and is required.

5. Click Save.

Use this setting to select the claim = No.
owner who must review the write-

offs for your business unit.
Note: If you use Redwood, then

1. In the Settlement by Write-off this setting isn't applicable.

- Write-Off Reviewer: Values
section, click the Add icon.

2. From the list, select the
Business Unit for which
you're setting up the write-
off. You can see only the BUs
you have access to.

3. Select the reviewer from the
Write-Off Reviewer list.

4. Enter a Value Code. This acts
as a unique identifier for the
setting, and is required.
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Category Setting

Supplier Program Calendar Calendar for Accrual Calculation
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Description Required

5. Click Save.

Use this setting to specify the
calendar period used to associate
supplier annual program accruals
based on your fiscal periods.

Yes, for Supplier Annual Programs

Tip:

Don't define a calendar based
your fiscal periods. Typically a
January to December calendar
is used to communicate with all
your suppliers.

Tip:

The CSV import will fail if the
invoice date of the supplier
invoice can't find a matching
period. Don't forget to open
periods for a new year.

CAUTION:

You won't be able to update
or disable the setting after it's
saved.

Recommendation: Start your
Period Name with the year.

Use this setting to specify the
event that triggers the creation of
supplier rebate accruals.

Yes, for Supplier Rebate

1. Inthe Supplier Rebate - Event
for Triggering Supplier Rebate
Accrual: Values section, click
the Add icon.

2. From the list, select the
Business Unit for which
you're setting up the
triggering event. You can see
only the BUs you have access
to.

3. Select the triggering
event from the Event for
Triggering Supplier Rebate
Accrual list.

Receiving Transaction:
Supplier rebate accruals
are created after the PO is
received.

Supplier Invoice: Supplier
rebate accruals are created
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Category Setting Description Required

only after the PO is received
and invoiced.

4. Enter a Value Code. This acts
as a unique identifier for the
setting, and is required.

5. Click Save.

Note:

An important deployment best
practices for supplier rebates

is determining when to trigger
the posting of accruals. The best
practice approach is that most
organizations should trigger
the posting of accruals upon
the receipt of a supplier invoice
for received goods, because
this validates that the received
goods weren't delivered in error,
and there is no doubt with an
invoice number which received
goods are being accrued and
claimed.

Note: After saving a setting, you can't delete it. You can only disable it, by deselecting the Enable check box.

Manage Aging Methods

Aging methods aid in the timely and efficient resolution of deductions. Claim age is calculated based on days from
claim creation to resolution. Use the Manage Aging Methods page to create or update your aging methods. This must
belong to the common set.

In the Setup and Maintenance work area, go to:
- Offering: Order Management
» Functional Area: Channel Revenue Management
- Task: Manage Aging Methods
How Age is Calculated for a Claim
« For Open Claims
Age = System Date - Claim Date +1

- For Resolved Claims
Age = Resolved Date - Claim Date + 1

Related Topics
- Aging Methods
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How to Set Up Write-offs

Investigating deductions can be time intensive and often not cost effective for smaller deductions. By configuring
thresholds at the business unit, customer, account, and bill-to site levels, automatic write offs can process eligible claims
without any human intervention.

After claim investigation of a deduction or invoice deduction, a claim analyst with the correct privileges can manually
write off any amount because it will go through approvals.

You must also configure receivables activity used in the creation of the receipt write-off or of write-off adjustment in AR.
For invoice deductions, you settle as a write-off adjustment. For deductions, you settle as a receipt write-off.

Write-off Type Thresholds Approvals Receivables Activity for Receivables Activity for
Receipt Write Off Write-Off Adjustment
Automatic Set at: N/A Set at: Set at:
Business Unit - in - Business Unit - in - Business Unit - in
Channel Settings Channel Settings Channel Settings

Party - in Customer
Trade Profile

Account - in Customer
Trade Profile

Bill-to Site - in
Customer Trade
Profile
Manual (requires the N/A Required Set at: Set at:
claim analyst to have the - Business Unit - in - Business Unit - in
p;Vl)lege to do manual write Channel Settings Channel Settings
offs
Claim Type - in - Claim Type - in
Manage Channel Manage Channel
Claim Types Claim Types

How to Configure Deduction Claims for Write-Off

You can configure deduction claims to be written off using the following settings:

- From the Manage Channel Settings page, set up the following at the business unit level:
o Deduction Threshold

o Receivables Activity for Receipt Write-offs
o Receivables Activity for Write-off Adjustment
o Write-off Reviewer

Note: If you use Redwood, then this setting isn't applicable.

If the claim amount is less than or same as the threshold amount, and a reviewer is selected, then this
reviewer is assigned the claim, as the claim owner. The claim is created in the Open status.
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If the write-off reviewer isn't enabled, and the deduction amount is less than or same as the threshold
amount, then the claim is created directly in the Settlement Pending status.

From the Manage Claim Types page, you can set up a default receivables activity for receipt write-off and
for write-off adjustment for a business unit and claim type when writing off customer claims. This mapping

enables you to standardize write-off accounting for a set of claim types.

If the receivables activity isn’t specified for the claim type, then the value is defaulted from the business unit.

Related Topics
« Manage Supplier Claim Types

- Write-offs and Receipts
« Create Customer Trade Profiles
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6 Set Up User Statuses

User Statuses

Claims and Programs have predefined statuses based on their various stages. In addition to this, you can create user-
defined statuses based on your business needs.

For example, you might want a review of a program that's pending for approval from another department. You can use a
user status to indicate the same.

Manage User Statuses

You can use the Manage User Statuses page to create and update user-defined statuses for program and claim
statuses. Each system status comes with a predefined user status. Make sure you minimally update the description and
change the user status name, if necessary. You can create new statuses based on additional business needs.

1. Inthe Setup and Maintenance work area, go to:

o Offering: Order Management/Procurement
o Functional Area: Channel Revenue Management/Supplier Incentives
o Task: Manage Channel User Statuses

2. Onthe Manage User Statuses page, click the Add icon to create a new user status.

Note: You can have multiple user statuses for each system status.

w

Enter a code for your user status in the User Status Code field. This code:

o Acts as a unique identifier for the user status, and is required.
o Is used to identify and synchronize setup data across multiple environments.
o Is not available to users in the transactional pages.

4. From the User Status For drop-down list, select either Claim or Program.

5. Use the Buy Side and Sell Side check boxes to select the channel flows for which you want the user status
enabled. You can't update this after saving the user status.

6. Enter the name of your user status in the User Status field.
7. From the System Status drop-down list, select the system status for which you're creating this user status.

8. Select the Buy-side Default check box if you want to make this user status the default for the selected system
status for buy side channel flows. Select the Sell-side Default check box if you want to make this user status
the default for the selected system status for sell side channel flows. For every system status, there must be one
default user status.

9. Select the Enable check box to enable the user status.
10. Enter values for the remaining fields, if required. Click Save.

Note: Once saved, you can't delete a user status. You can only disable it.
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7 Set Up Sell Side Programs

Setting Up Customer Programs

A customer program is used to define a channel agreement between the manufacturer, distributor, or wholesaler and
their channel customers.

Customer Programs encompass Customer Annual Co-op Programs, Customer Annual Volume Programs, Customer
Promotion Programs, Customer Volume Programs, and Customer Lump Sum Programs.

Program managers can negotiate customer promotions and create programs.

Delivered program templates represent supported channel business processes. The purpose of a program type is to
model the enterprise’s channel business requirements by configuring features of a program type based on a program
template.

The program type controls and simplifies the program creation. When a program manager creates a program, the
identification of a program type is required and this will drive how a program is created, applied, and processed.

Related Topics
« Predefined Customer Program Templates

Set Up Customer Program Qualifiers

Here you'll understand how to set up customer program qualifiers.

Quialifiers are attributes used to define eligibility in the form of customer, additional conditions, and product rules in a
channel program. Only those qualifiers that are part of the program type can be selected in the program. That is, you
have to select the qualifiers during program type creation, and only these are available for selection in the programs.
If you need a new qualifier type to be available in the program, you must first add that qualifier in the corresponding
program type.

Related Topics
« How to Set Up Custom Quialifiers Based on Order Header Extensible Flexfields

« How to Set Up Custom Quialifiers Based on Order Line Extensible Flexfields
« How to Set Up Custom Quialifiers Based on Sales Invoice Header Descriptive Flexfields
« How to Set Up Custom Quialifiers Based on Sales Invoice Line Descriptive Flexfields
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How to Add User-Defined Attributes to ltems

You can create user-defined attributes that can be used in the program product rules to identify eligible products
beyond predefined rules.

You must set it up as an item extensible attribute in an item class to represent details about the item.

Create an Attribute Group and Attributes
1. With roles allowing access, in the Setup and Maintenance work area, go to:
o Offering: Product Management
o Functional Area: Items
o Task: Manage Item Attribute Groups and Attributes

2. Inthe Manage Attribute Groups page, from the Actions drop-down button, click Create to create an attribute

group.
3. Inthe Create Attribute Group page, enter the details for the following fields:

Field Description
Display Name Enter a display name for the attribute group. For example, Item Color.
Internal Name Enter an internal reference name. For example, Item Color Specification.
API Name Automatically populated, edit if required.
Behavior Select Single Row from the list.
4. Onthe Context Usages tab, select Create from the Actions drop-down list.
5. Select Item from the Name list as the context usage. Click Save. This creates the attributes group with context
usage as Item.
6. In the Edit Attributes page, in the Attributes section, click Create from the Actions drop-down button.
7. Inthe Create Attribute page, enter the details for the following required fields:
Field Description
Display Name Enter a display name for the attribute. For example, Color.
Internal Name Enter an internal reference name. For example, Product Color.
APl Name Automatically populated, edit if required.
Data Type Select the data type of the attribute. For example, for color select Character.
Table Column Automatically populated, edit if required.

8. Select a Value Set from the list, or create one by clicking Create Value Set.
If you're creating a value set, in the Create Value Set page, enter the details for the following fields:

146
ORACLE



SCM Cloud Chapter 7
Implementing Channel Revenue Management Set Up Sell Side Programs

o Enter a code for your value set. For example, PRODUCT_COLOR.
o Enter a description to for the value set. For example, Value set for product colors.
o Select Product Model from the Module list.

o Select a Validation Type. You must select Independent or Format Only for each item extensible attribute
that you plan to use with Pricing.

o Select the data type of your value set from the Value Data Type list. You must select either Number or
Character for the data type. Other data types aren't supported.

o Inthe Definition section, enter the required details and save.
o Click Manage Values to add the values for the value set.
o Inthe Manage Values page, Click Create from the Actions drop-down button.
o Add the values you want for your value set. For example, different product colors like blue, red, and so on.
o Click Save and Close to navigate back to the Create Attributes page.
9. Inthe Create Attributes page, the Display Properties are now populated. You can edit this if required.
o Prompt: The prompt for your attribute. For example, Color.
o Display Type: How the values should be displayed. For example, List of Values.

10. Click Save and Close. The attribute for the attribute group is saved, and you're now on the Edit Attribute Group
page. You can create more attributes for this group if required. Note down the flexfield code and save.

Add the Attribute Group to an Item Class

1. With roles allowing access, in the Setup and Maintenance work area, go to:
o Offering: Product Management

o Functional Area: Items
o Task: Manage Item Classes

2. Inthe Manage Item Classes page, select the Item Class under which you want to add the attribute group and its
attributes as extensible attributes. You can select the Root Item Class to add the attribute group to all the item
classes.

3. Inthe Edit Item Class page, click Pages and Attribute Groups tab. On the Attribute Groups subtab, from the
Actions drop-down button, click Select and Add.

4. Select your attribute group and click Apply, then click OK. Click Save to save the updates to the item class.

5. Navigate to the Pages subtab. Select Pricing Item Attributes. If it's not available, add it. See the Add Your
Attribute Group to An Item Class section in the Add Your Own Attributes to Items in Pricing topic from the
Pricing Administration guide.

6. In the Attributes Group: Pricing Item Attributes section, click Select and Add from the Actions drop-down
button. Select your attribute group. Click Apply, then OK. Click Save to save the updates to the item class.

7. Navigate to the Functional ltem Pages subtab and ensure that the following is available:
o Functional Area: Pricing

o Usage: Pricing
o Item page: Pricing Item Attributes

The attribute group is added to the item classes.
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Deploy the Item Extensible Flexfield

After associating the attribute groups to the item classes, you must deploy the extensible flexfield.

1. With roles allowing access, in the Setup and Maintenance work area, go to:
o Offering: Product Management

o Functional Area: Items
o Task: Deploy Item Extensible Flexfields

2. Search for your flexfield code. Select it and click Deploy Flexfield.
3. After successful deployment, you must sign out and sign back in to view the EFF configuration on the item.

Edit the Pricing Matrix Class

You must now add the item attribute to the Pricing Matrix Class.

1. With roles allowing access, from the Navigator, select Pricing Administration. In the Overview page, open the
Tasks panel and select Manage Matrix Classes.

2. Inthe Manage Matrix Classes pages, select Channel Program Eligibility.

3. Inthe Edit Matrix Classes page, click Add Row from the Actions drop-down list. This creates a new dimension
to Channel Program Eligibility.

4. Inthe Name field, enter a name for your dimension. For example, Color.

5. Inthe Source Code Name field, enter a code concatenated with the operator abbreviation. The supported

operator abbreviations are E for equal to, NE for not equal to, EGT for greater than or equal to, and ELT for less

than or equal to. For example, COLOR_E.

In the Comparison field, choose the comparison operator. For example, =.

7. From the Compare to Attribute drop-down list, select one of the following. You must select the same data type
that you specified when you set up the attribute on the Manage Item Attribute Groups and Attributes page. If
the data types don't match, then the eligibility rules won't work correctly.

o itemExtensibleAttribute.VarcharValue

o

o itemExtensibleAttribute.NumberValue

8. Leave the Required check box deselected. Select the Allow Null and Null Is Wildcard check boxes.
9. From the Domain list, select:
o Domain Type: Item Extensible Attribute

o Data Type: Select the same data type that you specified when you set up the attribute on the Manage
ltem Attribute Groups and Attributes page
o Attribute: Select the attribute you created in the Manage Item Attribute Groups and Attributes page.

o Attribute Group Identifier: temExtensibleAttribute.AttributeGroupCode (default value)
o Attribute Identifier: temExtensibleAttribute.AttributeCode (default value)

10. Leave the Default Value field blank as it's not used. Click OK.
11. Click Save.

Update Channel Lookup
1. In the Setup and Maintenance work area, go to:
o Offering: Order Management/Procurement
o Functional Area: Channel Revenue Management/Supplier Incentives
o Task: Manage Channel Lookups
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2. Search for the extensible lookup: ORA_CIM_CUST_PROG_ITEM_LEVEL and add a new lookup code.

3. Inthe Lookup Code field, enter the same name as the Source Code Name used for Channel Program Eligibility
matrix class (without the concatenated operator). For example, if the Source Code Name in the matrix class is
COLOR_E, then enter COLOR as the lookup code.

4. Enter values for the remaining fields and click Save.

Note: For more information about creating extensible flexfields, see User Defined Attribute Groups and Attributes
(Extensible Flexfields-EFFs) Setup White Paper (Doc ID 1992317.1) on My Oracle Support at https://support.oracle.com.

Set Up Program Types

Predefined Customer Program Templates

Predefined program templates represent supported channel flows.
You must select a program template when creating a program type. Templates supported are:
« Customer Annual Co-op
-« Customer Annual Volume
» Customer Promotion
- Customer Volume

« Customer Lump Sum

Promotion Code Numbering
The promotion code is made up of a prefix and a single sequence. Prefix is defined by the program type. The predefined

prefixes are:
« Customer Annual Co-op - COOP
« Customer Annual Volume - CAV
» Customer Promotion - CREB
« Customer Volume - CVOL
« Customer Lump Sum - CLUM

A single sequence generates numbers from a given starting number stored in the database. This single sequence is
across all programs.

Note: If you prefer, you can configure your own prefix for a program type. A prefix can be shared across multiple
program types if so determined.
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Manage Program Types

The purpose of a program type is to model the enterprise’s channel business requirements by configuring features of a
program type based on a program template.

The program type controls and simplifies the program creation. When a program manager creates a program, the
identification of a program type is required and this drives how a program is created, applied, and processed.

Use configurable program types to create programs.

Program Type for Customer Annual Co-op Programs

The customer annual co-op template supports different date contexts, such as actual ship date, invoice date, order
date, requested arrival date, and requested shipped date. You can define product eligibility by item, category, or for all
items. Product eligibility supports exclusions by item or category. Specify discount type for product rules in terms of the
percentage or the amount per unit. The program applies to all customers, and rebates are defined for each product rule.
Eligible sales are obtained from sales orders, which are imported through a CSV file.

You can create and update customer annual co-op program types from the Manage Program Types page.

1. In the Setup and Maintenance work area, go to:
o Offering: Order Management
o Functional area: Channel Revenue Management
o Task: Manage Channel Program Types
2. Onthe Manage Program Types page you can create and update your program types. Click the Create icon. The
Create Program Type page appears.
3. From the Based on Predefined Program Template list, select Customer Annual Co-op.
Enter a name for your program type in the Name field.
5. Enter a code for your program type in the Program Type Code field. This code:
o Acts as a unique identifier for the program type.

>

o Is used to synchronize setup data across multiple environments.
o Isn’t available to users in the transactional pages.

6. Update the Prefix field if required. This value acts as the prefix for your Promotion Code while creating a
program. The predefined prefix for the customer volume program template is COOP.

7. On the Features tab, select the Enable program beneficiary check box to specify an alternate beneficiary to
whom the accrued earnings will be paid. The beneficiary can be different from the eligible customer on the
sales transaction. Alternate beneficiaries are defined within the context of a program and must be a customer.
Enable this check box for a royalty program type.

8. On the Quialifiers tab, select the applicable date contexts for your programs. From the Qualify Programs Based
On list of values select either:

o - Invoice Date: If you select this, then the programs are qualified by matching them against the
invoice date.

Note: It is recommended that you use this qualifier for Customer Annual Volume and Customer
Annual Co-op programs.

- Actual Ship Date: If you select this, then the channel programs created with this program type are
qualified by matching them against the actual ship date.
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- Order Date: If you select this, the programs are qualified by matching them against the order date.

- Requested Arrival Date: If you select this, the programs are qualified by matching them against
the requested arrival date.
- Requested Ship Date: If you select this, the programs are qualified by matching them against the
requested ship date.
9. On the Accrual Calculation tab, specify the pricing charge definition that Pricing associates with an item. Select
a pricing basis for discount types from the following:
o Unit List Price: If you select this, then you offer a discount on the unit list price of the item.

o Unit Selling Price: If you select this, then you offer a discount on the unit selling price of the item.

Note: If you select Unit List Price, then you must ensure that the Unit List Price is specified in the sales
transaction CSV file. The Unit Selling Price is mandatory in the sales transaction.

10. On the Optional Defaulting tab, specify the defaults for your programs.
o Default Program Currency To: Select the default currency for your program from the list of values. For
example, US Dollar.
o Default Discount Type for Product Rules To: Select the default discount type for your product rule from
the list of values. Available values are Amountand Percent.

11. Click Save and Close. The program type is created in the Draftstatus.

Program Type for Customer Annual Volume Programs
The annual volume program template supports aggregation and tracking of cumulative sales revenue or quantity across
orders for a specified period.

This program type enables you to calculate retrospective volume rebates on a periodic basis. Ensure you have set up a
Catalog under Customer Claims from the Manage Settings page.

You can create and update customer annual volume program types from the Manage Program Types page.

1. In the Setup and Maintenance work area, go to:
o Offering: Order Management
o Functional Area: Channel Revenue Management
o Task: Manage Channel Program Types
2. On the Manage Program Types page you can create and update your program types. Click the Create icon. The
Create Program Type page appears.
3. From the Based on Predefined Program Template list, select Customer Annual Volume.
Enter a name for your program type in the Name field.
5. Enter a code for your program type in the Program Type Code field. This code:
o Acts as a unique identifier for the program type.

>

o Is used to synchronize setup data across multiple environments.
o Isn’t available to users in the transactional pages.

6. The Prefix field is automatically populated when you select the program template. This value acts as the prefix
for your Promotion Code while creating a program. The predefined prefix for the customer annual volume
program template is CAV.

7. On the Qualifiers tab, specify the applicable date contexts for programs and select the Default check box. The
date contexts are:

o Invoice Date: If you select this, then the programs are qualified by matching them against the invoice
date.
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Note: It is recommended that you use this qualifier for Customer Annual Volume and Customer
Annual Co-op programs.

o Actual Ship Date: If you select this, then the channel programs created with this program type are
qualified by matching them against the actual ship date.

o Order Date: If you select this, the programs are qualified by matching them against the order date.

o Requested Arrival Date: If you select this, the programs are qualified by matching them against the
requested arrival date.

o Requested Ship Date: If you select this, the programs are qualified by matching them against the
requested ship date.
8. On the Accrual Calculation tab, specify the pricing charge definition that Pricing associates with an item. Select
a pricing basis for discount types from the following:
o Unit List Price: If you select this, then you offer a discount on the unit list price of the item.

o Unit Selling Price: If you select this, then you offer a discount on the unit selling price of the item.

Note: If you select Unit List Price, then you must ensure that the Unit List Price is specified in the sales
transaction CSV file. The Unit Selling Price is mandatory in the sales transaction.

9. On the Optional Defaulting tab, select the default for your programs. You can set the currency and calculation
method to be used during program creation and also specify the default tier to be used during discount rule
creation.

o Default Program Currency To: Select the default currency for your program from the list of values. For
example, US Dollar.
o Default Calculation Method To: By default, this is set to Retrospective.

o Default Tier Type: Select the default tier type from the list of values to be used during creation of
discount rules. Available values are Quantity and Sales.
10. From the Actions menu, select Activate to active the annual volume program type.

Program Type for Customer Promotion Programs

The customer promotion template supports different date contexts and customer eligibility based on the customer, bill-
to, or ship-to qualifiers. Additional conditions may be based on order type, order line type, warehouse, or salesperson
qualifiers. Specify product rebates in terms of the percentage or the amount per unit.

A program type can restrict the date contexts, selection of qualifiers, or the type of rebates available to simplify program
creation.

You can create and update customer promotion program types from the Manage Program Types page.

1. In the Setup and Maintenance work area, go to:
o Offering: Order Management

o Functional area: Channel Revenue Management
o Task: Manage Channel Program Types

Click the Create icon to open the Create Program Type page.
Select Customer Promotion from the Based on Predefined Program Template list of values.
Enter a name for your program type in the Name field.
Enter a code for your program type in the Program Type Code field. This code:
o Acts as a unique identifier for the program type.

uihWN

o Is used to synchronize setup data across multiple environments.
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o Isn’t available to users in the transactional pages.
6. Update the Prefix field if required. This value acts as the prefix for your Promotion Code while creating a
program. The predefined prefix for the customer promotion template is CREB.

7. Select the Enable program beneficiary check box to specify an alternate beneficiary to whom the accrued
earnings will be paid. The beneficiary can be different from the eligible customer on the sales transaction.
Alternate beneficiaries are defined within the context of a program, and must be a customer. Enable this check
box for a royalty program type.

8. On the Qualifiers tab:

a. Select the applicable date contexts for your programs. From the Qualify Programs Based On list of
values select either:

- Actual Ship Date: If you select this, then the channel programs created with this program type are
qualified by matching them against the actual ship date.

- Invoice Date: If you select this, then the programs are qualified by matching them against the
invoice date.

- Order Date: If you select this, the programs are qualified by matching them against the order date.

- Requested Arrival Date: If you select this, the programs are qualified by matching them against
the requested arrival date.

- Requested Ship Date: If you select this, the programs are qualified by matching them against the
requested ship date.

b. Add the qualifiers you want for your customer and additional conditions rules. The values in the list of
values are from the lookup ORA_CIJM_CUST_REBATE_QUAL.

9. On the Accrual Calculation tab, specify the pricing charge definition that Pricing associates with an item. Select
a pricing basis for discount types. You can choose between Unit List Price and Unit Selling Price. If you select
Unit List Price, then you must ensure that the Unit List Price is specified in the sales transaction CSV file. The
Unit Selling Price is mandatory in the sales transaction.

10. On the Optional Defaulting tab, specify the defaults for your programs.

o Default Program Currency To: Select the default currency for your program from the list of values. For
example, US Dollar.

o Default Discount Type for Product Rules To: Select the default discount type for your product rule from
the list of values. Available values are Amount and Percent.

11. Click Save. The program type is created in the Draft status.

Program Type for Customer Volume Programs

With the customer volume template, you can define percentage rebates based on sales value attainment tiers or
amount per unit rebates based on sold quantity attainment tiers. The program supports retrospective and stepped
calculations, and you can define product eligibility by item or for all items with exclusions. Eligible sales are obtained
from sales orders, which are imported through a CSV file.

You can create and update customer volume program types from the Manage Program Types page.

1. In the Setup and Maintenance work area, go to:
o Offering: Order Management

o Functional area: Channel Revenue Management
o Task: Manage Channel Program Types

Click the Create icon to open the Create Program Type page.

From the Based on Predefined Program Template list, select Customer Volume.
Enter a name for your program type in the Name field.

Enter a code for your program type in the Program Type Code field. This code:

A WN
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o Acts as a unique identifier for the program type.
o Is used to synchronize setup data across multiple environments.
o Isn’t available to users in the transactional pages.

6. The Prefix field is automatically populated when you select the program template. This value acts as the prefix
for your Promotion Code while creating a program. The predefined prefix for the customer volume program
template is CVOL.

7. On the Features tab, Select the Enable program beneficiary check box to specify an alternate beneficiary to
whom the accrued earnings will be paid. The beneficiary can be different from the eligible customer on the
sales transaction. Alternate beneficiaries are defined within the context of a program and must be a customer.
Enable this check box for a royalty program type.

8. On the Quialifiers tab:

a. Specify the applicable date contexts for programs from the Qualify Programs Based On list and select
the Default check box. The date contexts are:
- Actual Ship Date: If you select this, then the channel programs created with this program type are
qualified by matching them against the actual ship date.
- Invoice Date: If you select this, then the programs are qualified by matching them against the
invoice date.
- Order Date: If you select this, the programs are qualified by matching them against the order date.
- Requested Arrival Date: If you select this, the programs are qualified by matching them against
the requested arrival date.
- Requested Ship Date: If you select this, the programs are qualified by matching them against the
requested ship date.
b. Add the qualifiers you want for your customer and additional conditions rules. The values in the list of
values are from the lookup ORA_CIM_CUST_REBATE_QUAL.

9. On the Accrual Calculation tab, specify the pricing charge definition that Pricing associates with an item. Select

a pricing basis for discount types from the following:
o Unit List Price: If you select this, then you offer a discount on the unit list price of the item.

o Unit Selling Price: If you select this, then you offer a discount on the unit selling price of the item.

Note: : If you select Unit List Price, then you must ensure that the Unit List Price is specified in the
sales transaction CSV file. The Unit Selling Price is mandatory in the sales transaction.

10. On the Optional Defaulting tab, select the default for your programs. You can set the currency and calculation
method to be used during program creation and specify the default tier to be used during discount rule
creation.

o Default Program Currency To: Select the default currency for your program from the list of values. For
example, US Dollar.

o Default Calculation Method To: Select Retrospective or Stepped. Choose Stepped to provide higher
rebates to later orders and choose Retrospective to provide higher rebates to all eligible sales based on
the highest tier achieved.

The following tables show an example of how different tiers impact Retrospective and Stepped
calculation methods.

Tier Setup
Tier Quantity Discount
Tier 1 0-50 $10
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Tier Quantity Discount
Tier 2 51-100 $20
Tier 3 101and above $30

Retrospective and Stepped Calculations

Tier 1 Tier 2 Tier 3 Total Total Rebate

January - Retrospective Calculation Method for Purchase of 75 units
Quantity Purchased -- 75 -- --
Rebate Value -- 75*%$20=$1500 -- $1500

February - Retrospective Calculation Method for Purchase of 75 units

Quantity Purchased  -- -- 75 --

Rebate Value -- - 75*$30=$2250 + $2250+$750= $1500+$3000=
Uplift for January is $3000 $4500
(75*$30) - (75*$20)
=$750

January - Stepped Calculation Method for Purchase of 75 units

Quantity Purchased 50 25 -- --
Rebate Value 50*$10=$500 25*%$20=$500 -- $1000
February - Stepped Calculation Method for Purchase of 75 units

Quantity Purchased -- 25 50 --

Rebate Value 25*$20=$500 50*$30=$1500 $500+$1500= $1000+$2000=
$2000 $3000

o Default Tier Type: Select the default tier type from the list of values to be used during creation of
discount rules. Available values are Quantity and Sales.

11. Click Save and Close. The program type is created in the Draftstatus.

Program Type for Customer Lump Sum Programs

The lump sum program template supports lump sum programs that are customer-specific and target a single customer
at a time.

This program type enables you to default the program currency and product distribution.

You can create and update lump sum program types from the Manage Program Types page.

1. Inthe Setup and Maintenance work area, go to:
o Offering: Order Management
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8.

o Functional Area: Channel Revenue Management
o Task: Manage Channel Program Types
On the Manage Program Types page you can create and update your program types. Click the Create icon to
open the Create Program Type page.
From the Based on Predefined Program Template list, select Customer Lump Sum.
Enter a name for your program type in the Name field.
Enter a code for your program type in the Program Type Code field. This code:
o Acts as a unique identifier for the program type.

o Is used to synchronize setup data across multiple environments.
o Isn’t available to users in the transactional pages.
Update the Prefix field if required. This value acts as the prefix for your Promotion Code while creating a

program. The predefined prefix for the customer lump sum program template is CLUM.

On the Optional Defaulting tab, select the defaults. The defaults you select here determine the defaults during
program creation.

o Default Program Currency To: Optionally, select a default currency.
o Default Product Distribution Type To: Optionally, select the type of product distribution. You can
choose from Amount, Even, or Percent.
From the Actions menu, select Activate to active the lump sum program type.

Related Topics

Elements of a Customer Annual Co-op Program
Elements of a Customer Annual Volume Program
Elements of a Customer Promotion Program
Elements of a Customer Volume Program
Elements of a Customer Lump Sum Program

Program Type Statuses

Use program type statuses to monitor your customer program types.

Use program type statuses to monitor your program types. You can update them from the Manage Program Types
page. Statuses for program type are defined in the lookup ORA_CIJM_PROGRAM_TYPE_STATUS.
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This table shows supported program type statuses.

Status What Happens to the Channel Program

Draft The program type has been created and not activated.

Active The program type has been activated for use. Only active program types can be used to create a
program.

Closed for New Programs An active program type can be closed for use in additional new programs. These are no longer eligible

for use in new programs.
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8 Set Up Buy Side Programs

Setting Up Supplier Programs

Suppliers programs are used to define the rules of a channel agreement between the distributor or wholesaler and their
suppliers.

Generally, supplier programs are organized into various types, each with their own rule structure and set of business
processes. This structure is encompassed in a program type. When creating a program, the identification of a program
type is required. Use program types to determine channel guidelines, such as defining how a program is created,
applied, and processed. The program type controls and simplifies the program creation.

Related Topics
« Predefined Program Templates

Set Up Program Quialifiers

Important: This section is not applicable to Supplier Annual Programs because there is no integration with Fusion
Pricing. Qualifiers are attributes used to define eligibility in the form of program, market, and product rules in a channel
program. Only those qualifiers that are part of the program type can be selected in the program. That is, you have to
select the qualifiers during program type creation, and only these are available for selection in the programs. If you need
a new qualifier type to be available in the program, you must first add that qualifier in the corresponding program type.

Set Up Custom Quialifier for Market and Program Rules

Prior to adding a custom qualifier to a program type, it must be defined in the lookup ORA_CIM_QUALIFIER_TYPE and
should be enabled. It should also be available in the Channel Program Eligibility matrix class.

Related Topics
» Manage Channel Lookups

- Manage Your Integration

How to Add User-Defined Attributes to Items

You can create user-defined attributes that can be used in the program product rules to determine the price or discount.
You must set it up as an item extensible attributes in an item class to represent details about the item.

Create an Attribute Group and Attributes

1. With roles allowing access, in the Setup and Maintenance work area, go to:
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o Offering: Product Management
o Functional Area: Items
o Task: Manage Item Attribute Groups and Attributes

2. Inthe Manage Attribute Groups page, from the Actions drop-down button, click Create to create an attribute
group.
3. Inthe Create Attribute Group page, enter the details for the following fields:

Field Description

Display Name Enter a display name for the attribute group. For example, Item Color.
Internal Name Enter an internal reference name. For example, Item Color Specification.
APl Name Automatically populated, edit if required.

Behavior Select Single Row from the list.

4. On the Context Usages tab, select Create from the Actions drop-down list.

5. Select Item from the Name list as the context usage. Click Save. This creates the attributes group with context
usage as ltem.

In the Edit Attributes page, in the Attributes section, click Create from the Actions drop-down button.
7. Inthe Create Attribute page, enter the details for the following required fields:

o

Field Description

Display Name Enter a display name for the attribute. For example, Color.

Internal Name Enter an internal reference name. For example, Product Color.

APl Name Automatically populated, edit if required.

Data Type Select the data type of the attribute. For example, for color select Character.
Table Column Automatically populated, edit if required.

8. Select a Value Set from the list, or create one by clicking Create Value Set.
If you're creating a value set, in the Create Value Set page, enter the details for the following fields:

a. Enter a code for your value set. For example, PRODUCT_COLOR.
b. Enter a description to for the value set. For example, Value set for product colors.
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c. Select Product Model from the Module list.
d. Select a Validation Type. You must select Independent or Format Only for each item extensible attribute
that you plan to use with Pricing.

e. Select the data type of your value set from the Value Data Type list. You must select either Number or
Character for the data type. Other data types aren't supported.

f. In the Definition section, enter the required details and save.

g. Click Manage Values to add the values for the value set.

h. Inthe Manage Values page, Click Create from the Actions drop-down button.

i. Add the values you want for your value set. For example, different product colors like blue, red, and so on.

j- Click Save and Close to navigate back to the Create Attributes page.
9. Inthe Create Attributes page, the Display Properties are now populated. You can edit this if required.
a. Prompt: The prompt for your attribute. For example, Color.
b. Display Type: How the values should be displayed. For example, List of Values.
10. Click Save and Close. The attribute for the attribute group is saved, and you're now on the Edit Attribute Group
page. You can create more attributes for this group if required. Note down the flexfield code and save.

Add the Attribute Group to an Item Class

1. With roles allowing access, in the Setup and Maintenance work area, go to:
o Offering: Product Management

o Functional Area: Items
o Task: Manage Item Classes

2. Inthe Manage ltem Classes page, select the Item Class under which you want to add the attribute group and its
attributes as extensible attributes. You can select the Root Item Class to add the attribute group to all the item
classes.

3. Inthe Edit Item Class page, click Pages and Attribute Groups tab. On the Attribute Groups subtab, from the
Actions drop-down button, click Select and Add.

4. Select your attribute group and click Apply, then click OK. Click Save to save the updates to the item class.

5. Navigate to the Pages subtab. Select Pricing Item Attributes. If it's not available, add it. See the Add Your
Attribute Group to An Item Class section in the Add Your Own Attributes to Items in Pricing topic from the
Pricing Administration guide.

6. In the Attributes Group: Pricing Iltem Attributes section, click Select and Add from the Actions drop-down
button. Select your attribute group. Click Apply, then OK. Click Save to save the updates to the item class.

7. Navigate to the Functional Item Pages subtab and ensure that the following is available:

o Functional Area: Pricing

o Usage: Pricing
o Item page: Pricing Item Attributes

The attribute group is added to the item classes.

Deploy the Item Extensible Flexfield

After associating the attribute groups to the item classes, you must deploy the extensible flexfield.

1. With roles allowing access, in the Setup and Maintenance work area, go to:
o Offering: Product Management
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o Functional Area: Items
o Task: Deploy Item Extensible Flexfields

2. Search for your flexfield code. Select it and click Deploy Flexfield.
3. After successful deployment, you must sign out and sign back in to view the EFF configuration on the item.

Edit the Pricing Matrix Class

You must now add the item attribute to the Pricing Matrix Class.

1. With roles allowing access, from the Navigator, select Pricing Administration. In the Overview page, open the
Tasks panel and select Manage Matrix Classes.

2. Inthe Manage Matrix Classes pages, select Channel Program Eligibility.

3. Inthe Edit Matrix Classes page, click Add Row from the Actions drop-down list. This creates a new dimension
to Channel Program Eligibility.

4. Inthe Name field, enter a name for your dimension. For example, Color.

5. Inthe Source Code Name field, enter a code concatenated with the operator abbreviation. The supported

operator abbreviations are E for equal to, NE for not equal to, EGT for greater than or equal to, and ELT for less

than or equal to. For example, COLOR_E.

In the Comparison field, choose the comparison operator. For example, =.

7. From the Compare to Attribute drop-down list, select one of the following. You must select the same data type
that you specified when you set up the attribute on the Manage Item Attribute Groups and Attributes page. If
the data types don't match, then the eligibility rules won't work correctly.

o

o itemExtensibleAttribute.VarcharValue
o itemExtensibleAttribute.NumberValue

8. Leave the Required check box deselected. Select the Allow Null and Null Is Wildcard check boxes.
9. From the Domain list, select:

o Domain Type: Item Extensible Attribute

o Data Type: Select the same data type that you specified when you set up the attribute on the Manage
Item Attribute Groups and Attributes page
o Attribute: Select the attribute you created in the Manage Item Attribute Groups and Attributes page.

o Attribute Group Identifier: temExtensibleAttribute.AttributeGroupCode (default value)
o Attribute Identifier: temExtensibleAttribute.AttributeCode (default value)

10. Leave the Default Value field blank as it's not used. Click OK.
11. Click Save.

Update Channel Lookup

1. In the Setup and Maintenance work area, go to:
o Offering: Order Management/Procurement
o Functional Area: Channel Revenue Management/Supplier Incentives
o Task: Manage Channel Lookups

2. Search for the extensible lookup: ORA_ CIJM_ITEM_LEVEL and add a new lookup code.
3. Inthe Lookup Code field, enter the same name as the Source Code Name used for Channel Program Eligibility

matrix class (without the concatenated operator). For example, if the Source Code Name in the matrix class is
COLOR_E, then enter COLOR as the lookup code.
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4. Enter values for the remaining fields and click Save.

Note: For more information about creating extensible flexfields, see User Defined Attribute Groups and Attributes
(Extensible Flexfields-EFFs) Setup White Paper (Doc ID 1992317.1) on My Oracle Support at https://support.oracle.com.

Related Topics
 Item Attribute Groups and Attributes

« Product Value Sets: Explained

« Item Classes

« Add Your Own Attributes to Items in Pricing
- Item Specifications and Attributes

Set Up Program Types

Predefined Program Templates

Predefined templates are templates of industry defined channel programs and flows supported by Channel Revenue
Management.

You can select a predefined template while creating a program type. Types of templates supported:

- Supplier Rebate
- Supplier Annual Program
- Supplier Ship and Debit (from the standpoint of the distributor managing programs from their suppliers)

Program Code Numbering

The program code is made up of a prefix and a single sequence. Prefix is defined by the program type. The predefined
prefix for Supplier Ship and Debit program template is SSD, and for Supplier Rebate is REB. A single sequence generates
numbers from a given starting number stored in the database. This single sequence is across all programs.

Note: A prefix can be shared across multiple program types if so determined.

For example, consider two program types prefixed with ABC and DEF:

- 1st program code is ABC1000
- 2nd program code is DEF1001
« 3rd program code is ABC1002

Manage Program Types

Program types incorporate channel processing guidelines such as defining how a program is created, applied, and
processed.
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Program types control and simplify program creation. For example, within a predefined program template such as
Supplier Ship and Debit, a distributor can configure different flavors of supplier ship and debit as different program

types.
You can create and update program types from the Manage Program Types page.

1. Inthe Setup and Maintenance work area, go to:

o Offering: Order Management/Procurement
o Functional Area: Channel Revenue Management/Supplier Incentives
o Task: Manage Channel Program Types

2. On the Manage Channel Program Types page you can create and update your program types. Click the Create
icon. The Create Program Type page opens.

Create Supplier Rebate Program Type

1. From the Based on Predefined Program Template drop-down list, select Supplier Rebate.
2. Enter a name for your program type in the Name field.
3. Enter a code for your program type in the Program Type Code field. This code:

o Acts as a unique identifier for the program type, and is required.
o Is used to identify and synchronize setup data across multiple environments.
o Is not available to users in the transactional pages.

4. Update the Prefix field if required. This value acts as the prefix for your Program Code while creating a
program. The predefined prefix for the supplier rebate template is REB.

5. On the Qualifiers tab:

a. Select the applicable date contexts for your programs. From the Qualify Programs Based On drop-down
list select either:

- Purchase Order Date: If you select this, the channel programs created with this program type are
qualified by matching them against the date on the PO.

- Receipt Transaction Date: If you select this, the programs are qualified by matching them against
the transaction date in the receiving transaction.

- Requested Delivery Date: If you select this, the programs are qualified by matching them against
the requested delivery date on the order line.

- Requested Ship Date: If you select this, the programs are qualified by matching them against the
requested ship date on the order line.

- Shipped Date: If you select this, the programs are qualified by matching them against the shipped
date on the receipt.

- Supplier Invoice Date: If you select this, the programs are qualified by matching them against the
invoice date on the supplier invoice.

Note: Supplier Invoice Date doesn't apply to supplier rebates via the direct integration to
inbound receiving transactions.

b. Add the qualifiers you want for your program and market rules. The values in the drop-down list are from
the lookup ORA_CJM_SUP_REBATE_QUAL.

6. On the Optional Defaulting tab:

Specify the defaults for your programs.
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o Default Program Currency To: Select the default currency for your program from the drop-down list. For
example, US Dollar.

o Default Discount Type for Product Rules To: Select the default discount type for your product rule from
the drop-down list. Available values are Amount and Percent.

7. Click Save. The program type is created in the Draft status.

Create Supplier Annual Program Type

1. From the Based on Predefined Program Template drop-down list, select Supplier Annual Program.
2. Enter a name for your program type in the Name field.
3. Enter a code for your program type in the Program Type Code field. This code:

o Acts as a unique identifier for the program type, and is required.
o Is used to identify and synchronize setup data across multiple environments.
o Is not available to users in the transactional pages.
4. Update the Prefix field if required. This value acts as the prefix for your Program Code while creating a

program. The predefined prefix for the supplier annual program template is ANN.
5. On the Optional Defaulting tab:

Specify the defaults for your programs.

o Default Program Currency To: Select the default currency for your program from the drop-down list. For
example, US Dollar.
o Default Calculation Method: Select the default calculation method for your program. Available values
are Retrospective and Stepped.
o Default Tier Type: Select the default tier type for your volume rule. Available values are Purchases and
Quantity.
6. Click Save. The program type is created in the Draft status.

Create Supplier Ship and Debit Program Type

1. From the Based on Predefined Program Template drop-down list, select Supplier Ship and Debit.
2. Enter a name for your program type in the Name field.
3. Enter a code for your program type in the Program Type Code field. This code:

o Acts as a unique identifier for the program type, and is required.
o Is used to identify and synchronize setup data across multiple environments.
o Is not available to users in the transactional pages.

4. Update the Prefix field if required. This value acts as the prefix for your Program Code while creating a
program. The predefined prefix for the supplier ship and debit template is SSD.

5. On the Qualifiers tab:

a. Select the applicable date contexts for your programs. From the Qualify Programs Based On drop-down
list select either:

- Ordered Date: If you select this, the channel programs created with this program type are qualified
by matching them against the ordered date on the order.

- Requested Ship Date: If you select this, the channel programs created with this program type are
qualified by matching them against the requested ship date on the order line.
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b. Add the qualifiers you want for your program and market rules. The values in the drop-down list are from
the lookup ORA_ CIJM_QUALIFIER_ TYPE.

6. On the Pricing Integration tab:

o Specify the pricing charge definitions. Pricing uses these to determine the accrual for an item.

i. From the Charge Type drop-down list, select the type of charge for the items in your program. For
example, sale, service, or freight.

ii. From the Charge Subtype drop-down list, select the subtype for the items in your program. This
provides additional details about the charge. For example, the charge is a price or a fee.

o Specify the pricing basis for your discount types.
i. From the Basis for Percent drop-down list, select the pricing basis for a discount based on a
percentage.
ii. From the Basis for New Cost drop-down list, select the pricing basis for a discount based on a new
cost.

Note: You must select the pricing basis if your product rule discount is based on New Cost or Percent.

7. On the Order Management Integration tab:
Specify the Order Management action for sales orders created with programs of this program type.

o Apply Program Manually To Order: If you select this check box, the program won't be automatically

applied to the eligible sales orders. You have to manually add them from the Manage Incentives dialog
box.

o Prevent User from Declining a Program: If you select this check box, you can't remove the program
from the sales order after it gets applied.

8. On the Optional Defaulting tab:
Specify the defaults for your programs.

o Default Program Currency To: Select the default currency for your program from the drop-down list. For
example, US Dollar.

o Default Discount Type for Product Rules To: Select the default discount type for your product rule from
the drop-down list. Available values are Amount, New Cost, and Percent.

9. Click Save. The program type is created in the Draft status.

Activate Program Types

To activate a program type, with roles allowing access, open your program type from the Manage Program Types page.
Click Activate on the Actions drop-down button. A program type in the draft status can either be activated or deleted.

An active program type can be made inactive. Open the program type and from the Actions drop-down button, click
Inactivate. The status changes to Closed for New Programs.

Note: You can delete a program type after its activation only if there aren't any programs associated with the program
type.

Related Topics
« Manage Pricing Charge Definitions
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Program Type Statuses

Use program type statuses to monitor your program types. You can update them from the Manage Program Types
page. Statuses for program type are defined in the lookup ORA_CIM_PROGRAM_TYPE_STATUS. This table shows

supported program type statuses.

This table shows supported program type statuses.

Chapter 8
Set Up Buy Side Programs

Status Description

Draft The program type has been created and not activated.

Active The program type has been activated for use. Only active program types can be used to create a
program.

Closed for New Programs An active program type can be closed for use in additional programs. These are no longer eligible for

use in new programs.

This figure shows the system status transitions for program types.
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9 Set Up Adjustments

Overview of Adjustment Types

Before you can create manual adjustments, you must set up adjustment types. Each adjustment must be classified by
an adjustment type for processing to the checkbook and determining what prefix to use in the adjustment number.

The administration of adjustment types is partitioned by reference set. Within this setup, the predefined adjustment
type defines how the adjustment type affects the checkbook. For example, the missed supplier accrual adjustments
would be based on the Increase Earned predefined adjustment type, because such adjustments would increase
earned accruals in the checkbook. Supplier rejection adjustments would be based on the Decrease Earned predefined
adjustment type, because such adjustments would decrease earned accruals in the checkbook. In addition, you can
specify a prefix that will be used in generating adjustment numbers for each adjustment type.

I Note: Adjustment types can share the same prefix or they can have different prefixes.

Set Up Adjustment Numbering

Adjustment numbers consist of a prefix and a single sequence. The prefix is defined in the adjustment type setup. A
single sequence generates numbers from a given starting number that's stored in the database and the single sequence
is used across all adjustments. The sequence starts at 1000.

Most implementations choose to have the same prefix for adjustment types. However, we also support different
prefixes by adjustment type. For example, let's assume two adjustment types prefixed with ABC and DEF respectively:

For the first adjustment number, the sequence is ABC1000.
For the second adjustment number, the sequence is DEF1001.

For the third adjustment number, the sequence is ABC1002.

In this example, the ABC and DEF prefixes were defined in the adjustment type setup, which can be up to any five
alphanumeric characters.

Related Topics
- Reference Data Sets and Sharing Methods

Manage Adjustment Types

You can create and update adjustment types from the Manage Adjustment Types page.

1. In the Setup and Maintenance work area, go to:

o Offering: Order Management/Procurement
o Functional Area: Channel Revenue Management/Supplier Incentives
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2.
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o

10.

o Task: Manage Channel Adjustment Types

On the Manage Adjustment Types page, select the Add icon to create a new adjustment type.
Enter a code for your adjustment type in the Adjustment Type Code field. This code:

o Acts as a unique identifier for the adjustment type, and is required.
o Is used to identify and synchronize setup data across multiple environments.
o Is not available to users in the transactional pages.

From the Set Name list, select the set for which you want to create the adjustment type.
Select Buy Side or Sell Side for the type of adjustment you are creating.
Enter the name of your adjustment type in the Adjustment Type field.

From the Predefined Adjustment Type drop-down list, select either Decrease Earned or Increased Earned.
Predefined adjustment types are defined in the lookup ORA_CIJM_ADJUSTMENT_TYPE.

Enter the prefix you want for your adjustments in the Prefix field.
Enter values for the remaining fields, if required.
Create adjustment reasons for your adjustment type in the Adjustment Reasons section. Click Save.

Note: Each adjustment type can have multiple adjustment reasons.

Manage Adjustment Reasons

These are the reasons for making the adjustments, which you can set up based on your business needs.

You can create and update adjustment reasons for each adjustment type in the Adjustment Reasons section on the
Manage Adjustment Types page.

1.

Select the adjustment type for which you want to create adjustment reasons. Scroll down to the Adjustment
Reason section.

Select the Add icon to create a new adjustment type.
Enter a code for your adjustment reason in the Adjustment Reason Code field. This code:

o Acts as a unique identifier for the adjustment reason, and is required.
o Is used to identify and synchronize setup data across multiple environments.
o Is not available to users in the transactional pages.

Enter the adjustment reason in the Adjustment Reason field.
These fields are optional:

o Description: Add a description to better document your reason.
o Enable check box: If this check box is selected, the reason becomes available for selection in the Manage
Adjustments page while creating a manual adjustment with the corresponding adjustment type.

o Default check box: If this check box is selected, the reason becomes the default for the adjustment type,
and is automatically selected as the adjustment reason while creating a manual adjustment with the
corresponding adjustment type.

Click Save.

170

ORACLE



SCM Cloud Chapter 10
Implementing Channel Revenue Management Set Up Customer Claims

10 Set Up Customer Claims

Overview of Customer Claims

Here you can learn about and complete the setup steps that you must perform before you can start processing claims.
Deduction claims are derived from Receivables and you can create manual claims.
You must complete the following setups:

1. Claim Types
2. Claim Reasons
3. Claim Sources and Settlement Methods

The claim source represents how and where the claim was created. The settlement methods represent type of
Receivables transactions that are supported for a specific claim source. A claim can be settled with multiple settlement
methods.

The following table displays the Receivables action that creates a specific claim source and all the supported settlement
methods for each claim source. Configure the settlement methods for each claim source as needed.

Receivables Action Claim Source Select 1 Primary Apply 1or More Settlement in Receivables
Settlement Method Settlement Methods
Create Claim Investigation = Deduction - Credit Memo on - Open Credit Memos - Automatic Write Off
Account

. 0 O t:
o Nonpromotional pen Lverpayments

o Promotional

o Promotional Pay Over

- Manual Write Off

Create Claim Investigation = Overpayment Invoice Open Deductions
Create Channel Revenue Invoice Deduction - Credit Memo on - Open Credit Memos - Automatic Write Off
Claim Account

Nonpromotional + Open Overpayments
[e]

o Promotional

o Promotional Pay Over

- Credit Memo on
Invoice

o Nonpromotional

- Chargeback with no
other settlement
methods

- Manual Write Off
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Receivables Action Claim Source Select 1 Primary Apply 10or More Settlement in Receivables
Settlement Method Settlement Methods
Create Channel Revenue Invoice Overpayment Invoice Open Deductions
Claim
Not Applicable Manual Claim - Credit Memo on None
Account

o Nonpromotional
o Promotional

o Promotional Pay Over

Custom Settlement
Methods

In addition to the predefined settlement methods, you can also define custom settlement methods for your manual
claims. You can use this for both promotional and nonpromotional claims.

Related Topics
« Manage Claim Types

» Manage Claim Reasons

« Manage Customer Claim Sources and Settlement Methods
- Configure Pay Over Earnings

« Configure Custom Settlement Method

Manage Claim Types

Here you'll understand how to manage customer claim types.

Channel Revenue Management has configurable claim types. The administration of claim types is partitioned by
reference sets. You can use claim types to analyze claims and identify possible business process improvements.

1. In the Setup and Maintenance work area, go to:
o Offering: Order Management/Procurement
o Functional Area: Channel Revenue Management
o Task: Manage Channel Claim Types

2. Onthe Manage Claim Types page, you can create and update your claim types.

3. Click the Add icon to create a new claim type. Enter a code for your claim type in the Claim Type Code field.
This code:

o Acts as a unique identifier for the claim type.
o Is required to synchronize the setup data across multiple environments.
o Is not available to users in the transactional pages.

4. From the Set Name list, select the set for which you want to create the claim type.

5. Select the Sell Side check box to select the channel flow for which you want the claim type enabled. You can't
update this once saved.
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6. Enter the name of your claim type in the Claim Type field.
7. Enter values for the remaining fields, if required.
o Description: Add a description for your claim type.

o From Date and To Date: Add a date range during which your claim type is valid.

8. Select the following value to map your claim type with a transaction type in Receivables.
o Mapped Transaction Type for Credit Memo: Select Credit Memo.

o Mapped Transaction Type for Invoice: Select Invoice.
o Mapped Transaction Type for Chargeback: Select Chargeback-NES

9. Select the desired receivables activity to map your claim type and business unit for a receipt write off and a
write-off adjustment settlement transaction in AR.
10. Click Save.

Manage Claim Reasons

Here you'll understand how to manage customer claim reasons.

Channel Revenue Management has configurable claim reasons. The administration of claim reasons is partitioned by
reference set. You can use claim reasons to analyze claims and identify possible business process improvements.

1. In the Setup and Maintenance work area, go to:
o Offering: Order Management/Procurement
o Functional Area: Channel Revenue Management
o Task: Manage Channel Claim Reasons

2. On the Manage Claim Reasons page, you can create and update your claim reasons.
3. Click the Add icon to create a new claim reason.
4. Enter a code for your claim reason in the Claim Reason Code field. This code:

o Acts as a unique identifier for the claim reason, and is required.

o Is used to identify and synchronize the setup data across multiple environments.
o Is not available to users in the transactional pages.

w

From the Set Name list, select the set for which you want to create the claim reason.

6. Select the Sell Side check boxes to select the channel flow for which you want the claim reason enabled. You
can't update this once saved.

Enter the name of your claim reason in the Claim Reason field.

8. Enter values for the remaining fields, if required.

o Description: Add a description for your claim reason.

N

o From Date and To Date: Add a date range during which your claim reason is valid.

9. For Deductions and Settlement, select the following values to map your claim reason to Receivables:

o Mapped Credit Memo Reason: Select the Receivables credit memo reason that should be used for
deductions settled with credit memos, when using this claim reason, for example Damaged Product.

o Mapped Adjustment Reason: Select the Receivables adjustment reason that must be applied to
deduction write-offs, for example Offset.

o Mapped Chargeback Reason: Select the Receivables Chargeback Reason that should be used for
deductions settled with chargebacks, when using this claim reason, for example Offset.

10. Click Save. You can't delete a claim reason after saving. You can only update it.
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Manage Customer Claim Sources and Settlement
Methods

When a customer claim is settled, Receviables or Payables transactions are created based on settlement methods.

You can configure the claim sources and the settlement methods they use for processing from the Manage Claim
Sources page. The administration of claim sources is partitioned by reference sets.

1.

N

In the Setup and Maintenance work area, go to:
o Offering: Order Management

o Functional Area: Channel Revenue Management
o Task: Manage Channel Claim Sources

Click the Add icon to create a new claim source.
From the Set Name list, select the set for which you want to create the claim source.
From the Claim Source drop-down list, select your claim source. The values are from the lookup
ORA_CJIM_CLAIM_SOURCE.
Select the Enable check box if you want the claim source to be available for your claims.
Enter the prefix you want for each of your claim source in the Prefix field. The value is used in as the prefix
along with the generated claim number for each claim belonging to this claim source.
Enter values for the remaining fields, if required.
o Description: Add a description for your claim source.

o Default Claim Type: Select the claim type you want as the default for your claim source.
o Default Claim Reason: Select the claim reason you want as the default for your claim source.

Select the settlement methods for your claim source from the Available Settlement Methods section. You can
set a settlement method as the default for the claim source.
o Claim settlement methods are defined in the lookup ORA_CIM_SETTLEMENT_METHOD.

o The application that supports a predefined settlement method is defined in the lookup
ORA_CIM_CLAIM_ACCOUNT_FOR.

Claim Source Supported Settlement Method Accounting For
Deduction Credit Memo - On Account Receivables
Deduction Open Credit Memo Receivables
Deduction Open Overpayment Receivables
Deduction Write-Off Receivables
Invoice Deduction Chargeback Receivables
Invoice Deduction Credit Memo — On Account Receivables
Invoice Deduction Credit Memo - On Invoice Receivables
Invoice Deduction Open Credit Memo Receivables
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Claim Source Supported Settlement Method Accounting For

Invoice Deduction Open Overpayment Receivables

Invoice Deduction Write-Off Receivables

Invoice Overpayment Open Deduction Receivables

Manual Claim Credit Memo - On Account Receivables

Manual Claim Custom Settlement Receivables

Manual Claim Check Payables

Manual Claim Payables Default Payment Payables

Overpayment Open Deduction Receivables

Configure Pay Over Earnings

Pay over earnings allows for payments to be issued to customers that exceed their available amount or that have no
accruals.

The pay over earnings threshold rules are guidelines that decide when this extra payment can be made. You can set

a specific amount or percentage above the earned amount to determine how much extra the customer can be paid.
Alternatively, you can decide on an unconditional threshold type, which enables you to pay an unlimited amount to the
customer.

The following table explains the possible scenarios you can use to configure pay over earnings.

Pay Over Scenarios Pay Over Earnings Threshold Type Threshold Value Override Threshold
Don't allow pay over Disallow or Null NA NA NA
Allow pay over up to Allow - Percentage Percentage or amount No
threshold without approvals value
- Amount
Allow pay over up to Allow - Percentage Percentage or amount Yes
threshold without approvals value
and Allow pay over with + Amount
approvals above threshold . Unconditional

You can set the pay over earnings options in the customer's trade profile, either at the customer or customer account
level, or you can set the options in the Channel Settings.

The pay over earnings process is initiated when you associate earnings through the user interface or REST API to a
specific program and the intended amount to be associated is higher than the available earnings.

Depending on how pay over earnings are implemented in your organization, the application considers pay over
eligibility based on the value configured in the Customer Trade Profile at the Customer Account level. If the value
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isn't configured at the Customer Account level, then the application considers the value configured in the Customer
Trade Profile at the Customer Level. If both the above values aren't configured, then the application considers the
value configured in the Channel Settings to determine eligibility and threshold of pay over earnings for the customer .
However, if the values are configured at all three levels, Customer Account, Customer Level, and in the Channel
Settings, then the application considers the setting in the Customer Trade Profile Customer at the Account Level to
determine pay over eligibility.

You can configure pay over earnings from the Manage Customer Trade Profiles page as follows:

1. Navigator > Order Management > Customer Channel Management or Deductions and Settlement >
Administration tab. On the Administration page, select Configure customer trade profiles.

2. Select a value from the list in the Pay over Earnings field. Based on your selection here, you can select the
Threshold Type, Threshold Value, and an Override Threshold.

You can also configure pay over earnings from the Manage Settings page.

1. Inthe Setup and Maintenance work area, go to:
o Offering: Order Management/Procurement
o Functional Area: Channel Revenue Management
o Task: Manage Channel Settings

2. Enable Pay Over Earnings if payments are allowed to exceed program earnings. Based on your selection here,
you can configure the Threshold Type, Threshold Value, and the Override Threshold settings. You can also
configure the Automatically Include Programs with Zero Balances setting if required.

Related Topics
« Manage Channel Settings

« Create Customer Trade Profiles
« Resolve Promotional Claims

Configure Payables Settlement Method

Here you'll learn how to configure Payables settlement methods.

Customer Channel claims provides ready to use integrations to Fusion Financials Cloud for a host of ways to settle
claims.

Settle with

Create Check or Sl

Customer
Claims

Import
Payables
Invoices

Pay the
Invoice in

Manual Research Payables
Claim Default Full

Settlement ESS Job

1. Configure custom settlement method under its applicable claim source.

o Inthe Setup and Maintenance work area, go to the Manage Claim Sources task in the Channel Revenue
Management functional area.

o Select an applicable claim source, and add a Payables settlement method.

2. Configure Customer Trade Profile.
3. Configure Sub Ledger accounting rules from the Manage Accounting Rules task.
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Configure Custom Settlement Method

Here you'll learn how to configure custom settlement methods.

Customer Channel claims provides ready to use integrations to Fusion Financials Cloud for a host of ways to settle
claims. However, is you have additional settlement requirements, you can extend claim settlement options to create
a settlement method for manual claims that is unique to your business process. For example, you can use custom
settlement methods to settle claims created through an external application such as an Accounts Receivable or
Accounts Payable application using the Integration of Channel Revenue Management claims settlement to legacy or
third-party financial systems.

Custom Settlement Method

Populate the
o ) Interface Claim Research a_md settlement Settlement Settlement settle the
Claim in Third- to Channel Settle Claim : . . Document .
- Perform Claim Details using Instruments Channel Claim
Party Revenue using Custom

; ; Details in )
Application Management Sattlement Accounting REST service to and Payments Channel Claim Using REST
Using REST Method

Pass the Create

Third-Party in Third-Party Service

-Pal T using REST
Application Application service

The custom settlement method is available for promotional or nonpromotional manual claims. For promotional claims,
this method also enables you to account for channel revenue to relieve earned accruals on settlement.

This feature reduces the time and effort to integrate the settlement of claims in a third party financials system or
deductions management system.

Here are some common scenarios where you can use custom settlement methods:

- Process settlement in legacy or third-party financial systems.

- Settle with an AR document for overpayment (akin to a negative chargeback, where an AR transaction is used
to give money back to customers who have overpaid).

- Pay by wire transfer or EFT, as is common practice settling with European customers.

- Settle with free goods, if you issue free goods to your customers against their claims. Custom settlement can
support sales order settlement in your order management system for claims.

1. Add a new custom settlement method to the ORA_CIM_SETTLEMENT_METHOD lookup.

o Inthe Setup and Maintenance work area, go to the Manage Channel Lookups in the Channel Revenue
Management functional area.

o Search for lookup type, ORA_CIM_SETTLEMENT_METHOD.
o Add a new lookup code representing the new settlement method.

2. Configure custom settlement method under its applicable claim source.

o Inthe Setup and Maintenance work area, go to the Manage Claim Sources task in the Channel Revenue
Management functional area.

o Select an applicable claim source, and add a custom settlement method.

3. Configure Sub Ledger Accounting rules.
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11 Set Up Supplier Claims

Overview of Supplier Claims

Here you can learn about and complete the setup steps that you must perform before you can generate claims.
You must complete the following setups:

1. Claim Types
2. Claim Reasons
3. Claim Sources and Settlement Methods

Set Up Claims Numbering

Claim numbers consist of a prefix and a single sequence. The prefix is defined in the claim source setup. A single
sequence generates numbers from a given starting number that's stored in the database and the single sequence is
used across all claims. The sequence starts at 1000.

Implementations may choose to have the same or different prefix across claim sources. Consult the business owners to
help make this decision. For example, let's assume two claim sources prefixed with ABC and DEF respectively:

For the first claim number, the sequence is ABC1000.
For the second claim number, the sequence is DEF1001.

For the third claim number, the sequence is ABC1002.

In this example, the ABC and DEF prefixes were defined in the claim source setup, which can be up to any five
alphanumeric characters.

Set Up Supplier Claim Extract

Users must have roles allowing them to generate supplier claims to also generate and view claim extracts.

- The predefined Oracle Bl Publisher templates are located under Catalog > Shared Folders > Supply Chain
Management > Channel Revenue Management > Claims.

This table shows the template names for claim extracts from various claims.

Template Name Claim

Claim Detail Extract Report Supplier ship and debit claims
Supplier Annual Claim Detail Extract Supplier annual program claims
Report
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Template Name Claim
Supplier Rebate Claim Detail Extract Supplier rebate claims
Report

- You can also decide on the columns you want included in the export file, and create a Bl Publisher template for
it.
- The default format for date is yyyy/mm/pp.

- The default format for time stamp is yyyy/mMM/pp HH24:MI:SS.

Related Topics
« Generate Claim Extract

Manage Supplier Claim Types

Channel Revenue Management has configurable claim types. The administration of claim types is partitioned by
reference sets. You can use claim types to analyze claims and identify possible business process improvements.

1. Inthe Setup and Maintenance work area, go to:

o Offering: Order Management/Procurement
o Functional Area: Channel Revenue Management/Supplier Incentives
o Task: Manage Channel Claim Types

2. Onthe Manage Claim Types page, you can create and update your claim types.
3. Click the Add icon to create a new claim type.
4. Enter a code for your claim type in the Claim Type Code field. This code:

o Acts as a unique identifier for the claim type, and is required.
o Is used to identify and synchronize the setup data across multiple environments.
o Is not available to users in the transactional pages.

5. From the Set Name list, select the set for which you want to create the claim type.

6. Use the Buy Side and Sell Side check boxes to select the channel flows for which you want the claim type
enabled. You can't update this once saved.

Enter the name of your claim type in the Claim Type field.
8. Enter values for the remaining fields, if required.

N

o Description: Add a description for your claim type.
o From Date and To Date: Add a date range during which your claim type is valid.

9. For Deductions and Settlement, select the following values to map your claim type with a transaction type in
Receivables.

o Mapped Transaction Type for Credit Memo: Receivables transaction type to be used with the claim
type, for deductions that are settled with credit memos.
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o Mapped Transaction Type for Invoice: Receivables transaction type to be used with the claim type for
overpayments that are settled using invoices.

o Mapped Transaction Type for Chargeback: Receivables transaction type to be used with the claim type
for deductions that are settled with a chargeback.

10. For Deductions and Settlement, select the desired receivables activity to map your claim type and business unit
for a receipt write off and write-off adjustment settlement transaction in AR.

11. Click Save.

Manage Supplier Claim Reasons

Channel Revenue Management has configurable claim reasons. The administration of claim reasons is partitioned by
reference set. You can use claim reasons to analyze claims and identify possible business process improvements.

1. Inthe Setup and Maintenance work area, go to:

o Offering: Order Management/Procurement
o Functional Area: Channel Revenue Management/Supplier Incentives
o Task: Manage Channel Claim Reasons

2. Onthe Manage Claim Reasons page, you can create and update your claim reasons.
Click the Add icon to create a new claim reason.
4. Enter a code for your claim reason in the Claim Reason Code field. This code:

W

o Acts as a unique identifier for the claim reason, and is required.
o Is used to identify and synchronize the setup data across multiple environments.
o Is not available to users in the transactional pages.

5. From the Set Name list, select the set for which you want to create the claim reason.

6. Use the Buy Side and Sell Side check boxes to select the channel flows for which you want the claim reason
enabled. You can't update this once saved.

Enter the name of your claim reason in the Claim Reason field.
8. Enter values for the remaining fields, if required.

N

o Description: Add a description for your claim reason.
o From Date and To Date: Add a date range during which your claim reason is valid.

9. For Deductions and Settlement, select the following values to map your claim reason to Receivables:

o Mapped Credit Memo Reason: Select the Receivables credit memo reason that should be used for
deductions settled with credit memos, when using this claim reason.

o Mapped Adjustment Reason: Select the Receivables adjustment reason that must be applied to
deduction write-offs.

o Mapped Chargeback Reason: Select the Receivables Chargeback Reason that should be used for
deductions settled with chargebacks, when using this claim reason.

10. Click Save. You can't delete a claim reason after saving. You can only update it.
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Manage Supplier Claim Sources and Settlement Methods

Based on the application that generates the claim, and the claim amount, the claim class is determined.

The claim class along with the reference set determines the claim source for any claim. When this claim is interfaced to
the Financials cloud to collect or pay, it uses the associated settlement method to do so.

You can configure the claim sources and the settlement methods they use for processing from the Manage Claim
Sources page. The administration of claim sources is partitioned by reference sets.

1. Inthe Setup and Maintenance work area, go to:

o Offering: Order Management
o Functional Area: Channel Revenue Management
o Task: Manage Channel Claim Sources

2. Click the Add icon to create a new claim source.
3. From the Set Name list, select the set for which you want to create the claim source.

4. From the Claim Source drop-down list, select your claim source. The values are from the lookup
ORA_CJIM_CLAIM_SOURCE.

5. Select the Enable check box if you want the claim source to be available for your claims.

6. Claim classes are derived based on the claim source. Claim classes are defined in the lookup
ORA_CIM_CLAIM_CLASS.

This table shows the mapping between claim source and claim class.

Flow Claim Source Claim Class
Deductions and Settlement Deduction Deduction
Deductions and Settlement Invoice Deduction Deduction
Deductions and Settlement Invoice Overpayment Overpayment
Deductions and Settlement Manual Claim Claim
Deductions and Settlement Overpayment Overpayment
Supplier Annual Program Supplier Annual Program - Claim Claim
Supplier Annual Program Supplier Annual Program - Debit Claim Debit Claim
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Flow Claim Source Claim Class
Supplier Rebate Supplier Rebate - Claim Claim
Supplier Rebate Supplier Rebate - Debit Claim Debit Claim
Supplier Ship and Debit Supplier Ship and Debit - Claim Claim

When a supplier claim is totaled, a positive
total is assigned as Claim

Supplier Ship and Debit Supplier Ship and Debit - Debit Claim Debit Claim

When a supplier claim is totaled, a negative
total is assigned as Debit Claim.

7. Enter the prefix you want for each of your claim source in the Prefix field. The value is used in as the prefix
along with the generated claim number for each claim belonging to this claim source.

8. Enter values for the remaining fields, if required.

o Description: Add a description for your claim source.
o Default Claim Type: Select the claim type you want as the default for your claim source.
o Default Claim Reason: Select the claim reason you want as the default for your claim source.

9. Select the settlement methods for your claim source from the Available Settlement Methods section. You can
set a settlement method as the default for the claim source.

o Claim settlement methods are defined in the lookup ORA_CIM_SETTLEMENT_METHOD.

o The application that supports a predefined settlement method is defined in the lookup
ORA_CIM_CLAIM_ACCOUNT_FOR.

Claim Source Supported Settlement Methods Accounting For

Deduction Credit Memo - On Account Receivables
Open Credit Memo
Open Overpayment

Write-Off

Invoice Deduction Credit Memo - On Account Receivables
Credit Memo - On Invoice

Open Credit Memo
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Claim Source

Invoice Overpayment

Manual Claim

Overpayment

Supplier Annual Program - Claim

Supplier Annual Program - Debit Claim

Supplier Rebate - Claim

Supplier Rebate - Debit Claim

Supplier Ship and Debit - Claim

Supplier Ship and Debit - Debit Claim

10. Click Save.

ORACLE

Supported Settlement Methods

Open Overpayment

Write-Off

Chargebacks

Invoice

Open Deduction

Credit Memo - On Account

Invoice

Open Deduction

AP Debit

AP Default Payment

AP Debit

AP Default Payment

AP Debit

AP Default Payment

Accounting For

Receivables

Receivables

Receivables

Payables

Payables

Payables

Payables

Payables

Payables
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12 Set Up Channel Revenue Flows

Manage Channel Lookups

Here you can view, manage, and edit the lookups for Channel Revenue Management.

1. In the Setup and Maintenance work area, go to:

o Offering: Order Management/Procurement

o Functional Area: Channel Revenue Management/Supplier Incentives

o Task: Manage Channel Lookups

2. You can search for and manage the Channel Revenue Management lookups from the Manage Channel

Lookups page.

List of Channel Lookups

This table lists the lookups and their codes available for Channel Revenue Management.

I Note: You can configure lookups with Lookup Configuration Level: Extensible or User.

Lookup Type

ORA_CIM_ACCRUAL_ADJ_
FOR

ORA_CIM_ACCRUAL_
STATUS

ORA_CIJM_ACCRUAL_TYPE

ORA_CIM_ADJUSTMENT_
TYPE

ORACLE

Meaning

Accrual Adjustment For

Accrual Status for Eligible
Line

Accrual Type

Manual Adjustment Type

Description

Indicates that the accrual
adjustment is done for the
supplier.

Indicates whether accrual
has been computed for the
eligible line.

Indicates that the accrual is
created for the supplier.

List of manual adjustment
types supported in the
channel. For example,
Increase Earned, or
Decrease Earned.

Lookup Configuration
Level

System

System

System

System

Lookup Codes

SUPPLIER
CUSTOMER

PARTY
ORA_CIM_ACCRUAL_
PENDING
ORA_CIJM_ACCRUED

ORA_CIJM_ERROR

SUPPLIER

DECREASE_EARNED

INCREASE_EARNED

TIER_INCREASE_EARNED

TIER_DECREASE_EARNED
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Lookup Type

ORA_CIM_ANP_
CHECKBOOK_GROUP_BY

ORA_CIM_ASSOCIATION_
TYPE

ORA_CIM_BATCH_DATA_
SOURCE

ORA_CIM_BATCH_LINE_
STATUS

ORA_CIM_BATCH_
SOURCE_TYPE

ORA_CIM_BATCH_STATUS

ORA_CIM_BENEFICIARY_

TYPE

ORA_CIJM_BUDGET_
CATEGORY

ORA_CIM_CHANL_CUST_
QUAL

ORA_CIM_CHECKBOOK_
GROUP_BY

ORACLE

Meaning

Grouping Criteria for
Accruals for Annual
Program

Claim Association Type

Batch Data Source Type

Batch Line Status

Source for Load
Transactions

Batch Status

Channel Program

Beneficiary Type

Channel Budget Category

Quialifier for Customer

Programs

Grouping Criteria for
Accruals

Description

Indicates the attribute used
to summarize the accruals
in the annual program
checkbook.

Indicates the level at which
association is performed.
For example, Program,
Order, Product or Invoice.

Indicates the transaction
type used to categorize
the transaction data in the
batch.

List of statuses supported
in the channel batch line.

Indicates the source used
in the Load Transactions
scheduled process.

List of statuses supported
in the channel batch.

List of beneficiary types

supported in the channel.
For example, Bill To, Ship
To, Customer, or Custom.

List of Budget categories.

List of qualifiers supported
in customer annual
programs.

Indicates the attribute used
to summarize the accruals
in the supplier program
checkbook.
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Lookup Configuration
Level

System

System

System

System

System

System

System

User

System

System

Lookup Codes

ORA_CIM_CATEGORY_OR_
ITEM

ORA_CIM_ITEM_IN_
CATEGORY

ORA_CIM_PERIOD

PROGRAM

ORA_RECEIVING_TRX
ORA_SALES_ORDER

ORA_SUPPLIER_INVOICE_
csv

ORA_SALES_ORDER_CSV

ORA_VALIDATED

ORA_PROCESSED

RECEIVING_TRX

ORA_OPEN
ORA_VALIDATED

ORA_PROCESSED

ORA_CIM_BILL_TO_
CUSTOMER_ID

SALES

VENDOR_REBATE

ORA_HEADER_BILL_TO_
CUSTOMERL_ID

ORA_CIM_ITEM

ORA_CIM_PO
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Lookup Type

ORA_CIM_CLAIM_
ACCOUNTING_FOR

ORA_CIM_CLAIM_CLASS

ORA_CIM_CLAIM_FOR

ORA_CIM_CLAIM_LINE_
TYPE

ORA_CIM_CLAIM_PAY_
OVER_EARNING

Meaning

Claim Accounting For

Channel Claim Class

Claim For

Claim Line Type

Pay Over Earnings

ORA_CIJM_CLAIM_SOURCE Channel Claim Source

ORACLE

Description

Indicates whether the claim
accounting is for Payables
or Receivables.

List of claim classes
supported in the channel.

Indicates that the claim is
created for the supplier.

List of claim line types
supported in the channel.

Indicates whether the pay
over earning is allowed or
not.

List of claim sources
supported in the channel
claim.
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Lookup Configuration
Level

Lookup Codes
ORA_CIM_BILL_TO_
LOCATION
ORA_CIM_SHIP_TO_
LOCATION

System PAYABLES

RECEIVABLES

System CLAIM
DEBIT_CLAIM
DEDUCTION

OVERPAYMENT

System SUPPLIER

System ITEM
MEMO_LINE
TAX
FREIGHT

ORA_DESCRIPTION

System ORA_ALLOW

ORA_DISALLOW

System CLAIM

CLAIM_INVESTIGATION_
DED

CLAIM_INVESTIGATION_
OPM

INVOICE_DEDUCTION
INVOICE_OVERPAYMENT
SA_CLAIM
SA_DEBIT_CLAIM
SSD_CLAIM
SSD_DEBIT_CLAIM

SR_CLAIM
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Lookup Type

ORA_CIM_CLAIM_STATUS

ORA_CIM_CLM_PAY_
OVER_THLD_TYPE

ORA_CIM_CODE_
MAPPING_TYPE

ORA_CIM_CUST_CHKBK_
TYPE

ORA_CIM_CUST_CLAIM_
ASSOC_TYPE

ORA_CIM_CUST_CLAIM_
RESOL_TYPE

ORA_CIM_CUST_REB_
PERCENT_BASIS

ORA_CIM_CUST_REBATE_
DATE_QUAL

ORACLE

Meaning

Channel Claim Status

Pay Over Earnings
Threshold Type

Channel Code Mapping
Type

Type of Data Shown in
Customer Checkbook

Association Type for
Customer Claims

Resolution Type for
Customer Claims

Percent Basis for Customer
Rebates

Date Quialifier for Customer
Rebates

Description

List of statuses supported
in the channel claim.

List of the threshold types
used for pay over earnings.

Indicates the mapping
types for customer
mappings.

Indicates whether to

show customer balances,
program balances, or total
balances.

Indicates the level at which
accrual association is
performed in customer
claims.

Indicates the resolution
types supported in
customer claims.

List of pricing bases for
percent supported in
customer rebate programs.

Indicates the date qualifiers
supported in customer
rebates.
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Lookup Configuration
Level

System

System

System

System

System

System

System

System

Lookup Codes

SR_DEBIT_CLAIM

APPROVAL_PENDING
APPROVAL_REJECTED
CANCELLED
NETTING_IN_PROG
OPEN
UPDATE_IN_PROGRESS
SETTLED

SETTLEMENT_PENDING

ORA_AMOUNT
ORA_PERCENTAGE

ORA_UNCONDITIONAL

ORA_CLAIM_REASON

ORA_CUSTOMER_BAL
ORA_PROGRAM_BAL

ORA_TOTAL_BAL

ORA_PROGRAM

ORA_INVOICE_ITEM

ORA_PROMOTIONAL

ORA_NON_PROMOTIONAL

ORA_UNIT_LIST_PRICE

ORA_UNIT_SELLING_PRICE

ACTUAL_SHIP_DATE
SALES_INVOICE_DATE
ORDERED_DATE

REQ_ARRIVAL_DATE
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Lookup Type

ORA_CIM_CUST_REBATE_
QUAL

ORA_CIM_CUST_CLM_
ACCRUE_TO_LVL

ORA_CIM_CUST_CLM_
CALENDAR_YEAR

ORA_CIM_CUST_PROG_
ITEM_LEVEL

ORA_CIM_CUSTOMER_
OR_SUPPLIER

ORA_CIM_DISCOUNT_
APPLIED_TO

ORA_CIM_DISP_TYPE_
STATUS

ORACLE

Meaning

Quialifier for Customer
Rebates

Level of Accrue To
for Customer Claim
Associations

Calendar Year for Customer
Claim Associations

Item Level for Product
Rules in Customer
Programs

Generic Customer or

Supplier List of Values

Discount Applied To

Filter Records by Status

Description

List of qualifiers supported
in customer rebate
programs.

Chapter 12

Set Up Channel Revenue Flows

Lookup Configuration
Level

Extensible

Indicates the level of accrue  System

to supported in customer
claim associations.

Indicates the calendar years System

supported in customer
claims associations.

Item levels supported in
product rules for customer
programs.

Generic list of values
used to select either the
customer or supplier
option.

Choices to indicate the
grouping option used
when applying the channel
program. For example,
Single line or Group of
lines.

Filter used to sort records
based on one of the
following statuses: enabled,
disabled or all statuses.

Extensible

System

System

System

Lookup Codes

REQ_SHIP_DATE
ORA_HEADER_BILL_TO_
CUSTOMERL_ID

ORA_HEADER_BILL_TO_
SITE_USE_ID

ORA_ORDER_LINE_TYPE
ORDER_TYPE
SALESPERSON_ID
SHIP_TO_PARTY_SITE_ID
ORA_WAREHOUSE
ORA_ALL_ACCT_
RELATIONSHIP

ORA_BILL_TO_
RELATIONSHIP

ORA_RECIPROCAL _
RELATIONSHIP

ORA_CURRENT_YEAR

ORA_LAST_YEAR

ORA_ITEM
ORA_ALL_ITEMS

ORA_ITEM_CATEGORY

ORA_SUPPLIER

ORA_CUSTOMER

LINE - Single line

ALL
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Lookup Type
ORA_CIJM_DISTRIBUTION_

TYPE

ORA_CIJM_DOCUMENT_
TYPE

ORA_CIM_ESS_PARAM_
PROCESS_MODE

ORA_CIM_GEN_SUP_CLM_
DATE_TYPE

ORA_CIM_INITIATED_BY

ORA_CIM_ITEM_LEVEL

ORA_CIM_ITEM_VAL_
ORG_SETUP_IN

ORA_CIM_LINE_
DISCOUNT_TYPE

ORA_CIM_LINE_SOURCE_
TYPE

ORA_CIM_LS_QUALIFIER

ORACLE

Meaning

Product Distribution Type

Channel Document Type

Program Process Mode

Date Type for Generate
Supplier Claims

Initiated By

Channel Program Item
Level

Applications with the item
validation organization
setting

Line Discount Type

Claim Line Source Type

Lump Sum Program
Qualifier

Description

List of product distribution
types supported in the
lump sum program.

Indicates the document
type.

Indicates whether the
program runs in preview
mode or update mode.

Indicates the date type
used for identifying eligible
accruals in the Generate
Supplier Claims scheduled
process.

Indicates whether the
program is created by an
internal or external user.

List of item levels
supported in the channel
program. For example, ltem
or All ltems.

List of applications from
where channel retrieves the
item validation organization
setting.

Discount types supported
in the channel program. For
example, amount, percent,
or new cost.

List of line source types
supported in the channel.

List of qualifiers supported
in Lump Sum programs.
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Lookup Configuration
Level

System

System

System

System

System

Extensible

System

System

System

System

Lookup Codes

ORA_EVEN
ORA_AMOUNT

ORA_PERCENT

ORA_RECEIVING_TRX

PREVIEW - In preview
mode, the program reports
the accounting exceptions.
UPDATE - In update mode,
the program sweeps the
unaccounted channel
transactions.

ACCT_DATE

REQ_ACCT_DATE

ORA_CIM_INTERNAL

ORA_CIM_EXTERNAL

ALL_ITEMS

ITEM

ORA_RECEIVABLES

ORA_PRICING

DISCOUNT_AMOUNT
DISCOUNT_PERCENT
NEW_COST

NEW_PRICE

PROGRAM

ORA_BILL_TO_
CUSTOMER_ACCOUNT
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Lookup Type

ORA_CIM_MANUAL_ADJ_

STATUS

ORA_CIM_MASS_
SETTLEMENT_METHOD

ORA_CIJM_ORDER_GL_
POST_PHASE

ORA_CIM_PGM_CHKBK_
TYPE

ORA_CIM_PRICING_APP_
DATE_TYPE

ORA_CIM_PROG_ITEM_
LEVEL

ORA_CIJM_PROGRAM_
STATUS

ORA_CIJM_PROGRAM_
TYPE

ORACLE

Meaning

Manual Adjustment Status

Channel Claim Mass
Settlement Method

Order Line Phase to Create

GL Entries

Type of Data Shown in
Program Checkbook

Channel Program
Application Date Type

Item Level for Product
Rules

Channel Program Statuses

Channel Program Template

Description

List of statuses supported
in the manual adjustment.

List of settlement methods
supported in the mass
settle page.

Order line phase at which
GL entries are created.

Indicates whether to show
customer balances, bill to
balances, or total balances.

Sales order date type used
for evaluating channel
program eligibility.

Item levels supported in
product rules evaluated
in Channel Revenue
Management.

List of statuses supported
in the channel program.

List of program templates
supported in Channel
Revenue Management.
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Lookup Configuration
Level

System

Extensible

System

System

System

System

System

System

Lookup Codes

APPROVAL_PENDING
APPROVAL_REJECTED
APPROVED

OPEN

SUCCESSFUL

ORA_CIM_CREDIT_MEMO

ORA_CIM_WRITE_OFF

INVOICED

ORA_CUSTOMER_BAL
ORA_BILL_TO_BAL

ORA_TOTAL_BAL

ORDERED_DATE

REQ_SHIP_DATE

ORA_ALL_ITEMS
ORA_ITEM

ORA_ITEM_CATEGORY

ACTIVE
APPROVAL_PENDING
APPROVAL_REJECTED
DRAFT

TERMINATED
SUPPLIER_DRAFT
DECLINED
SUPPLIER_ANNUAL _
PROGRAM

SUPPLIER_SHIP_AND_
DEBIT

SUPPLIER_REBATE
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Lookup Type

ORA_CIJM_PROGRAM_
TYPE_STATUS

ORA_CIJM_QUALIFIER_
OPERATOR

ORA_CIM_QUALIFIER_
TYPE

ORA_CIM_SALES_
METHOD

ORA_CIM_SETTLEMENT_
DOC_TYPE

ORA_CIM_SETTLEMENT_
METHOD

ORACLE

Meaning

Channel Program Type
Statuses

Quialifier Operator

Channel Program Qualifier

Sales Method

Settlement Document Type

Channel Claim Settlement
Method

Description

List of statuses supported
in the channel program

type.

List of operators supported
while adding qualifiers in
channel.

List of qualifiers supported
in Channel Revenue
Management.

Source of sales for which
a rebate program is
applicable. For example,
Direct or Indirect.

Indicates whether the
settlement document line is
a transaction or instrument.

List of settlement methods
supported in channel
claims.
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Lookup Configuration
Level

System

System

Extensible

System

System

Extensible

Lookup Codes

CUSTOMER_REBATE
CUSTOMER_LUMP_SUM

CUSTOMER_ANNUAL _
VOLUME

CUSTOMER_ANNUAL _
coop

CUSTOMER_VOLUME

ACTIVE
CLOSED
DRAFT

PREDEFINED

E(=)
NE (<>)

BILL_TO_CUSTOMER_ID
ORDER_TYPE
SALESPERSON_ID
SOLD_TO_PARTY_ID
SHIP_TO_PARTY_SITE_ID
SALESPERSON_ID

ORA_WAREHOUSE

B - Both

D - Direct

TRANSACTION

INSTRUMENT

AP_DEBIT
AP_DEFAULT
CM_ON_ACCOUNT
CM_ON_INVOICE

PRE_OPEN_CREDIT
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Lookup Type

ORA_CIM_STLMNT_
INSTRUMENT_TYPE

ORA_CIM_SUP_RBT_DISC_
TYPE

ORA_CIM_SUP_RBT_
EARN_ACCR_EVT

ORA_CIM_SUP_RBT_NEW_
PRIC_BASIS

ORA_CIM_SUP_RBT_
PERCENT_BASIS

ORA_CIM_SUP_REBATE_
DATE_QUALFR

ORA_CIM_SUP_REBATE_
QUAL

ORACLE

Meaning

Settlement Instrument Type

Discount Type for Supplier
Rebates

Event for Triggering Earned
Accrual for Supplier Rebate

New Price Basis for Supplier
Rebates

Percent Basis for Supplier
Rebates

Date Quialifier for Supplier
Rebates

Quialifier Type for Supplier
Rebates

Description

List of instrument types
supported in customer
claim settlements.

Discount types supported
in supplier rebate
programs.

Indicates the event for
triggering supplier rebate
accrual.
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Lookup Configuration
Level

System

System

System

List of pricing bases for new Extensible

price supported in supplier
rebate programs.

List of pricing bases for
percent supported in
supplier rebate programs.

Indicates the date qualifiers
supported in supplier
rebates.

List of qualifiers supported
in supplier rebate
programs.

Extensible

System

Extensible

Lookup Codes

ON_ACCOUNT_INV
OPEN_DED
OPEN_OPM
WRITE_OFF
ORA_CHARGEBACK
ORA_CHECK

ORA_AP_DEFAULT

ORA_INVOICE

ORA_DISCOUNT_PERCENT
ORA_DISCOUNT_AMOUNT
ORA_NEW_PRICE
ORA_CIM_ACCR_EVT_
RECEIPT
ORA_CIM_ACCR_EVT_
SUPPL_INVOICE

ORA_PO_LINE_UNIT_PRICE

ORA_PO_LINE_UNIT_PRICE

PO_DATE
RECEIPT_TRX_DATE
REQ_DELIVERY_DATE
REQ_SHIP_DATE
SHIPPED_DATE

SUPPLIER_INVOICE_DATE

ORA_BILL_TO_LOCATION

ORA_SHIP_TO_LOCATION
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Lookup Type

ORA_CIM_SUPPLIER_INV_
REASON

ORA_CIM_TIER_CALC_

METHOD

ORA_CIM_TIER_TYPE

ORA_CIM_TRANSACTION_
TYPE

ORA_CIM_USER_STATUS_
FOR

ORA_CIM_YES_NO

Meaning

Reason for Supplier Invoice
Correction

Tier Calculation Method

Channel Program Tier Type

Channel Transaction Type

User Status For

Generic Yes or No List of
Values

Description

List of reasons for
correcting an invoice.

List of tier calculation
methods supported in
programs.

Tier types supported in the
channel program.

List of transaction types
supported in channel.
For example, Accrual or
Adjustment.

Indicates channel object
type for which the user
status is created.

Generic Yes or No list of
values.

Manage Channel Profile Options

Chapter 12
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Lookup Configuration
Level

Extensible

System

System

System

System

System

Here you can view and manage profile options for Channel Revenue Management.

1. In the Setup and Maintenance work area, go to:

o Offering: Order Management/Procurement

o Functional Area: Channel Revenue Management/Supplier Incentives

o Task: Manage Channel Profile Options

ORACLE

Lookup Codes

ORA_TRANSACTION_
REASON

ORA_RETROSPECTIVE

ORA_STEPPED

ORA_QUANTITY
ORA_AMOUNT
ORA_SALES
ACCRUAL

ADJUSTMENT

CLAIM
PROGRAM
PROGRAM_TYPE

ADJUSTMENT

Y - Yes

N - No
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2. Onthe Manage Channel Profile Options page:

o The Search Results: Profile Option section displays details of the profile option code, the profile display
name, the application and its module that uses the profile option, the start and end dates, and the
description of the profile option that you search for.

o The Profile Option: Profile Values section displays the profile level set for the profile option.

List of Channel Profile Options

This table lists the profile options available for Channel Revenue Management.

Profile Display Name Profile Option Code Description

Channel Currency Conversion Type CIM_CURRENCY_CONVERSION_TYPE Use this option to specify the conversion rate
type to be used during currency conversions at
the site level.

Credit Method for Installments ORA_CIJM_AR_CR_MTHD_FOR_INSTL For Deductions and Settlement

Use this option to specify how installments
must be credited in Receivables for transactions
with multiple installments, when settling with
the settlement method Credit Memo - On
Invoice. This option is for the site level. Values
can be:

«  FIFO: First in First Out. Credits the first
installment first.

« LIFO: Last In First Out. Credits the last
installment first.

- Prorate: Credits the installments of the
credited transactions and prorate them
based on the amount remaining for each
installment.

Credit Method for Accounting Rules ORA_CIJM_AR_CR_MTHD_FOR_RULE For Deductions and Settlement

Use this option to specify how the accounting
entries must be reversed in Receivables by the
settlement method Credit Memo - On Invoice, if
accounting rules are used. This option is for the
site level. Values can be:

- LIFO: Last In First Out. Starts from the last
accounting period and reverses all prior
periods till the credit memo is used up.

- Prorate: Credits an equal percentage to all
the account assignments for the invoice.

- Unit: Reverses revenue for the number of
units specified in the original invoice line.

Calendar Year Filter in Available Accruals Search. ORA_CIJM_AVAIL_ACCR_CAL_YEAR_FILTER Use this option to specify the calendar year
filter used to search available accruals. This
option can be used at the site or user levels.
The default value is set at the site level.
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Profile Display Name

Group by in Available Accruals Search

Minimum Number of Days of Receipt Data for
Initial Load

ORACLE

Profile Option Code

ORA_CIM_AVAIL_ACCR_GROUP_BY

ORA_CIM_MIN_DAYS_INITIAL_LOAD_RECEIPT
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Description

Use this option to specify the association type
used to group results in the available accruals
search. This profile can be used at the site or
user levels. The default value is set at the site
level.

For Supplier Rebates

Use this option to specify the number of days
of receipt data that must be processed in

the initial (first) run of the Load Transactions
process at the site level. When:

N = Minimum Number of Days of Receipt Data
For Initial Load

D1 = Start date of the active program with the
earliest start date.

D2=D1-N

- If D2 <= Today's date, the initial start date
for Load Transactions is D2.

- If D2 > Today's date, the initial start date
for Load Transactions is Today - N days.

- If there are no active programs, the initial
start date for Load Transactions is Today -
N days.

- Default value for Minimum Number of
Days of Receipt Data For Initial Load is set
as 30 days, if the profile value is cleared or
a negative value is entered.

The profile option is used to determine how

far back in days your implementation wants to
collect receiving transactions from when you
first execute the Load Transactions process.
This profile is only used the first time you run
the Load Transactions scheduled process. After
the first run, the application tracks when the
process was last performed. So from the next
run onward, it collects only the new receiving
transactions.

For example, if you're running the first Load
Transactions process on Dec 14th and the
implementation wants to bring in 1 month of
transactions prior to a Jan 1st go-live date,

then your initial load on Dec 14th should set
Minimum Number of Days of Receipt Data from
Initial Load to 14 days.
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Manage Channel Messages

Here you can view, edit, and add new messages for Channel Revenue Management.

1. In the Setup and Maintenance work area, go to:

o Offering: Order Management/Procurement
o Functional Area: Channel Revenue Management/Supplier Incentives
o Task: Manage Channel Messages
2. Onthe Manage Channel Messages page, you can search for, and edit existing messages, or create your custom
messages.

Note: Before creating a new message, check the existing messages to see if it meets your need.

3. To create a new message, click the New icon, or select New from the Actions drop-down list.
4. Onthe Create Message page, enter you message details. The following attributes are required:

Attribute Description

Message Name Enter a unique name with the format: APPLICATIONSHORTNAME_LBA/SUB-LBA_MESSAGE
DESCRIPTION. For example, CJM_ADJ_SUP_ATRIB_NO_INPUT. Use all uppercase letters, and
don't use symbols.

o Don'tinclude spaces within the name, or at the start or end of the name. Use underscore
characters to separate parts of the message name.

o Don'tinclude message numbers in the name.

Application Channel Revenue Management

Module Select the area for which the message is created. For example, common.
Message Type Select the type of the message, for example, error, warning and so on.
Short Text Enter the message that you want to use.

5. If you're using tokens, in the Message Tokens area, select New and add the token details. A token is a
placeholder for variable content, such as text or a number. Channel Revenue Management replaces the token
with the value at runtime.

6. Click Save and Close.

For more information, see the Configuring and Extending Applications guide for Oracle Applications Cloud.
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Manage Channel Descriptive Flexfields

Here you can view and manage descriptive flexfields for Channel Revenue Management.

1. In the Setup and Maintenance work area, go to:

o Offering: Order Management/Procurement

o Functional Area: Channel Revenue Management/Supplier Incentives

o Task: Manage Channel Descriptive Flexfields

2. Onthe Manage Descriptive Flexfields page, search for the Channel flexfield.

Channel Descriptive Flexfields

These DFFs are available to manage additional information for Channel Revenue Management.

Name

Channel Program Header DFF

Channel Program Product Rules

Channel Claim Header DFF

Customer Claim Header DFF

Channel Document Header DFF.

Channel Document Line DFF

Related Topics

« Overview of Flexfields

ORACLE

Flexfield Code

CIJM_PROGRAMS

CIM_PROGRAM_ PRODUCT_RULES

CIM_CLAIMS

CCIM_CUSTOMER_CLAIMS

CIJM_DOCUMENT_HEADER_DFF

CIM_DOCUMENT_LINE_DFF

Description

Fields for additional information about the
channel program header.

Fields for additional information about a
product rule of a channel program.

Fields for additional information about the
channel claim header.

Fields for additional information about the
customer claim header.

Fields to capture additional information about
the channel document header.

Fields to capture additional information about
the channel document line.
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15 Set Up Import

Import Customer Invoices

You can import customer invoices from CSV files into Channel Revenue Management using the Import Management
application.

Import Management can be accessed from Tools > Import Management.

Consideration: If you import sales invoices via the CSV file (Batch Transaction Type = ORA_SALES_ORDER_CSV), then
you must first import the CSV file, and then schedule the Create Accruals for Channel Batch process to create accruals.

Input CSV file

;
CX Import

[ Channel Revenue
Import e Management
\ Interface

[ Channel Revenue

Errors? NOr—— ocment Batches,
. _ | \ Header and Lines |
\ / I A
I
Yes_y
b e e e l _________ I l
Errar CSV file Rejected CSV file

How to Handle Errors

Here are some tips to handle errors that may occur during the import process:

- The import process provides you with an error.csv file and a reject.csv file for a given import. All the errors are
in the error.csv file. The reject.csv file is a copy of your source CSV with additional columns with error messages.

- Correct the errors in the reject.csv file. Remember to remove the first and last columns and save as a new CSV
file.

Import the new CSV file.

Note: You must fix all the errors in the CSV file before rerunning the import. A batch is created only if there are no
validation errors.
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Attributes Required from Oracle Fusion Cloud Applications

You must set up these attributes that are part of various Oracle Fusion Cloud applications for importing sales invoices.

Application

HR foundation in HCM

Financials foundation

Product Information Management
Product Information Management

Pricing

Receivables

TCA

TCA

TCA

Order Management
Order Management
Receivables
Receivables

Inventory

Sales Invoice Attributes

Attribute

Business Unit
Currency
Item

UoM

Item Validation Organization (Pricing
Parameter)

Bill-to Customer, Account and Site
Ship-to Customer, Site

Sold-to Customer

Salesperson

Sales Order Type

Sales Order Line Type

Sales Invoice Type

Sales Invoice Line Type

Warehouse

Required?

Yes
Yes
Yes
Yes

Yes

Yes
Yes
Yes
Yes, if specified in the CSV file
Yes, if specified in the CSV file
Yes, if specified in the CSV file
Yes, if specified in the CSV file
Yes, if specified in the CSV file

Yes, if specified in the CSV file
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You must use Channel Batch Transaction as the import object. The attribute Batch Transaction Type is a required
attribute. For sales invoices, it's ORA_SALES_ORDER_CSV. You can either download the Channel Batch Transaction
template or map your template against the attributes in the Channel Batch Transaction object. The following attributes

are available for sales invoices:

Display Name

Batch Transaction Type

Bill of Lading

ORACLE

Attribute Name

BatchTransactionType

BillOfLadingNumber

Description

The transaction type
used to categorize the
transaction data in the
batch.

A carrier's contract and
receipt for the goods

that the carrier agrees to
transport from a specific
origin address to a specific
destination address.

Required

Yes

Validated

Yes

No
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Display Name

Bill-to Account

Bill-to Account ID

Bill-to Account Site

Bill-to Account Site ID

Bill-to Customer

Bill-to Customer ID

Bill-to Customer Registry ID

Business Unit

Business Unit ID

Comments

Currency

ltem

Item Description

Item ID

Line Comments

Original Sales Order Line

Number

Original Sales Order
Number

Original System Line
Reference

Original System Reference

ORACLE

Attribute Name

BillToAccount

BillToAccountID

BillToAccountSite

BillToAccountSitelD

BillToCustomer

BillToCustomerID

BillToCustomerRegistrylD

BusinessUnit

BusinessUnitld

Comments

Currency

[temNumber

ltemDescription

ltemID

LineComments

OriginalSalesOrderLineNum

OriginalSalesOrderNumber

OriginalSystemLineReferenc

OriginalSystemReference

Description

The account number of the
bill-to customer.

The unique identifier for
the bill-to account.

Indicates the unique user-
friendly identifier of the
customer account site.

Indicates the unique
identifier of the customer
account site.

The name of the bill-to
customer.

The unique identifier for
the bill-to customer.

The user-friendly unique
identifier for the bill-to
customer.

The business unit for the
transaction.

The unique identifier for
the business unit.

The comments for the
transaction.

The currency code for the
transaction.

The inventory item number.

The description for the
item.

The unique identifier for
the inventory item.

The comments for the
transaction line.

The line number for the
original sales order line.

The sales order number for
the original sales order.

The original document
reference for the
transaction line in the
external system.

The original document
reference for the
transaction in the external
system.

Required

Conditional

Conditional

Conditional

Conditional

Conditional

Conditional

Conditional

Conditional

Conditional

Yes

Conditional

Conditional

Validated

Yes

Yes

Yes

Yes

Yes

Yes

Yes

Yes

Yes

No

Yes

Yes

No

Yes

No

No

No

No

No
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Display Name

Original System Source
Purchase Order Line
Number

Purchase Order Number

Requested Arrival Date

Requested Ship Date

Sales Invoice Date

Sales Invoice Line Number

Sales Invoice Line Type

Sales Invoice Number

Sales Invoice Type

Sales Order Date

Sales Order Line Number

Sales Order Line Type

Sales Order Number

Sales Order Type

Salesperson

Salesperson ID

Salesperson Number

ORACLE

Attribute Name

OriginalSystemSource

PurchaseOrderLineNumber

PurchaseOrderNumber

RequestedArrivalDate

RequestedShipDate

SalesInvoiceDate

SaleslnvoiceLineNumber

SalesInvoiceLineType

SalesInvoiceNumber

SalesInvoiceType

SalesOrderDate

SalesOrderLineNumber

SalesOrderLineType

SalesOrderNumber

SalesOrderType

Salesperson

SalespersonID

SalespersonNumber

Description

The name of the system
source.

The unique identifier for
the purchase order line.

The purchase order
document number.

The original date the
customer requested the
item arrive on.

The original date the
customer requested the
item ship on.

The date that appears on a
customer invoice.

The unique identifier for
the invoice line.

Indicates whether the
invoice line corresponds
to an item, tax, freight, or
miscellaneous.

The invoice number for the
customer invoice.

The invoice type for the
invoice.

The ordered date on the
sales order.

The unique identifier for
the sales order line.

Defines the system
behavior for the order line
transaction.

The identifier for the sales
order.

The name of the type of
order that was placed.

The person who is engaged
in the sale of goods and
services.

The unique identifier for
the salesperson.

The unique user-friendly
number that is associated
with the salesperson.

Required

Yes

Yes

Yes

Yes

Yes

Yes

Yes

Validated

No

No

No

No

No

No

No

Yes

No

Yes

No

No

Yes

No

Yes

Yes

Yes

Yes
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Display Name

Shipment Number

Shipped Date

Shipped Quantity

Shipped UOM

Ship-to Customer

Ship-to Customer ID

Ship-to Customer Registry
ID

Ship-to Site

Ship-to Site ID

Sold-to Customer

Sold-to Customer ID

Sold-to Customer Registry
ID
Sold-to Site

Sold-to Site ID

Unit List Price

Unit Selling Price

Warehouse Code

Warehouse ID

ORACLE

Attribute Name

ShipmentNumber

ShippedDate

ShippedQuantity

ShippedUOM

ShipToCustomer

ShipToCustomerID

ShipToCustomerRegistrylD

ShipToSite

ShipToSitelD

SoldToCustomer

SoldToCustomerID

SoldToCustomerRegistrylD

SoldToSite

SoldToSitelD

UnitListPrice

UnitSellingPrice

WarehouseCode

WarehouselD

Description

The unique identifier of a
shipment.

The date the shipment was
actually sent.

The quantity of goods or
services that was shipped
by supplier.

The unit of measure for
the shipped quantity. UOM
stands for Unit of Measure.

The name of the ship-to
customer.

The unique identifier for
the ship-to customer.

The user-friendly unique
identifier for the ship-to
customer.

The unique user-friendly
address identifier for the
ship-to customer.

The unique address
identifier for the ship-to
customer.

The name of the sold-to
customer.

The unique identifier for
the sold-to customer.

The user-friendly unique
identifier for the sold-to
customer.

The unique user-friendly
address identifier for the
sold-to customer.

The unique address
identifier for the sold-to
customer.

The base selling price
before applying discounts.

The price per unit that a
buyer paid for an item.

The unique alphanumeric
identifier for the inventory
organization.

The unique identifier for
the warehouse that is

Required

Yes

Yes

Conditional

Conditional

Conditional

Conditional

Conditional

Conditional

Conditional

Conditional

Yes

No

No

Validated

No

No

No

Yes

Yes

Yes

Yes

Yes

Yes

Yes

Yes

Yes

Yes

Yes

No

No

Yes

Yes
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Attribute Name

Display Name

Waybill WaybillNumber

Channel Document Header = Based on setup
DFF

Channel Document Line Based on setup
DFF

evaluated.

Qualifiers for Sales Invoice

Here's the list of qualifiers for sales invoices

- Order Date

- Invoice Date

- Actual Ship Date

- Requested Ship Date

- Requested Arrival Date

« Customer

ORACLE

Description Required

used to ship items from or
receive items into.

The non-negotiable -
document describing the
contract for transporting
cargo.

The fields to capture
additional information
about the channel
document header.

Based on setup

Note: If a DFF attribute
is populated in the csv
but not configured

in the DFF, it will get
copied to the document
transaction without
validation.

The fields to capture -
additional information

about the channel

document line.

Note: If a DFF attribute
is populated in the csv
but not configured

in the DFF, it will get
copied to the document
transaction without
validation.

Chapter 13
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Validated

No

Yes

Note: When both ID and Name values are available, for example, BusinessUnitld and BusinessUnit, the ID value is

Note: The combination of Batch Transaction Type, Business Unit ID, Original System Source, Sales Order Line
Number, and Sales Order Number must be unique.
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Bill To

- Ship To

- Order Type

« Order Line Type

- Salesperson

- Warehouse

- Channel Document Header DFF (only for csv integration)

- Channel Document Line DFF (only for csv integration)

Mapping between Customer Qualifiers in Customer Rebate and Attributes
in CSV

Customer Qualifier in Customer Name in Channel Batch Accounts Receivable Transaction Accounts Receivable
Rebate Transaction Template CSV File Ul receivablesinvoices REST API
Customer Bill-to Account Bill-to Account Number BillToCustomerNumber
Bill To Bill-to Account Site Bill-to Site BillToSite
Ship To Ship-to Site Ship-to Site ShipToSite
Related Topics

- How do | import data?
« How do | map import fields?
« Overview of Import Queues

Import Supplier Invoices

You can import supplier invoices from CSV files into Channel Revenue Management using the Import Management
application. Import Management can be accessed from Tools > Import Management.

Consideration: If you import supplier invoices via a CSV file (Batch Transaction Type = ORA_SUPPLIER_INVOICE_CSV),
then import the CSV file once, and then schedule 2 processes to create accruals (for example, Create Accruals for
Channel Batch and Create Accruals for Volume Programs).
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Rejected CSV file

‘ Error CSV file

How to Handle Errors

Here are some tips to handle errors that may occur during the import process:

1. The import process provides you with an error.csv file and a reject.csv file for a given import. All the errors are
in the error.csv file. The reject.csv file is a copy of your source CSV with additional columns with error messages.

2. Correct the errors in the reject.csv file. Remember to remove the first and last columns and save as a new CSV
file.

3. Import the new CSV file.

Note: You must fix all the errors in the CSV file before rerunning the import. A batch is created only if there
are no validation errors.

Attributes Required from Oracle Fusion Cloud Applications

You must set up these attributes that are part of various Oracle Fusion Cloud applications for importing supplier
invoices.

This table contains all the required attributes that must be set up in various Oracle Fusion Cloud applications, for
importing supplier invoices using CSV files.
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Application

HR foundation in HCM

HR foundation in HCM

HR foundation in HCM

HR foundation in HCM

Financials foundation

Product Information Management

Product Information Management

Product Information Management

Inventory Management

Procurement

Procurement

Procurement

Procurement

Payables Invoices

Receiving

Receiving or Inventory

Attribute

Business Unit

Bill-to Location

Ship-to Location

Receiving Location

Currency

ltem

Supplier Item

UuoMm

Receiving Inventory Org

Supplier

Supplier Site

Procurement BU

Item Validation Org

(Configure the Procurement Business Function

for Procurement BU)

Invoice Type

Transaction Type

Transaction Reason

Supplier Invoice Attributes

You must use Channel Batch Transaction as the import object. The attribute Batch Transaction Type is a required
attribute. For supplier invoices, it's ORA_SUPPLIER_INVOICE_CSV. You can either download the Channel Batch
Transaction template or map your template against the attributes in the Channel Batch Transaction object. These
attributes are available for supplier invoices.

This table contains all the attributes that are available for supplier invoice import

ORACLE

Required?

Yes

Yes, if specified in the CSV file

Yes, if specified in the CSV file

Yes, if specified in the CSV file

Yes

Yes

Yes, if specified in the CSV file

Yes

Yes, if specified in the CSV file

Yes

Yes

Yes, if specified in the CSV file

Yes

Yes

Yes, if specified in the CSV file

Yes, if specified in the CSV file

Chapter 13
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Attribute Name Display Name Description Required? Validated?
BatchTransactionType Batch Transaction Type The transaction type Yes Yes
used to categorize the
transaction data in the Value is from the lookup
batch. ORA_CIM_BATCH_DATA_
SOURCE
BusinessUnit Business Unit The business unit for the Conditional Yes
transaction.
BusinessUnitld Business Unit ID The unique identifier for Conditional Yes
the business unit.
Comments Comments The comments for the No No
transaction.
Currency Currency The currency code for the Yes Yes
transaction.
[temNumber ltem The inventory item number.  Conditional Yes
ItemDescription Item Description The description for the No No
item.
ltemID ltem ID The unique identifier for Conditional Yes
the inventory item.
LineComments Line Comments The comments for the No No
transaction line.
OriginalReceivingTransactio Original Receiving The unique identifier for No No
Transaction Number the original transaction
associated with the
receiving line.
OriginalSupplierlnvoiceLinel Original Supplier Invoice The line number for the No No
Line Number original supplier invoice
line.
OriginalSupplierlnvoiceNum  Original Supplier Invoice The supplier invoice No No
Number number for the original
supplier invoice.
OriginalSystemLineReferenc Original System Line The original document No No
Reference reference for the
transaction line in the
external system.
OriginalSystemReference Original System Reference = The original document No No

ORACLE

reference for the
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Attribute Name

OriginalSystemSource

ProcurementBusinessUnit

ProcurementBusinessUnitld

PurchaseOrderBillToLocatior

PurchaseOrderBillToLocatior

PurchaseOrderDate

PurchaseOrderLineNumber

PurchaseOrderLineRequeste

PurchaseOrderLineRequeste

PurchaseOrderLineShipToLc

PurchaseOrderLineShipTolLc

PurchaseOrderNumber

ReceiptBillOfLadingNumber

ORACLE

Display Name

Original System Source

Procurement Business Unit

Procurement Business Unit
ID

Purchase Order Bill-to
Location Code

Purchase Order Bill-to
Location ID

Purchase Order Date

Purchase Order Line
Number

Purchase Order Line

Requested Delivery Date

Purchase Order Line
Requested Ship Date

Purchase Order Line Ship-
to Location Code

Purchase Order Line Ship-

to Location ID

Purchase Order Number

Receipt Bill of Lading

Description

transaction in the external
system.

The name of the system
source.

The procurement business

unit on the purchase order.

The unique identifier for
the procurement business

unit on the purchase order.

The unique identifier for
the bill-to location.

The unique identifier of
the address for the bill-to
location.

The date on which the
purchase order was
communicated to the
supplier.

The unique identifier for
the purchase order line.

The date by which the
buyer has requested
delivery of a line item by
the supplier.

The date by which the
buyer asked suppliers
to ship goods from their
location.

The unique identifier for
the ship-to location.

The unique identifier of
the address for the ship-to
location.

The purchase order
document number.

A carrier's contract and
receipt for the goods

Required?

Yes

No

No

No

No

No

No

No

No

No

No

No

No

Chapter 13
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Validated?

No

Yes

Yes

Yes

Yes

No

No

No

No

Yes

Yes

Yes

No

209



SCM Cloud

Implementing Channel Revenue Management

Attribute Name

ReceiptNumber

ReceiptShipmentNumber

ReceiptShippedDate

ReceiptWaybillNumber

ReceivingInventoryOrganiza'

ReceivingInventoryOrganiza’

ReceivinglLocationCode

Receivinglocationld

Display Name

Receipt Number

Receipt Shipment Number

Receipt Shipped Date

Receipt Waybill

Receiving Inventory
Organization Code

Receiving Inventory

Organization ID

Receiving Location Code

Receiving Location ID

Description

that the carrier agrees to
transport from a specific
origin address to a specific
destination address.

The number that
acknowledges that a
shipment was received in
the warehouse.

A shipment from one
supplier that can include
several items ordered on
many purchase orders.

The date when goods or
services were shipped by
the supplier.

The non-negotiable
document describing the
contract for transporting
cargo.

The user-defined unique
code for the inventory
organization.

The unique identifier for

the inventory organization.

The unique identifier for
the receiving location.

The unique identifier for
the receiving location.

Required?

No

No

No

No

No

No

No

No

Chapter 13
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Validated?

No

No

No

No

Yes

Yes

Yes

Yes

ReceivingTransactionDate = Receiving Transaction Date = The date on which the No No

transaction was performed.

ReceivingTransactionNumbe Receiving Transaction
Number

The unique identifier for No No
the transaction associated
with the receiving line.

ReceivingTransactionReasor Receiving Transaction An explanation or No Yes
Reason justification that explains
why the transaction is
performed.

ReceivingTransactionReasor Receiving Transaction
Reason ID

The unique identifier for No Yes
the transaction reason.
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Attribute Name

ReceivingTransactionType

SupplierName

Supplierld

SupplierlnvoiceDate

SupplierinvoiceLineNumber

SupplierlnvoiceLineQuantity

SupplierlnvoiceLineReason

SupplierlnvoiceLineUnitPrice

SupplierlnvoiceLineUOM

SupplierlnvoiceNumber

SupplierinvoiceType

ORACLE

Display Name

Receiving Transaction Type

Supplier

Supplier ID

Supplier Invoice Date

Supplier Invoice Line
Number

Supplier Invoice Line
Quantity

Supplier Invoice Line
Reason

Supplier Invoice Line Unit
Price

Supplier Invoice Line UOM

Supplier Invoice Number

Supplier Invoice Type

Description

The transaction type
used to categorize the
transaction.

The organization or
individual that provides
goods or services to the
buying organization for
payment, bound by a
contractual obligation.

The unique identifier for
the supplier.

The invoice date of the
supplier invoice.

The line number for the
supplier invoice line.

The quantity for the
supplier invoice line.

An explanation or
justification that explains
why the transaction is
performed.

The unit price for the
supplier invoice line.

The unit of measure for the
supplier invoice line. UOM
stands for Unit of Measure.

The supplier invoice
number for the supplier
invoice.

The supplier invoice type
for the supplier invoice.

Required?

No

Conditional

Conditional

Yes

Yes

Yes

No

Yes

Yes

Yes

Yes
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Validated?

Yes

Value is from the
Receiving lookup RCV_
TRANSACTION_TYPE.

Yes

Yes

No

No

No

No

No

Yes

No

Yes

Values are from the
Payables lookup type
INVOICE TYPE, lookup code
STANDARD, CREDIT, and
DEBIT. The reference data
set is Common.
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Attribute Name

SupplierltemNumber

Supplierltemid

SupplierNumber

SupplierSite

SupplierSiteld

Channel Document Header
DFF

Channel Document Line
DFF

evaluated.

ORACLE

Display Name

Supplier Item

Supplier Item ID

Supplier Number

Supplier Site

Supplier Site ID

Based on setup

Based on setup

Description Required?

The supplier item number No

from the purchase order

shipment line.

The unique identifier for No

the supplier item.

The unique identifier of the Conditional
supplier assigned by the
buying organization.

The entity that models how Conditional

the buying organization

conducts business with the
supplier.

The unique identifier for Conditional

the supplier site.

The fields to capture Based on setup
additional information
about the channel

document header.

Note: If a DFF attribute
is populated in the csv
but not configured

in the DFF, it will get
copied to the document
transaction without
validation.

The fields to capture
additional information
about the channel
document line.

Note: If a DFF attribute
is populated in the csv
but not configured

in the DFF, it will get
copied to the document
transaction without
validation.
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Validated?

Yes

Yes

Yes

Yes

Yes

Yes

Note: When both ID and Name values are available, for example, BusinessUnitld and BusinessUnit, the ID value is

Note: The combination of Batch Transaction Type, Business Unit ID, Original System Source, Supplier Invoice Line
Number, Supplier Invoice Number, and Supplier Site ID must be unique.
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Qualifiers for Supplier Invoice

Here's the list of qualifiers for supplier invoices

« Purchase Order Date

- Requested Delivery Date
- Requested Ship Date

« Supplier Invoice Date

- Receipt Transaction Date
- Transaction Reason

- Bill-to Location

« Ship-to Location

« Channel Document Header DFF (only for csv integration)

« Channel Document Line DFF (only for csv integration)

Chapter 13
Set Up Import

Note: Only global segment descriptive flexfields are supported as program qualifiers, not context-based
segments. However, your implementation can import context-based segments if it doesn't use them as

qualifiers.

Related Topics

« Create Accruals from Imported Supplier Invoices

- How do | import data?
« How do | map import fields?
« Overview of Import Queues

Privileges for Import

You must assign these privileges to users to enable them to use the Import Management application to import data
from CSV files into Channel Revenue Management.

This table contains the privileges required for a channel user to import data using CSV files.

Privilege Name

View Channel Batch
Transaction File Import
Activity Object Type Data

View Channel Batch
Transaction File Import
Mapping Object Type Data

ORACLE

Code

CIM_VIEW_BATCH_TRX_
FILE_IMPORT_ACTIVITY_
OBJECT_TYPE_DATA

CIM_VIEW_BATCH_TRX_
FILE_IMPORT_MAPPING_
OBJECT_TYPE_DATA

Description

Allows viewing channel
batch transaction import
activities across the
enterprise.

Allows viewing channel
batch transaction import
mappings across the
enterprise.

Usage

Data

Data

Assigned To

Channel Integration
Specialist Duty

Channel Integration
Specialist Duty
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Privilege Name

View Channel Batch
Transaction File Import
Object Type Data

Run File Import Scheduler

Set Up File Import Activity

Set Up File Import Object
and Mapping

ORACLE

Code

CIM_VIEW_BATCH_TRX_
FILE_IMPORT_OBJECT_
TYPE_DATA

ZCA_RUN_FILE_IMPORT_

SCHEDULER

ZCA_SET_UP_FILE_
IMPORT_ACTIVITY

ZCA_SET_UP_FILE_
IMPORT_OBJECT_AND_
MAPPING

Description

Allows viewing channel
batch transaction import
objects across the
enterprise.

Allows scheduling and
monitoring the process
that schedules file import
activities.

Allows creating and
maintaining import
activities that contain
process criteria, file
mapping, and schedule
to import external files
containing business

objects, such as customers
and contacts, into staging

tables.

Allows creating and
maintaining import
activities that contain
process criteria, file
mapping, and schedule
to import external files
containing business

objects, such as customers
and contacts, into staging

tables.

Usage

Data

Function (Common CRM
Privilege)

Function (Common CRM
Privilege)

Function (Common CRM
Privilege)
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Assigned To

Channel Integration
Specialist Duty

Channel Integration
Specialist Duty

Channel Integration
Specialist Duty

Channel Integration
Specialist Duty
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14 Security

Deductions and Settlement

Business Functions

This topic lists the required business functions.

You must associate the Billing and Revenue Management business function with the business unit on the manual claim.

Roles and Duties

This topic describes roles and duties in Deductions and Settlement.

This table gives the job roles that can be assigned to your users:

Job Roles in Deductions and Settlement

Name Code Description
BPM Workflow System Admin Role BPMWorkflowAdmin BPM Workflow Administrator Application Role.
Channel Claims Manager ORA_CIM_CHANNEL_CLAIMS_MANAGER Individual responsible for creating, managing,

and approving customer claims.

This table gives the duty roles that can be assigned to your users:

Duty Roles in Deductions and Settlement

Name Code Description

Channel Administration ORA_CIM_CHANNEL_ADMINISTRATION_DUTY Manages channel setup and administration
tasks.

Channel Claims Management ORA_CIM_CHANNEL_CLAIMS_ Manages customer claims.

MANAGEMENT_DUTY

Channel Claims Viewing ORA_CIJM_CHANNEL_CLAIMS_VIEW_DUTY Views customer claims.
Channel Operations ORA_CIJM_CHANNEL_OPERATIONS_DUTY Manages execution of scheduled processes.
Channel Setup Viewing ORA_CIJM_CHANNEL_SETUP_VIEW_DUTY Views setups required for channel execution.

This includes viewing the setups for program
types, adjustment types and reasons, claim
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Name

For information, see:

Description

Chapter 14
Security

types and reasons, claim sources, and user

statuses.

- Role-Based Access Control, Oracle Fusion Applications Understanding Security guide

- Provisioning Roles to Application Users, Oracle SCM Cloud Securing SCM guide

Privileges

You can assign these privileges to your users based on their responsibilities.

Assign Privileges for Deductions and Settlement Users

This table gives the privileges your users require to perform various functions. It contains the names, codes, and
descriptions of the privileges that can be assigned to a channel user.

Privilege

Allow Claim Write-Offs

Approve Customer Claims

Create Accruals for Co-op
Programs

Create Customer Claims

ORACLE

Usage

Function

ul

Scheduled Process

ul

Code

CIM_ALLOW_CLAIM_
WRITE_OFFS_PRIV

CIM_APPROVE_
CUSTOMER_CLAIMS_PRIV

CIM_CREATE_ACCRUALS_
FOR_CO_OP_PROGRAMS

CIM_CREATE_CUSTOMER_
CLAIMS_PRIV

Description

Allows to write-off
deductions irrespective
of the write-off threshold
value.

If you haven't opted into
the Approve Customer
Claims with BPM Workflow
feature, then this privilege
allows viewing and
approval of customer
claims.

If you have opted into the
Approve Customer Claims
with BPM Workflow feature,
then this privilege allows
the approver to view all the
details of the claim in the
notification.

Allows submission of

the process that checks
eligibility for channel
document transactions
based on product rules and
creates aggregated channel
program accrual entries for
eligible transactions.

Enables creation of
customer claims.

Assigned to Role

Channel Claims
Management (Duty Role)

Channel Claims
Management (Duty Role)

Channel Operations (Duty
Role)

Channel Claims
Management (Duty Role)
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Privilege

Maintain Collections
Aging Buckets (Collections
privilege)

Manage Channel
Administration Using REST
Service

Manage Channel Claim

Reasons

Manage Channel Claim
Sources

Manage Channel Claim
Types

Manage Channel Customer
Claims using REST Service

Manage Channel Settings

Manage Channel Settings
using REST Service

Manage Channel User
Statuses

Manage Customer Claims

Manage Customer Trade
Profiles

ORACLE

Usage

ul

REST

Ul

ul

ul

REST

ul

REST

Ul

ul

Ul

Code

IEX_MAINTAIN_
COLLECTIONS_AGING_
BUCKETS_PRIV

CIM_MANAGE_CHANNEL _
ADMINISTRATION_REST_
SERVICE_PRIV

CIM_MANAGE_CHANNEL_
CLAIM_REASONS_PRIV

CIM_MANAGE_CHANNEL_
CLAIM_SOURCES_PRIV

CIM_MANAGE_CHANNEL _
CLAIM_TYPES_PRIV

CIM_MANAGE_CHANNEL_
CUSTOMER_CLAIM_REST_
SERVICE_PRIV

CIM_MANAGE_CHANNEL _
SETTINGS_PRIV

CIM_MANAGE_CHANNEL _
SETTING_REST_SERVICE_
PRIV

CIM_MANAGE_CHANNEL_
USER_STATUSES_PRIV

CIM_MANAGE_
CUSTOMER_CLAIMS_PRIV

CIM_MANAGE_
CUSTOMER_TRADE_
PROFILES_PRIV

Description

Allows a user to maintain
aging buckets.

Enables creation and
update of channel claim
sources, channel claim
types, channel adjustment
types, and channel user
statuses using REST
services.

Enables creation, update,
and viewing of channel
claim reasons.

Enables creation, update,
and viewing of channel
claim sources.

Enables creation, update,
and viewing of channel
claim types.

Enables creation, update,
and viewing of channel
customer claims using
REST service.

Enables creation, update,
and viewing of channel
settings.

Enables creation, update,
and viewing of channel
settings using REST
service.

Enables creation, update,
and viewing of channel
user statuses.

Enables update, and

viewing of customer claims.

Enables creation, update,
and viewing of customer
trade profiles.
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Assigned to Role

Channel Administration
(Duty Role)

Channel Administration
(Duty Role)

Channel Administration
(Duty Role)

Channel Administration
(Duty Role)

Channel Administration
(Duty Role)

Channel Claims
Management (Duty Role)

Channel Administration
(Duty Role)

Channel Administration
(Duty Role)

Channel Administration
(Duty Role)

Channel Claims
Management (Duty Role)

Channel Claims
Management (Duty Role)
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Privilege

Manage Customer Trade
Profiles using REST Service

Manage Scheduled Job
Definition

Reprocess Stalled Claims

Review Claim Write-Offs

Review Collections Aging
Buckets (Collections
privilege)

Settle Customer Claims

View Channel Claim
Reasons

View Channel Claim
Sources

View Channel Claim Types

View Channel Settings

View Channel User Statuses

View Customers

View Customer Claims

ORACLE

Usage

REST

Scheduled Process

Scheduled Process

Ul

ul

Scheduled Process

Ul

ul

Ul

Ul

Function

Ul

Code

CIM_MANAGE_
CUSTOMER_TRADE_
PROFILE_REST_SERVICE_
PRIV

FND_MANAGE_
SCHEDULED_JOB_
DEFINITION_PRIV

CIM_REPROCESS_
STALLED_CLAIMS_PRIV

CIM_REVIEW_CLAIM_
WRITE_OFFS_PRIV

IEX_REVIEW_
COLLECTIONS_AGING_
BUCKETS_PRIV

CIM_SETTLE_CUSTOMER_
CLAIMS_PRIV

CIM_VIEW_CHANNEL_
CLAIM_REASONS_PRIV

CIM_VIEW_CHANNEL _
CLAIM_SOURCES_PRIV

CIM_VIEW_CHANNEL _
CLAIM_TYPES_PRIV

CIM_VIEW_CHANNEL_
SETTINGS_PRIV

CIM_VIEW_CHANNEL _
USER_STATUSES_PRIV

AR_VIEW_CUSTOMERS_
PRIV

CIM_VIEW_CUSTOMER_
CLAIMS_PRIV

Description

Enables creation, update,
and viewing of customer
trade profiles using REST
service.

Manage the definition of a
Scheduled Job

Allows submission of the
process that reprocesses
claims stuck in update in
progress status.

Allows oversight of
systematic write-offs when
review of claim write-offs is
enabled.

Allows a user to see the
aged transactions for a
customer.

Allows submission of the
process that closes settled
customer claims.

Allows viewing of channel
claim reasons.

Allows viewing of channel
claim sources.

Allows viewing of channel
claim types.

Allows viewing of system
settings and their child
entities.

Allows viewing of channel
user statuses.

Allows the viewing of the
customer, account and the
site information.

Allows viewing of all
customer claims.
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Assigned to Role

Channel Claims
Management (Duty Role)

Channel Claims
Management (Duty Role)
Channel Operations (Duty

Role)

Channel Claims
Management (Duty Role)

Channel Administration
(Duty Role)

Channel Operations (Duty
Role)

Channel Setup Viewing
(Duty Role)

Channel Setup Viewing
(Duty Role)

Channel Setup Viewing
(Duty Role)

Channel Setup Viewing
(Duty Role)

Channel Setup Viewing
(Duty Role)

Channel Claims
Management (Duty Role)

Channel Claims Viewing
(Duty Role)
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Privilege

View Customer Trade
Profiles

View Only Activity

View Trading Community
Organization

Data Security

Usage

Ul

REST

Code

CIM_VIEW_CUSTOMER_
TRADE_PROFILES_PRIV

ZMM_VIEW_ONLY_
ACTIVITY_PRIV

HZ_VIEW_TRADING_
COMMUNITY_
ORGANIZATION_PRIV

Description

Allows viewing of customer
trade profiles and their
child entities.

Allows only viewing of
activities.

Allows exporting,
searching, and viewing of
organization details such as
addresses, classifications,
identifiers, and names.

Data security consists of controlling access to data through various policies.
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Assigned to Role

Channel Claims Viewing
(Duty Role)

Channel Claims
Management (Duty Role)

Channel Claims Viewing

(Duty Role)

Channel Claims
Management (Duty Role)

- Transactional users with access to transactional pages and scheduled processes must have data access through

BUs.

- Administrators with access to the Functional Setup Manager pages must have data access through Reference

Sets.

Note: If you already use Deductions and Settlement, then you must add the reference data set access to all existing
users. If you are a first time implementer of deductions and settlement flows, then you must provide business unit
and reference data set access to your users. Implementation users always access to both the business unit and the

reference data set.

Data Security for Deductions and Settlement Users
This table provides the data security policies that are required for your users for various roles.

Data Security Policy

Maintain Collections Aging Buckets

Data (Collections privilege)

Manage Channel Claims Data

ORACLE

Code

CIM_MANAGE_CHANNEL_

CLAIMS_DATA

IEX_MAINTAIN_COLLECTIONS_
AGING_BUCKETS_DATA

Description

bucket data.

authorized for.

Allows a user to maintain aging

Controls user access to channel
claims of the business units they're

Assigned to Role

Channel Administration (Duty Role)

Supplier Channel Management
(Duty Role)

Channel Operations (Duty Role)

Channel Claims Manager(Job Role)
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Data Security Policy

Manage Channel Claim Reason
Data

Manage Channel Claim Source
Mapping Data

Manage Channel Claim Type Data

Manage Channel Notes Data

Manage Channel Setting Data

Manage Customer Trade Profile
Data

Manage Receivables Activity
(Receivables privilege)

View Customer Account Data

View Trading Community
Organization Data

Related Topics
- Data Security

ORACLE

Code

CIM_MANAGE_CHANNEL_CLAIM_
REASON_DATA

CIM_MANAGE_CHANNEL_CLAIM_
SOURCE_MAPPING_DATA

CIM_MANAGE_CHANNEL_CLAIM_
TYPE_DATA

CIM_MANAGE_CHANNEL_
NOTES_DATA

CIM_MANAGE_CHANNEL_
SETTING_DATA

CIM_MANAGE_CUSTOMER_
TRADE_PROFILE_DATA

AR_MANAGE_RECEIVABLES_
ACTIVITIES_DATA

HZ_VIEW_CUSTOMER_ACCOUNT_
DATA

HZ_VIEW_TRADING_
COMMUNITY_ORGANIZATION_
DATA

Description

Controls user access to channel
claim reason reference data set
they're authorized for.

Controls user access to channel
claim source mapping reference
data set they're authorized for.

Controls user access to channel
claim type reference data set
they're authorized for.

Allows viewing, updating, and
deleting of internal notes for
channel objects.

Controls user access to channel
system setting of the business
units they're authorized for.

Controls user access to customer
trade profile of the business units
they're authorized for.

Controls user access to receivables
activity of the business units
they're authorized for.

Allows viewing customer account
data for all customer accounts in
the enterprise.

Allows viewing trading community
organization data for all
organizations in the enterprise.
Allows viewing trading community
organization data where they

are a member of the partner
organization.
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Assigned to Role

Channel Administration (Duty Role)

Channel Administration (Duty Role)

Channel Administration (Duty Role)

Channel Claims Manager (Job Role)

Supply Chain Application
Administrator (Job Role)

Channel Claims Manager (Job Role)

Customer Channel Program
Manager (Job Role)

Channel Claims Manager (Job Role)

Channel Operations (Duty Role)

Channel Claims Manager (Job Role)

Channel Claims Manager (Job Role)
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Customer Channel Flows

Business Functions

This topic lists the required business functions.

Chapter 14
Security

You must associate the Billing and Revenue Management business function with the business unit on the manual claim.

Roles and Duties

This topic describes roles and duties in customer channel flows.

You can assign these job roles and duties to your users based on their responsibilities.

This table displays the job roles that can be assigned to your users:

Job Roles in Customer Channel Flows

Name

BPM Workflow System Admin Role

Channel Claims Manager

Customer Channel Program Manager

Supply Chain Integration Specialist

Supply Chain Application Administrator

Code
BPMWorkflowAdmin

ORA_CIJM_CHANNEL_CLAIMS_MANAGER_JOB

ORA_CIM_CUSTOMER_CHANNEL_PROGRAM_
MANAGER_JOB

ORA_RCS_SUPPLY_CHAIN_INTEGRATION_
SPECIALIST_JOB

ORA_RCS_SUPPLY_CHAIN_APPLICATION_
ADMINISTRATOR_JOB

This table displays the duty roles that can be assigned to your users:

Duty Roles in Customer Channel Flows

Name

Customer Channel Program Management

ORACLE

Code

ORA_CIJM_CUSTOMER_CHANNEL_PROGRAM_
MANAGEMENT_DUTY

Description

BPM Workflow Administrator Application Role.

Individual responsible for creating, managing,
and approving customer claims.

Individual responsible for creating, managing,
and approving customer channel programs.

Individual responsible for planning,
coordinating, and supervising all activities
related to the integration of supply chain
management information systems.

Individual responsible for supply chain
application administration. Collaborates with

supply chain application users to maintain
consistent application setup, rules, and access.

Description

Manages customer programs and manual
adjustments.
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Name

Customer Channel Program Viewing

Channel Claims Management

Channel Claims Viewing

Channel Integration Specialist

Channel Administration

Channel Operations

Privileges

Code

ORA_CIM_CUSTOMER_CHANNEL_PROGRAM_
VIEW_DUTY

ORA_CIJM_CHANNEL_CLAIMS_
MANAGEMENT_DUTY

ORA_CIJM_CHANNEL_CLAIMS_VIEW_DUTY
ORA_CIM_CHANNEL_INTEGRATION_
SPECIALIST_DUTY

ORA_CIJM_CHANNEL_ADMINISTRATION_DUTY

ORA_CIJM_CHANNEL_OPERATIONS_DUTY

Here you'll understand the privileges for customer channel flows.

You can assign these privileges to your users based on their responsibilities.

Privilege

Approve Customer Claims

Approve Customer
Programs

Extract Customer Accruals

ORACLE

Usage

Ul

ul

ESS

Code Description

CIM_APPROVE_

If you haven't opted into
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Description

View customer programs.

Manages customer claims.

Views customer claims.

Manages import of transactional data from
external applications into Channel Revenue
Management.

Manages channel setup and administration
tasks.

Manages execution of scheduled processes.

Assigned to Role

Channel Claims

CUSTOMER_CLAIMS_PRIV

CIM_APPROVE_
CUSTOMER_PROGRAMS_
PRIV

CIM_EXTRACT_
CUSTOMER_ACCRUALS_
PRIV

the Approve Customer
Claims with BPM Workflow
feature, then this privilege
allows viewing and
approval of customer
claims.

If you have opted into the
Approve Customer Claims
with BPM Workflow feature,
then this privilege allows
the approver to view all the
details of the claim in the
notification.

If you have opted into

the Approve Customer
Programs with BPM
Workflow feature, then

this privilege allows the
approver to view and
approve the customer
program in the notification.

Allows exporting of
customer accruals.

Management (Duty Role)

Customer Channel Program
Management (Duty Role)

Customer Channel Program
Management (Duty Role)

Customer Channel Program
Viewing (Duty Role)
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Privilege

Extract Customer Accruals

Get Channel Customer
Checkbook Balances using
REST Service

Get Channel Customer
Program Checkbook
Balances using REST
Service

Get Channel Item Validation
Organization using REST
Service

Get Item Rest

Manage Channel Customer
Mass Claim using REST
Service

Manage Channel Customer
Programs using REST
Service

Manage Customer Claims

Manage Customer Manual
Adjustments using REST
Service

Manage Customer

Programs

Search Channel Customer
Available Accruals using
REST Service

ORACLE

Usage

BIP

REST

REST

REST

REST

REST

REST

Ul

REST

Function

REST

Code

CIM_EXTRACT_
CUSTOMER_ACCRUALS_
PRIV_OBI

CIM_GET_CHANNEL _
CUSTOMER_CHECKBOOK_
BAL_REST_SERVICE_PRIV

CIM_GET_CHANNEL_
CUSTOMER_PGM_
CHECKBOOK_BAL_REST_
SERVICE_PRIV

CIM_GET_CHANNEL _
ITEM_VAL_ORG_REST_
SERVICE_PRIV

EGP_GET_ITEM_REST_
PRIV

CIM_MANAGE_
CUSTOMER_MASS_CLAIM_
REST_SERVICE_PRIV

CIM_MANAGE_CHANNEL _
CUSTOMER_PROGRAM_
REST_SERVICE_PRIV

CIM_MANAGE_
CUSTOMER_CLAIMS_PRIV

CIM_MANAGE_
CUSTOMER_MANUAL_
ADJUSTMENT_REST_
SERVICE_PRIV

CIM_MANAGE_
CUSTOMER_PROGRAMS_
PRIV

CIM_SEARCH_CHANNEL _
CUSTOMER_AVAILABLE_
ACCRUAL_REST_SERVICE_
PRIV

Description

Allows exporting of
customer accruals.

Gets the customer
checkbook balances using
REST service.

Gets the program
checkbook balances using
REST service.

Gets the item validation
organization using REST
service.

Allows query access to
items through the REST
APL.

Enables creation, update,
deletion, and viewing of
channel customer mass
claims using REST service.

Enables creation, update,
deletion, and viewing

of channel customer
programs and their child

entities using REST service.

Enables update, and

viewing of customer claims.

Enables creating and
viewing customer manual
adjustments using REST
service.

Enables creation, update,
deletion, and viewing of
customer programs and
their child entities.

Enables searching of
channel customer available
accruals using REST
service.

Chapter 14
Security

Assigned to Role

Customer Channel Program
Management (Duty Role)

Customer Channel Program

Viewing (Duty Role)

Customer Channel Program
Management (Duty Role)

Customer Channel Program
Management (Duty Role)

Channel Claims
Management (Duty Role)

Customer Channel Program
Management (Duty Role)
Customer Channel Program
Management (Duty Role)
Channel Claims

Management (Duty Role)

Channel Claims
Management (Duty Role)

Customer Channel Program
Management (Duty Role)

Channel Claims
Management (Duty Role)

Customer Channel Program
Management (Duty Role)

Customer Channel Program
Management (Duty Role)

Channel Claims
Management (Duty Role)
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Privilege

View Customers

View Customer Checkbook

View Customer Claims

View Customer Programs

View Only Activity

Data Security

Usage

Fucntion

ul

Ul

Function

REST

Code

AR_VIEW_CUSTOMERS_
PRIV

CIM_VIEW_CUSTOMER_
CHECKBOOK_PRIV

CIM_VIEW_CUSTOMER_
CLAIMS_PRIV

CIM_VIEW_CUSTOMER_
PROGRAMS_PRIV

ZMM_VIEW_ONLY_
ACTIVITY_PRIV

Here you'll understand the data security for customer channel flows.

Description

Allows the viewing of the
customer, account and the
site information.

Allows viewing of customer
checkbook.

Allows viewing of all
customer claims.

Allows viewing of all
customer programs and
their child entities.

Allows only viewing of
activities.

Data security consists of controlling access to data through various policies.
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Assigned to Role

Customer Channel Program
Management (Duty Role)

Customer Channel Program
Management (Duty Role)

Channel Claims Viewing
(Duty Role)

Customer Channel Program
Viewing (Duty Role)

Customer Channel Program
Management (Duty Role)

Customer Channel Program
Viewing (Duty Role)

- Transactional users with access to transactional pages and scheduled processes must have data access through

BUs.

- Administrators with access to the Functional Setup Manager pages must have data access through Reference

Sets.

Note: If you already use Deductions and Settlement, then you must add the reference data set access to all existing
users. If you are a first time implementer of customer channel flows, then you must provide business unit and
reference data set access to your users. Implementation users always access to both the business unit and the

reference data set.

Data Security for Customer Channel Flows

Data Security Policy

Manage Channel Claims Data

Manage Channel Program Data

ORACLE

Code

CIM_MANAGE_CHANNEL _
CLAIMS_DATA

CIM_MANAGE_CHANNEL_
PROGRAMS_DATA

Description

Controls user access to channel
claims of the business units they
are authorized for.

Controls user access to channel
programs of the business units
they are authorized for.

Assigned to Role

Channel Claims Manager (Job Role)

Customer Channel Program
Management (Duty Role)
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Data Security Policy

Manage Customer Trade Profile
Data

View Customer Account Data

View Customer Account
Relationship Data

View Customer Account Site Data

View Customer Account Site Use
Data

View Item Basic Data

View Trading Community
Organization Data

Code

CIM_MANAGE_CUSTOMER_
TRADE_PROFILE_DATA

HZ_VIEW_CUSTOMER_ACCOUNT_
DATA

HZ_VIEW_CUSTOMER_ACCOUNT_

RELATIONSHIP_DATA

HZ_VIEW_CUSTOMER_ACCOUNT_
SITE_DATA

HZ_VIEW_CUSTOMER_ACCOUNT_
SITE_USE_DATA

EGO_VIEW_ITEM_BASIC_DATA

HZ_VIEW_TRADING_
COMMUNITY_ORGANIZATION_
DATA

Buy Side Channel Flows

Business Functions

This topic lists the required business functions.

Description

Controls user access to customer
trade profile of the business units
they are authorized for.

Allows viewing customer account
data for all customer accounts in
the enterprise.

Allows viewing customer account
relationship data for the reference
data sets for which they are
authorized.

Allows the management of
customer account site data for the
reference data sets for which they
are authorized. If assigning, also
assign the ability to view customer
account site use data.

Allows viewing customer account
site use data for the reference data
sets for which they are authorized.

Allows access to query and

view item basic information
including attributes, attachments,
organizations, suppliers,
relationships, and other related
information.

Allows viewing trading community
organization data for all
organizations in the enterprise.
Allows viewing trading community
organization data where they

are a member of the partner
organization.
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Assigned to Role

Channel Claims Manager (Job Role)

Customer Channel Program
Manager (Job Role)

Channel Claims Manager (Job Role)
Customer Channel Program
Manager (Job Role)

Channel Claims Manager (Job Role)

Customer Channel Program
Manager (Job Role)

Channel Claims Manager (Job Role)
Customer Channel Program
Manager (Job Role)

Customer Channel Program
Management (Duty Role)

Channel Claims Management

(Duty Role)

Customer Channel Program
Manager (Job Role)

The following business functions must be associated with the business unit on the Supplier Ship and Debit program:

- Payables Invoicing

- Payables Payment or there is a downstream payables payment service provider for the business unit

- Billing and Revenue Management

ORACLE
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The following business functions must be associated with the business unit on the Supplier Rebate program:

- Payables Invoicing

- Payables Payment or a downstream payables payment service provider for the business unit

The following business functions must be associated with the business unit on the Supplier Annual program:

- Payables Invoicing

- Payables Payment or a downstream payables payment service provider for the business unit

Roles and Duties

You can assign these job roles and duties to your users based on their responsibilities. Job roles and duties are the same
regardless of whether you access buy side channel flows from the Procurement or Order Management offerings.

This table gives the job roles that can be assigned to your users:

Job Roles for Buy Side Users

Role

Supplier Channel Manager

Role Code

ORA_CIM_SUPPLIER_CHANNEL_MANAGER_
JOB

This table gives the duty roles that can be assigned to your users:

Duty Roles for Buy Side Users

Name

Channel Administration

Channel Integration Specialist

Channel Operations

Channel Setup Viewing

Supplier Channel Management

ORACLE

Code

ORA_CIJM_CHANNEL_ADMINISTRATION_DUTY

ORA_CIM_CHANNEL_INTEGRATION_
SPECIALIST_DUTY

ORA_CIJM_CHANNEL_OPERATIONS_DUTY

ORA_CIJM_CHANNEL_SETUP_VIEW_DUTY

CIM_SUPPLIER_CHANNEL_MANAGEMENT_
DUTY

Description

Individual responsible for creating, managing,
and approving supplier channel programs,
making manual adjustments, and managing
supplier claims.

Description

Manages channel setup and administration
tasks.

Manages import of transactional data from
external applications into Channel Revenue
Management.

Manages execution of scheduled processes.

Views setups required for channel execution.
This includes viewing the setups for program
types, adjustment types and reasons, claim
types and reasons, claim sources, and user
statuses.

Manages supplier programs, claims, manual
adjustments, and channel transactions.
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Name Code Description
Supplier Channel Viewing ORA_CIM_SUPPLIER_CHANNEL_VIEW_DUTY  Views supplier programs, claims, manual

adjustments, channel transactions, and
program types.

For information, see:

- Role-Based Access Control, Oracle Fusion Applications Understanding Security guide
- Provisioning Roles to Application Users, Oracle SCM Cloud Securing SCM guide

Roles

Here you'll understand the roles for supplier contacts.

You can assign these job roles and duties to your users based on their responsibilities.

Role Role Code Description
Supplier Channel Management in Supplier CIM_MANAGE_SUPPLIER_PROGRAMS_IN_ Role associated with the privilege to create and
Portal Duty PORTAL update Supplier Programs for the associated

supplier from the Supplier Portal.

Supplier Channel Viewing in Supplier Portal CIM_VIEW_SUPPLIER_PROGRAMS_IN_PORTAL Role associated with the new privilege to view
Duty Supplier Programs for the associated supplier
from the Supplier Portal.

Privileges
You can assign these privileges to your users based on their responsibilities. Privileges are the same regardless of

whether you are accessing buy side channel flows from the Procurement or Order Management offerings.

Assign Privileges for Buy Side Users

This table gives the privileges your users require to perform various functions. It contains the names, codes, and
descriptions of the privileges that can be assigned to a channel user.

Privilege Usage Code Description Assigned to Role

Approve Supplier Claims Ul CIM_APPROVE_SUPPLIER_ Allows viewing and Supplier Channel
CLAIMS_PRIV approval of supplier claims.  Management (Duty Role)

Approve Supplier Manual Function CIM_APPROVE_SUPPLIER_  Allows viewing and Supplier Channel

Adjustments MANUAL_ADJUSTMENT_  approval of supplier manual Management (Duty Role)
PRIV adjustments.
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Privilege

Approve Supplier Programs

Close Settled Claims

Create Accruals

Create Accruals for Volume
Programs

Extract Supplier Claims

Generate Supplier Claims

Load Transactions

Maintain Collections Aging
Buckets

Manage Active Supplier
Programs

Manage Channel
Adjustment Types

ORACLE

Usage

Ul

Scheduled Process

Scheduled Process

Scheduled Process

Scheduled Process

Scheduled Process

Scheduled Process

ul

Ul

Ul

Code

CIM_APPROVE_SUPPLIER_
PROGRAMS_PRIV

CIM_CLOSE_SETTLED_
CLAIMS_PRIV

CIM_CREATE_ACCRUALS_
PRIV

CIM_CREATE_ACCRUALS_
FOR_VOLUME_
PROGRAMS_PRIV

CIM_EXTRACT_SUPPLIER_
CLAIMS_PRIV

CIM_GENERATE_
SUPPLIER_CLAIMS_PRIV

CIM_LOAD_
TRANSACTIONS_PRIV

IEX_MAINTAIN_
COLLECTIONS_AGING_
BUCKETS_PRIV

CIM_MANAGE_ACTIVE_
SUPPLIER_PROGRAMS_
PRIV

CIM_MANAGE_CHANNEL_
ADJUSTMENT_TYPES_
PRIV

Description

Allows viewing and
approval of supplier
programs.

Allows submission of the
process that closes settled
claims.

Allows submission of
the process that creates
accruals.

Allows submission

of the process that
checks eligibility for
channel document
transactions based on
tiered attainments and
creates channel program
accrual entries for the
eligible transactions.

Allows exporting of
claim details in the excel
workbook.

Allows submission of the
process that generates
supplier claims.

Allows loading of
transactions from external
sources into Channel
Revenue Management.

Allows a user to maintain
aging buckets.

Enables creation, update,
deletion, and viewing of
supplier programs and their
child entities, and update of
active programs.

Enables creation, update,
and viewing of channel
adjustment types and
adjustment reasons.
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Assigned to Role

Supplier Channel
Management (Duty Role)

Channel Operations (Duty
Role)

Channel Operations (Duty
Role)

Channel Operations (Duty
Role)

Supplier Channel
Management (Duty Role)

Supplier Channel Viewing
(Duty Role)

Channel Operations (Duty
Role)

Channel Operations (Duty
Role)

Channel Administration
(Duty Role)

Supplier Channel
Management (Duty Role)

Channel Administration
(Duty Role)
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Privilege

Manage Channel
Administration Using REST
Service

Manage Channel Batches

Manage Channel Claim
Reasons

Manage Channel Claim
Sources

Manage Channel Claim
Types

Manage Channel Claims
using REST Service

Manage Channel Program
Types

Manage Channel Program
Types using REST Service

Manage Channel Programs
Using REST Service

Manage Channel User
Statuses

Manage Manual
Adjustments using REST
Service

ORACLE

Usage

REST

ul

Ul

Ul

ul

REST

Ul

REST

REST

Ul

ul

Code

CIM_MANAGE_CHANNEL_
ADMINISTRATION_REST_
SERVICE_PRIV

CIM_MANAGE_CHANNEL _
BATCHES_PRIV

CIM_MANAGE_CHANNEL _
CLAIM_REASONS_PRIV

CIM_MANAGE_CHANNEL_
CLAIM_SOURCES_PRIV

CIM_MANAGE_CHANNEL _
CLAIM_TYPES_PRIV

CIM_MANAGE_CHANNEL _
CLAIM_REST_SERVICE_
PRIV

CIM_MANAGE_CHANNEL_
PROGRAM_TYPES_PRIV

CIM_MANAGE_CHANNEL_
PROGRAM_TYPE_REST_
SERVICE_PRIV

CIM_MANAGE_CHANNEL _
PROGRAMS_REST_
SERVICE_PRIV

CIM_MANAGE_CHANNEL_
USER_STATUSES_PRIV

CIM_MANAGE_MANUAL_
ADJUSTMENT_REST_
SERVICE_PRIV

Description

Enables creation and
update of channel claim
sources, channel claim
types, channel adjustment
types, and channel user
statuses using REST
services.

Allows update and viewing
of channel batches.

Enables creation, update,
and viewing of channel
claim reasons.

Enables creation, update,
and viewing of channel
claim sources.

Enables creation, update,
and viewing of channel
claim types.

Enables creation, update,
and viewing of channel
claims using REST service.

Enables creation, update,
deletion, and viewing of
channel program types and
child entities.

Enables creation, update,
deletion, and viewing of
channel program types and
child entities.

Enables creation, update,
deletion, and viewing of
channel programs and their
child entities using REST
service.

Enables creation, update,
and viewing of channel
user statuses.

Enables creation and
viewing of manual
adjustments using REST
service.
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Assigned to Role

Channel Administration
(Duty Role)

Supplier Channel
Management (Duty Role)

Channel Administration
(Duty Role)

Channel Administration
(Duty Role)

Channel Administration
(Duty Role)

Supplier Channel
Management (Duty Role)

Channel Administration
(Duty Role)

Channel Administration
(Duty Role)

Supplier Channel
Management (Duty Role)

Channel Administration
(Duty Role)

Supplier Channel
Management (Duty Role)
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Privilege

Manage Supplier Claims

Manage Supplier Manual
Adjustments

Manage Supplier Programs

Manage Supplier Trade
Profile using REST Service

Manage Supplier Trade
Profiles

Review Collections Aging
Buckets

Sweep Channel Transaction
Accounting Events

View Channel Adjustment
Types

View Channel Claim
Reasons

View Channel Claim
Sources

View Channel Claim Types

View Channel Program
Types

ORACLE

Usage

Ul

ul

Ul

REST

ul

Scheduled Process

ul

Ul

Ul

ul

Ul

Code

CIM_MANAGE_SUPPLIER_
CLAIMS_PRIV

CIM_MANAGE_SUPPLIER_
MANUAL_ADJUSTMENT_
PRIV

CIM_MANAGE_SUPPLIER_
PROGRAMS_PRIV

CIM_MANAGE_SUPPLIER_
TRADE_PROFILE_REST_
SERVICE_PRIV

CIM_MANAGE_SUPPLIER_
TRADE_PROFILES_PRIV

IEX_REVIEW_
COLLECTIONS_AGING_
BUCKETS_PRIV

CIM_SWEEP_CHANNEL_
TRANSACTION_
ACCOUNTING_EVENTS_
PRIV

CIM_VIEW_CHANNEL _
ADJUSTMENT_TYPES_
PRIV

CIM_VIEW_CHANNEL _
CLAIM_REASONS_PRIV

CIM_VIEW_CHANNEL_
CLAIM_SOURCES_PRIV

CIM_VIEW_CHANNEL _
CLAIM_TYPES_PRIV

CIM_VIEW_CHANNEL _
PROGRAM_TYPES_PRIV

Description

Enables creation, update,
and viewing of supplier
claims and their child
entities.

Enables creation and
viewing of supplier manual
adjustments.

Enables creation, update,
deletion, and viewing of
supplier programs and their
child entities.

Enables creation, update,
and viewing of supplier
trade profile using REST
service.

Enables creation, update,
and viewing of supplier
trade profiles.

Allows a user to see the
aged transactions for a
customer.

Allows submission of
the process that sweeps
channel transaction
accounting events.

Allows viewing of channel
adjustment types and
adjustment reasons.

Allows viewing of channel
claim reasons.

Allows viewing of channel
claim sources.

Allows viewing of channel
claim types.

Allows viewing of channel
program types and child
entities.
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Assigned to Role

Supplier Channel
Management (Duty Role)

Supplier Channel
Management (Duty Role)

Supplier Channel
Management (Duty Role)

Supplier Channel
Management (Duty Role)

Supplier Channel
Management (Duty Role)

Channel Administration
(Duty Role)

Channel Operations (Duty
Role)

Channel Setup Viewing
(Duty Role)

Channel Setup Viewing
(Duty Role)

Channel Setup Viewing
(Duty Role)

Channel Setup Viewing
(Duty Role)

Channel Setup Viewing
(Duty Role)
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Privilege

View Channel Transactions
Using REST Service

View Channel User Statuses

View Supplier Checkbook

View Supplier Claims

View Supplier Manual
Adjustments

View Supplier Programs

View Supplier Trade Profiles

Usage

REST

U

Ul

ul

Ul

u

Code

CIM_VIEW_CHANNEL_
TRANSACTION_REST_
SERVICE_PRIV

CIM_VIEW_CHANNEL _
USER_STATUSES_PRIV

CIM_VIEW_SUPPLIER_
CHECKBOOK_PRIV

CIM_VIEW_SUPPLIER_
CLAIMS_PRIV

CIM_VIEW_SUPPLIER_
MANUAL_ADJUSTMENT_
PRIV

CIM_VIEW_SUPPLIER_
PROGRAMS_PRIV

CIM_VIEW_SUPPLIER_
TRADE_PROFILES_PRIV

Description

Enables viewing of channel
transactions using REST
service.

Allows viewing of channel
user statuses.

Allows viewing of supplier
checkbook.

Allows viewing of all
supplier claims and their
child entities.

Allows viewing of

all supplier manual
adjustments and their child
entities.

Allows viewing of all
supplier programs and their
child entities.

Allows viewing of supplier
trade profiles and their
child entities.

Note: All Supplier Ship and Debit Ul users must have one of the following two privileges:
- Manage Supplier Programs

- View Supplier Programs

Assign Privileges to Supplier Contacts
This table describes the privileges for supplier contacts to access Channel Programs via the Supplier Portal.

Privilege

Manage Supplier Programs
in Supplier Portal

View Supplier Programs in
Supplier Portal

ORACLE

Usage

ul

ul

Code

CIM_MANAGE_SUPPLIER_
PROGRAMS_IN_PORTAL

CIM_VIEW_SUPPLIER_
PROGRAMS_IN_PORTAL

Description

Enables creation, update,
and viewing of supplier
programs from the supplier
portal.

Allows viewing of supplier
programs from the supplier
portal.
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Assigned to Role
Supplier Channel

Management (Duty Role)

Channel Setup Viewing
(Duty Role)

Supplier Channel
Management (Duty Role)

Supplier Channel Viewing
(Duty Role)

Supplier Channel Viewing
(Duty Role)

Supplier Channel Viewing
(Duty Role)

Supplier Channel Viewing
(Duty Role)

Assigned to Duty Role

Supplier Channel
Management in Supplier
Portal Duty

Supplier Channel Viewing
in Supplier Portal Duty
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Data Security

Data security consists of controlling access to data through various policies.

Chapter 14
Security

- Transactional users with access to transactional pages and scheduled processes must have data access through

BUs.

- Administrators with access to the Functional Setup Manager pages must have data access through Reference

Sets.

- Data security policies are the same regardless of whether you access buy side channel flows from the
Procurement or Order Management offerings.

Data Security for Buy Side Users

This table provides the data security policies that are required for your users for various roles.

Data Security Policy

Maintain Collections Aging Buckets
Data

Manage Channel Adjustment Type

Data

Manage Channel Batch Data

Manage Channel Claims Data

Manage Channel Claim Reason
Data

Manage Channel Claim Source
Mapping Data

Manage Channel Claim Type Data

Manage Channel Notes Data

ORACLE

Code

IEX_MAINTAIN_COLLECTIONS_
AGING_BUCKETS_DATA

CIM_MANAGE_CHANNEL_
ADJUSTMENT_TYPE_DATA

CIM_MANAGE_CHANNEL_BATCH_
DATA

CIM_MANAGE_CHANNEL_
CLAIMS_DATA

CIM_MANAGE_CHANNEL_CLAIM_
REASON_DATA

CIM_MANAGE_CHANNEL_CLAIM_
SOURCE_MAPPING_DATA

CIM_MANAGE_CHANNEL_CLAIM_
TYPE_DATA

CIM_MANAGE_CHANNEL_
NOTES_DATA

Description

Allows a user to maintain aging
bucket data.

Controls user access to channel
adjustment type reference data set
they're authorized for.

Controls user access to batches
of the business units they're
authorized for.

Controls user access to channel
claims of the business units they're
authorized for.

Controls user access to channel
claim reason reference data set
they're authorized for.

Controls user access to channel
claim source mapping reference
data set they're authorized for.

Controls user access to channel
claim type reference data set
they're authorized for.

Allows viewing, updating, and
deleting of internal notes for
channel objects.

Assigned to Role

Channel Administration (Duty Role)

Channel Administration (Duty Role)

Supplier Channel Manager (Job
Role)

Supplier Channel Management
(Duty Role)

Channel Operations (Duty Role)

Channel Administration (Duty Role)

Channel Administration (Duty Role)

Channel Administration (Duty Role)

Supplier Channel Manager (Job
Role)
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Data Security Policy

Manage Channel Program Data

Manage Supplier Trade Profile Data

View Channel Batch Transaction
File Import Activity Object Type
Data

View Channel Batch Transaction
File Import Mapping Object Type
Data

View Channel Batch Transaction
File Import Object Type Data

View Trading Community
Organization Data

Related Topics
- Data Security

ORACLE

Code

CIM_MANAGE_CHANNEL_
PROGRAMS_DATA

CIM_MANAGE_SUPPLIER_TRADE_
PROFILE_DATA

CIM_VIEW_BATCH_TRX_FILE_
IMPORT_ACTIVITY_OBJECT_
TYPE_DATA

CIM_VIEW_BATCH_TRX_FILE_
IMPORT_MAPPING_OBJECT_
TYPE_DATA

CIM_VIEW_BATCH_TRX_FILE_
IMPORT_OBJECT_TYPE_DATA

HZ_VIEW_TRADING_
COMMUNITY_ORGANIZATION_
DATA

Description

Controls user access to channel
programs of the business units
they're authorized for.

Controls user access to supplier
trade profile of the business units
they're authorized for.

Allows viewing channel batch
transaction import activities across
the enterprise.

Allows viewing channel batch
transaction import mappings
across the enterprise.

Allows viewing channel batch
transaction import objects across
the enterprise.

Allows viewing trading community
organization data for all
organizations in the enterprise.
Allows viewing trading community
organization data where they

are a member of the partner
organization.
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Assigned to Role

Supplier Channel Management
(Duty Role)

Channel Operations (Duty Role)

Supplier Channel Management
(Duty Role)

Channel Integration Specialist
(Duty Role)

Channel Integration Specialist
(Duty Role)

Channel Integration Specialist
(Duty Role)

Supplier Channel Manager (Job
Role)
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15 Accounting Event Details

Accounting Event Details for Customer Accruals

For every accrual and claim, there is an accounting entry. This appendix explains the events and their corresponding
accounting entries in detail.

For every accrual and claim, there is an accounting entry. This appendix explains the events and their corresponding
accounting entries in detail.

Customer Accrual Event
Debit Credit
Sales or Expense Account Accrual Liability Account

Customer Claim Settlement Event

Debit Credit

Claim Accrual Liability Account Receivables Clearing Account

Accounting Rules for Customer Accruals and Customer Claim Settlements

Event Class Name Event Type Name Journal Entry Description Side

Customer Accrual Customer Accrual Adjustment Sales or Expense Debit

Customer Accrual Customer Accrual Adjustment Accrual Liability Credit

Customer Accrual Customer Accrual Creation Sales or Expense Debit

Customer Accrual Customer Accrual Creation Accrual Liability Credit

Customer Claim Settlement Customer Claim Settlement Claim Accrual Liability Debit
Reversal

Customer Claim Settlement Customer Claim Settlement Payables Clearing for Check and AP Credit
Reversal Default Customer Claim

Customer Claim Settlement Customer Claim Settlement Receivables Clearing for Credit Credit
Reversal Memo Customer Claim

Customer Claim Settlement Customer Claim Settlement Exchange Gain and Loss for Credit
Reversal Customer Claim

Customer Claim Settlement Claim Settlement by Payables Claim Accrual Liability Debit
Default
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Event Class Name

Customer Claim Settlement

Customer Claim Settlement

Customer Claim Settlement

Customer Claim Settlement

Customer Claim Settlement

Customer Claim Settlement

Customer Claim Settlement
Customer Claim Settlement
Customer Claim Settlement by

Extensible Payables

Customer Claim Settlement by
Extensible Payables

Customer Claim Settlement by
Extensible Payables

Customer Claim Settlement by
Extensible Payables

Customer Claim Settlement by
Extensible Payables

Customer Claim Settlement by
Extensible Payables

Customer Claim Settlement by
Extensible Receivables

Customer Claim Settlement by
Extensible Receivables

Customer Claim Settlement by
Extensible Receivables
Customer Claim Settlement by

Extensible Receivables

Customer Claim Settlement by
Extensible Receivables

Customer Claim Settlement by
Extensible Receivables

ORACLE

Event Type Name

Claim Settlement by Payables
Default

Claim Settlement by Payables
Default

Claim Settlement by Check

Claim Settlement by Check

Claim Settlement by Check

Claim Settlement by Credit Memo

Claim Settlement by Credit Memo
Claim Settlement by Credit Memo
Payables Extensible Settlement

Reversal

Payables Extensible Settlement
Reversal

Payables Extensible Settlement
Reversal

Claim Settlement by Extensible
Payables

Claim Settlement by Extensible
Payables

Claim Settlement by Extensible
Payables

Receivables Extensible Settlement
Reversal

Receivables Extensible Settlement
Reversal

Receivables Extensible Settlement
Reversal
Claim Settlement by Extensible

Receivables

Claim Settlement by Extensible
Receivables

Claim Settlement by Extensible
Receivables

Journal Entry Description

Payables Clearing for Check and AP
Default Customer Claim

Exchange Gain or Loss for
Customer Claim

Claim Accrual Liability

Payables Clearing for Check and AP
Default Customer Claim

Exchange Gain or Loss for
Customer Claim

Claim Accrual Liability

Receivables Clearing for Credit
Memo Customer Claim

Exchange Gain and Loss for
Customer Claim

Claim Accrual Liability for Payables
Extensible Settlement

Payables Clearing for Extensible
Customer Claim

Exchange Gain or Loss for Payables
Extensible Customer Claim

Claim Accrual Liability for Payables
Extensible Settlement

Payables Clearing for Extensible
Customer Claim

Exchange Gain or Loss for Payables
Extensible Customer Claim

Claim Accrual Liability for
Receivables Extensible Settlement

Receivables Clearing for Extensible
Customer Claim

Exchange Gain or Loss for
Receivables Extensible Customer
Claim

Claim Accrual Liability for
Receivables Extensible Settlement

Receivables Clearing for Extensible
Customer Claim

Exchange Gain or Loss for
Receivables Extensible Customer
Claim
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Side
Credit
Credit

Debit

Credit

Credit

Debit

Credit

Credit

Debit

Credit

Credit

Debit

Credit

Credit

Debit

Credit

Credit

Debit

Credit

Credit
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Navigate to the Manage Sources: Channel Revenue Management page to view the sources that are available for setting
up SLA accounting rules as follows:

- From the Navigator, select Setup and Maintenance.
- On the Setup: page, select Order Management from the drop-down list.

- Select the Channel Revenue Management functional area and select the Manage Sources task.

Note: Enter CUST in the Object Column Name search field to search for objects related to customers.

Accounting Event Details for Supplier Accruals

For every accrual, adjustment, and claim, there is an accounting entry. This appendix explains the events and their
corresponding accounting entries in detail.

Accrual Event

Debit Credit

Accrual Asset Account Income or Discount on COGS Account

Claim Settlement Event

Debit Credit

Payables Clearing Account Claim Accrual Asset Account

Accounting Rules for Supplier Accruals and Supplier Claim Settlements

Event Class Name Journal Entry Rule Journal Line Rule Side Account Rule Mapping Set

Set
Supplier Accrual Supplier Accrual Rule ~ Accrual Asset Debit Accrual Asset Account  Accrual Asset Account
Supplier Accrual Supplier Accrual Rule  Income or Discount on  Credit Income or Discount on  Income or Discount on

COGS COGS Account COGS Account

Supplier Claim Supplier Claim Payables Clearing Debit Payables Clearing Payables Clearing
Settlement Settlement by Account Account

Payables Rule
Supplier Claim Supplier Claim Claim Accrual Asset Credit Claim Accrual Asset Claim Accrual Asset
Settlement Settlement by Account Account

Payables Rule
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Event Class Name Journal Entry Rule Journal Line Rule
Set

Supplier Claim Supplier Claim Claim Accrual Asset

Settlement Settlement by Account

Payables Rule

ORACLE

Side

Credit
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Account Rule

Claim Gain or Loss
Account

Mapping Set

Exchange Gain
Account

Exchange Loss
Account
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